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Chapter 1B – Overview  

Before getting started 
Many new features have been added to this version of Route Manager 
Advanced™, which has caused the User Guide to grow in features and 
content.  This being the case, the User Guide is being presented as two 
separate volumes:   

User Guide – Volume A:  Contains information on setting up and using the 
program as well as definitions for all items located within the File, Lists, and 
Transactions pads.   

User Guide – Volume B:  This volume contains definitions for all items 
located within Reports, Handhelds, Tools, and Help pads. 

In some cases, there may be some cross-referencing of material and 
information between the two manuals.   

Introduction 
 

Route Manager Advanced integrates state-of-the-art handheld technology 
with sophisticated accounts receivable software.  This provides a cost-
effective solution for field data collection in a variety of route accounting 
applications serving a number of different industries. 

The two volume manual contains the necessary information to help you set up 
the system quickly and operate it efficiently.  The complete collection of 
manuals includes:  

• Getting Started Guide 

• Desktop User Manual (A & B) 

• Supplemental Manual 

• Handheld Guide 

These manuals, along with our web-based training videos and other aids, will 
help you quickly get the program operating and employees using it 
effectively. 
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Intentionally left blank. 
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Chapter 2B – Reports 

Overview 
The Reports pad contains a variety of reports that can be generated within the 
program.    

 
These report options and their submenus (indicated by black arrows to the 
right) are described in detail within this chapter. 

 



 

12 •••• Reports – Chapter 2B Route Manager Advanced User Guide B 

 

Accounting Reports 
The menu groups available under Accounting Reports divide the reports into 
separate categories so you can easily find the report or information you need. 

 

Lookup 
The Lookup report sub-menu lists invoice and payment reports. 

 

Invoice Reprint  
The Invoice Reprint option can be used to reprint any invoice created on the 
desktop or handheld.  

NOTE:   Additionally, you can reprint individual invoices using the Invoice 
Lookup option within each customer’s account.  

 

Fields: 
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Primary and Secondary Sort:  The primary and secondary fields to sort by.  
You can choose from the following categories: 

• Account Number 

• Invoice Number 

• Account Name 

Acct Number:  The range of accounts to include in the report. 

Date:  The range of invoice dates to include in the report. 

Invoice Number:  The range of invoice numbers to include in the report, 
from the first to last invoice number. 

Customer Type:  The range of customer types to include in the report.  
Customer types are set up in the Customer Type Codes field, under the 
Customer Setup Codes in the Lists pad and are applied to each account. 

Print as:  Select the account number to include on the invoices: 

• Master Account Number 

• Sub-Account Number 

Open invoices:  Select this box to show only open invoices. 

Close Invoices:  Select this box to show only closed invoices 

Both:  Select this box to show both open and closed invoices. 

Rent Invoices Only:  Will only print rental invoices. 

Include Summary:  Prints a summary of reprinted invoices. 

Invoice Lookup 
The Invoice Lookup option allows you to search for a specific invoice based 
on the invoice number, amount, or P.O. number.   

NOTE:   You may search by the invoice number, the invoice amount or both.  
However, if both the invoice number and amount are used, they must match 
for results to be shown. 

 

Fields: 
Invoice Number:  Enter the desired invoice number to search for. 

Include Previous [ ] Months:  Enter the number of previous months to 
include in the search. 

Invoice Amount:  Enter the dollar amount to search for. 

P.O. Number:  Enter a P.O. number if there is one. 
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Payment Lookup 
The Payment Lookup option allows you to search for a specific payment 
based on a check number, amount, batch number, and more.   

NOTE:   Press ESC while looking up payments to abort the lookup and 
display the results already found. 

 

Fields: 
Check Number From: and To Range:  The range of check numbers to search 
for. 

Check Date:  The date on the check(s). 

Payment Amount:  The payment amount to search for. 

Include Previous…Months:  Indicate the number of previous months to 
include in the search. 

Batch Number:  The batch number to include in the search. 

Document ID:  Enter a document ID to search for. 

Receipt Notes:  Enter notes to search for. 

Acct Number:  The account number assigned to the invoice. 
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Open Invoices 
The Open Invoices Report allows you to view all of the unpaid invoices 
within each customer’s account. 

NOTE:   Open items are only available on accounts that have the ‘Open 
Invoice’ option selected within the Credit tab of Customer Information.   

 

Fields: 
Primary and Secondary Sort:  The primary and secondary fields to sort by.  
You can choose from the following categories: 

• Account Number 

• Invoice Number 

• Account Name 

Acct Number:  The range of accounts to include in this report. 

Invoice Date:  The range of invoice dates to include in the report. 

Credit Class:  The range of credit classes to include in the report.   

Credit Controller:  The range of Credit Controller Types to include in the 
report.   

All:   Check this box to include the full range of data for the Credit Controller 
fields. 

Customer Type:  The range of Customer Types to include in the report.   

Open Balance:  The range of open balances to include in the report. 

Invoice Amount:  Enter the invoice amount range to include in the report. 

Major Account:  Enter the range of Major Accounts to include in the report. 

Standard Report:  Select this option to include outstanding items on the 
indicated accounts in a single-line format.   

Standard Report with Aging:  Select this option to include outstanding items 
on the indicated accounts in a single-line format with an aged balance 
summary.     
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Open Balance Summary with Single Line Aging:  Select this option to 
include an aged balance summary on the indicated accounts in a single-line 
format.   

Open Balance Summary With Multi-line Aging:  Select this option to 
include an aged balance summary on the indicated accounts in a multi-line 
detailed format.   

No Sub Account Breakdown:  Select this option to suppress detailed Sub 
Account information on the report.   

Group Sub Account within Master:  Select this option to include sub account 
detail under each master account on the report.   

Show Sub Accounts Individually:  Select this option to list sub accounts 
individually on the report.   

Only Unapplied Credits:  Check this box to only include credit invoices or 
unapplied payments on the report. 



 

Route Manager Advanced User Guide B Chapter 2B – Reports 17 

 

Paid Invoices 
The Paid Invoices report will list all paid invoices on Open Item accounts.   

NOTE:   Open Items are only available on accounts that have the ‘Open 
Invoice’ option selected within the Credit tab of Customer Information.   

 

Fields: 
Primary Sort:  The primary fields to sort by; you can choose from the 
following categories: 

• Account Number 

• Invoice Number 

• Account Name 

Acct Number:  The range of account numbers to include on the report. 

Invoice Date:  The range of account numbers to include on the report. 

Payment Date:  The range of account numbers to include on the report. 

Customer Type:  The range of account numbers to include on the report. 

No Sub Account Breakdown:  Select this option to suppress detailed Sub 
Account information and include all paid invoice details within their 
associated Master Account on the report. 

Group Sub Account within Master:  Select this option to list all of the paid 
Sub Account invoices under each Master Account on the report. 

Show Sub Accounts Individually:  Select this option to list all of the Sub 
Accounts individually on the report. 
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Sales 
The Sales report sub-menu contains detailed sales and payment related 
reports.   

 
 

 



 

Route Manager Advanced User Guide B Chapter 2B – Reports 19 

 

Sales Detail Report 
The Sales Detail Report provides detailed product sales figures based on a 
variety of criteria.   

NOTE:   This popular report has great versatility.  The output of the report 
will reflect the sort options selected.  

 

Fields: 
Sort Option 1, 2, 3:  You can choose from the following categories: 

• Branch 

• Customer Type 

• Account Number 

• Date 

• Charge Code 

• Product Class 

• Employee ID 

• Route 

• Major Acct. Code 

• Period (Will break down sales per period) 

• Price 

• Stop 

• Invoices 

• Quantity 

• Sales 

• Gallons 

• Group Area 

• None 

Account Number:  The range of account numbers to include in the report. 
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All:   Default to include all customers. 

Do not group by Master Accounts:  Choose this option to include sub 
account information on the report if using master billing. 

Don’t include inactive Accounts:  Choose this option to exclude account 
information for inactive customers. 

Hide Profit Information:  Check this box to suppress all of the “profit” 
related figures from the report (i.e., Cost of Goods and Gross Margin).   

Customer Type:  The range of customer types to include in the report. 

All:   Default to include all Customer Types in the report. 

Sales Rep:  The range of Sales Reps to include in the report. 

All:   Default to include all Sales Reps in the report. 

Sales Rep 1-3:  Select the desired Sales Rep field to include in the report. 

Driver 1-3:  Select the desired Driver field to include in the report. 

Dates:  The range of dates to include in this report. 

Charge Code:  The range of charge codes to include in this report. 

All:   Default to include all Charge Codes in the report. 

Product Class:  The range of Product Class Codes to include in the report. 

All :  Default to include all product Class Codes in the report. 

Route:  The range of route ID’s to include in the report. 

All:   Default to include all Route ID’s in the report. 

Major Account Code:  The major account number range to include in the 
report.   

NOTE:   It is not required to have such a code on each account.   

All:  Default to include all Major Account Codes in the report. 
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Sales Comparison Report 
The Sales Comparison Report provides detailed product sales figures based 
on multiple date ranges and a variety of additional criteria.   

 

Fields: 
Sort Option 1, 2, 3:  You can choose from the following categories: 

• Branch 

• Customer Type 

• Account Number 

• Date 

• Charge Code 

• Product Class 

• Employee ID 

• Route 

• Major Acct. Code 

• Period  

• Price 

• Stop 

• Invoice Number 

• Quantity 

• Sales 

• Gallons 

• Group Area 

• None 

Account Number:  The range of account numbers to include in the report. 

All:   Default to include all customers. 

Do not group by Master Accounts:  Choose this option to include sub 
account information on the report if using master billing. 
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Don’t include inactive Accounts:  Choose this option to exclude account 
information for inactive customers. 

Hide Profit Information:  Check this box to suppress all of the “profit” 
related figures from the report (i.e., Cost of Goods and Gross Margin).   

Customer Type:  The range of Customer Types to include in the report. 

All:   Default to include all Customer Types in the report. 

Sales Rep:  The range of Sales Reps to include in the report. 

All:   Default to include all Sales Reps in the report. 

Sales Rep 1-3:  Select the desired Sales Rep field to include in the report. 

Driver 1-3:  Select the desired Driver field to include in the report. 

Charge Code:  The range of charge codes to include in this report. 

All:   Default to include all charge codes in the report. 

Product Class:  The range of Product Class Codes to include in the report. 

All :  Default to include all Product Class Codes in the report. 

Route:  The range of Route ID’s to include in the report. 

All:   Default to include all Route ID’s in the report. 

Major Account Code:  The major account number range to include in the 
report.   

All:  Default to include all Major Account Codes in the report.   

Date Range 1-3:  Enter up to three date ranges to compare in the report.   

None (Date Ranges 2 and 3): Select this option to disable the date range 
from being included in the report. 
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Daily Sales Report 
The Daily Sales Report allows you to print a sales report for a selected date.  
The report contains summarized posted totals for the date listed.  

NOTE:   If multiple postings were done on the same date, the report will 
include a combined total for the date selected. 

 
After selecting the desired day(s), click ‘OK’.   
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Customer Sales by Product Class 
The Customer Sales by Product Class Report includes product sales 
information separated by Product Class per customer.  The report includes 
individual columns for each Product Class and a total sales summary.   

NOTE:   This report can only be viewed within Microsoft Excel. 

 

Fields: 
Primary and Secondary Sorts:  The primary fields to sort by.  You can 
choose from the following categories: 

• Account Number 

• Customer Name 

• Highest Balance 

Dates:  The range of dates to include in the report. 

Account Number:  The range of account numbers to include in the report.  

Major Account Code:  The range of Major Account Codes to include in the 
report. 

Customer Type:  The range of Customer Types to include in the report. 

Available Product Class:  Includes all of the available Product Classes that 
can be added to the report. 

Selected Product Class:  Includes all of the Product Classes that will be 
included in the report. 

NOTE:   Use the arrows or double-click on each Product Class to add or 
remove from the list. 

Output File Name:  Specify the file name that you would like to assign to the 
report. 
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Payment Summary from History 
This report includes a summary of payments received for the date and route 
entered.   

 
Fields: 
Primary and Secondary Sorts:  The primary fields to sort by.  You can 
choose from the following categories: 

• Date 

• Route 

• Account No. 

Payment Date:  The range of dates to include in your report. 

Route:  The range of routes to include in the report.  

Totals Only:  Select this to include only the payment totals. 

Include Unposted Payments:  Select this to include unposted payments in the 
report. 
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Cash Received by Employee Report 
This report includes payments collected by Sales Reps or Drivers.   

NOTE:   This report is often used to pay commissions based on payment 
received totals. 

 

Fields: 
Primary and Secondary Sort:  The primary and secondary fields to sort by.  
Select one of the following categories: 

• Account Number 

• Employee ID 

Date:  The range of dates to include in the report. 

Employee ID:  The range of employee ID numbers to include in the report. 

Account Number:  Enter the account number range to include on the report. 

Sales Rep/Driver:  Select either button for the report to represent payments 
received by either group of employees. 

Sales Reps:  Select which sales representative to include on the report from 
the list below. 

• Sales Rep 1 

• Sales Rep 2 

• Sales Rep 1 or 2 

Include Detail:   Check this box to only include a complete list of details of 
the monies collect to the dates chosen. 
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Disputed Invoices Report   
This report includes a list of all invoices that are Disputed or Resolved within 
each customer’s account.   

NOTE:   Simply right-click on an invoice listed within the Open Invoices 
section of the customer’s account to Dispute or Resolve the item.  
Alternatively, the Disputed Invoices option can be used under Transactions > 
Payments to dispute or resolve items. 

 

Fields: 
Primary and Secondary Sort:  The primary and secondary fields to sort by.  
Select one of the following categories: 

• Invoice Number 

• Invoice Date 

Acct Number:  The range of account numbers to include in this report. 

Invoice Date:  The range of invoice dates to include. 

Statement:  The range of statement numbers to include. 

Disputed:  Select this option to print disputed invoices. 

Resolved:  Select this option to print resolved invoices. 

Both:  Select this option to print disputed and resolved invoices. 
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Prepay Quantities Report 
This report includes each customer’s Prepay Products details.   

NOTE:   For further information on the Prepay Products option, refer to 
Chapter 2.09 of the Supplemental Guide.  

 

Fields: 
Primary and Secondary Sort:  The primary and secondary fields to sort by.   
Select one of the following categories: 

• Account Number 

• Charge Code 

• Date 

• Balance 

• Branch 

Acct Number:  The range of account numbers to include in this report. 

Charge Code:  The range of product codes to include in the report. 

Product Balance:  The range of ‘pre-paid’ balances to include in the report. 

Branch:  The range of company branches to include in the report. 

Dates:  The range of prepay purchases to include in the report. 

Either:  Select this option to include both purchased and used information in 
the report. 

Purchased:  Select this option to only include customer prepay purchases in 
the report. 

Used:  Select this option to only include customers that have used (any 
portion of) their prepay products, in the report. 
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Sales vs. Returns Report 
The Sales vs. Returns Report includes detailed sales and product return 
information that also calculates the percentage of sales vs. returns for the date 
range entered. 

NOTE:   For further information on setting up and managing product returns, 
refer to Chapter 2.13 of the Supplemental Guide. 

 

Fields: 
Sort Option 1, 2, 3:  You can choose from the following categories: 

• Branch 

• Customer Type 

• Account Number 

• Date 

• Charge Code 

• Product Class 

• Employee ID 

• Route 

• Major Acct. Code 

• Period  

• Price 

• Stop 

• Return Reason 

• None 

Account Number:  The range of account numbers to include in the report. 

All:   Default to include all customers. 

Do not group by Master Accounts:  Choose this option to include sub 
account information on the report if using master billing. 



 

30 •••• Reports – Chapter 2B Route Manager Advanced User Guide B 

 

Don’t include inactive Accounts:  Choose this option to exclude account 
information for inactive customers. 

Customer Type:  The range of Customer Types to include in the report. 

All:   Default to include all Customer Types in the report. 

Sales Rep:  The range of Sales Reps to include in the report. 

All:   Default to include all Sales Reps in the report. 

Dates:  The range of dates to include in this report. 

Charge Code:  The range of charge codes to include in this report. 

All:   Default to include all charge codes in the report. 

Product Class:  The range of Product Class Codes to include in the report. 

All :  Default to include all Product Class Codes in the report. 

Route:  The range of Route ID’s to include in the report. 

All:   Default to include all Route ID’s in the report. 

Major Account Code:  The major account number range to include in the 
report.   

All:  Default to include all Major Account Codes in the report. 

Available Return Reasons:  Includes all of the available Return Code 
Reasons. 

Selected Return Reasons:  Includes all of the Return Code Reasons that will 
be included in the report. 

NOTE:   Use the arrows or double-click on each Return Code Reason to add 
or remove from each list. 
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Weekly Returns Report 
The Weekly Returns Report includes detailed product return information for 
any seven day period.  Additionally, this report includes product quantities, 
dollar values, and percentage information. 

NOTE:   For further information on setting up and managing product returns, 
refer to Chapter 2.13 of the Supplemental Guide. 

 

Fields: 
Sort Option 1, 2, 3:  You can choose from the following categories: 

• Branch 

• Customer Type 

• Account Number 

• Date 

• Charge Code 

• Product Class 

• Employee ID 

• Route 

• Major Acct. Code 

• Period  

• Price 

• Stop 

• Return Reason 

• None 

Account Number:  The range of account numbers to include in the report. 

All:   Default to include all customers. 

Do not group by Master Accounts:  Choose this option to include sub 
account information on the report if using master billing. 

Don’t include inactive Accounts:  Choose this option to exclude account 
information for inactive customers. 
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Customer Type:  The range of Customer Types to include in the report. 

All:   Default to include all Customer Types in the report. 

Sales Rep:  The range of Sales Reps to include in the report. 

All:   Default to include all Sales Reps in the report. 

Dates:  The range of dates to include in this report. 

Charge Code:  The range of charge codes to include in this report. 

All:   Default to include all charge codes in the report. 

Product Class:  The range of Product Class Codes to include in the report. 

All :  Default to include all Product Class Codes in the report. 

Route:  The range of Route ID’s to include in the report. 

All:   Default to include all Route ID’s in the report. 

Major Account Code:  The major account number range to include in the 
report.   

All:  Default to include all Major Account Codes in the report. 

Available Return Reasons:  Includes all of the available Return Code 
Reasons. 

Selected Return Reasons:  Includes all of the Return Code Reasons that will 
be included in the report. 

NOTE:   Use the arrows or double-click on each Return Code Reason to add 
or remove from each list. 

Extended Totals Summary:  Select this option to include Net Sales, Gross 
Margin, and additional totals on the report. 
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Returns by Reason Report 
The Returns by Reason Report includes detailed product return information 
listed per Return Code Reason.   

NOTE:   For further information on setting up and managing product returns, 
refer to Chapter 2.13 of the Supplemental Guide. 

 

Fields: 
Sort Option 1, 2, 3:  You can choose from the following categories: 

• Account Number 

• Date 

• Charge Code 

• Product Class 

• Employee ID 

• Route 

• Major Acct. Code 

• Period  

• Price 

• Stop 

• Return Reason 

• None 

Account Number:  The range of account numbers to include in the report. 

All:   Default to include all customers. 

Do not group by Master Accounts:  Choose this option to include sub 
account information on the report if using master billing. 

Don’t include inactive Accounts:  Choose this option to exclude account 
information for inactive customers. 

Customer Type:  The range of Customer Types to include in the report. 

All:   Default to include all Customer Types in the report. 
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Dates:  The range of dates to include in this report. 

Charge Code:  The range of charge codes to include in this report. 

All:   Default to include all charge codes in the report. 

Product Class:  The range of Product Class Codes to include in the report. 

All :  Default to include all Product Class Codes in the report. 

Route:  The range of Route ID’s to include in the report. 

All:   Default to include all Route ID’s in the report. 

Major Account Code:  The major account number range to include in the 
report.   

All:  Default to include all Major Account Codes in the report. 

Available Return Reasons:  Includes all of the available Return Code 
Reasons. 

Selected Return Reasons:  Includes all of the Return Code Reasons that will 
be included in the report. 

NOTE:   Use the arrows or double-click on each Return Code Reason to add 
or remove from each list. 
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Tax 
The Tax report sub-menu contains detailed sales and asset tax reports. 

 

Sales and Tax Report   
This report provides sales and tax information separated by month, quarter, 
and year-to-date.   

NOTE:   Do not use this report solely for sales figures.  Use the Sales Detail 
Report for this information. 

 

Fields: 
Sales Tax ID:  The range of sales tax codes to include in the report. 

Date:  Specify the date range to be used on the report.  These two fields only 
show if Calculate from History is checked. 

Calculate from History:  Choose this option to calculate taxes with a date 
range. 
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Sales Tax Collected   
This report includes the total amount in taxes that has been collected from 
your customers.   

NOTE:   This report is based on payments collected.  For all taxes billed to 
your customers, use the Sales and Tax Report. 

 

Fields: 
Sort Option 1 & 2: 

• Sales Tax ID 

• Description 

Sales Tax ID:  The range of Sales Tax ID numbers to include in the report. 

Date:  The date range to include in the report. 

Include Detail:  Choosing this option will include detailed invoice 
information on the report. 
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Asset Tax Report 
The Asset Tax Report allows you to print a report that indicates the serial 
number and location of any equipment that needs to be tracked, for taxing 
purposes.   

 

Fields: 
Primary and Secondary Sort:  The primary and secondary fields to sort by.  
Select one of the following categories: 

• Equipment ID 

• Asset Tax ID 

• Date 

• Acct No 

Equipment ID:  The range of equipment ID numbers to include in the report. 

Asset Tax Code:  The range of asset tax ID numbers to include in the report. 

Purchase Date:  The date the purchase order was entered, or the date the 
products were purchased/paid for. 

Account Number:  Enter the account number range to include on the report. 

Summary Only:  Check this box to only include a list of account numbers in 
the report.   

Work Sheet Format:  This option will print in a format that can be written 
on. 

Exclude Equipment with Period Code ‘3’:  Choose this option to exclude 
equipment assigned Period Code 3 (Sold Equipment).  

Exclude Equipment with Period Code ‘Z’:  Choose this option to exclude 
equipment assigned Period Code Z (No Rent). 

Exclude Customer Owned Equipment:  Choose this option to exclude 
equipment designated as ‘Customer Owned’. 
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General Ledger 
The General Ledger report sub-menu contains detailed G/L and deferred 
rental reports. 

 

Reprint G/L Report(s) 
This option allows you to generate G/L totals based on the range of dates 
entered.   

NOTE:   This is a useful alternative to the General Ledger Postings Report — 
found under the Transactions menu — for users that do not wish to capture 
month-to-date totals only.  

 

Fields: 
Date Range: The range of dates to include in the report. 

Account Range:  The range of account numbers to include in the report. 

Export G/L File:  Select this option to export the G/L totals (QuickBooks). 

Show Detail:  Check this box to include all pertinent details on the report. 
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Deferred Rentals Report   
This report will display Deferred Rent totals for the G/L Period selected. 

NOTE:   Refer to Chapter 4.07 of the Supplemental Guide for further 
information on Deferred Rentals. 

 

Fields: 
Primary and Secondary Sort:  The primary and secondary fields to sort by.  
You can choose from the following categories: 

• Serial number 

• Customer 

Account No.:  The range of account numbers to include on this report. 

Serial No.:  The range of equipment serial numbers to include on the report. 

Product:  Enter the range of rental codes to include on the report. 

G/L Period:  Select the appropriate G/L period to view. 

Include Detail:  Check this box to obtain a detailed report, not just a 
summary report. 
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Customer 
The Customer report sub-menu contains various customer related reports.   
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Aging Analysis   
This report displays customer balances by the number of days outstanding, 
and identifies the accounts that have fallen behind in payments.   

NOTE:   Phone numbers are included on the report for contacting these 
customers.  Additionally, this report functions as an ‘Aged A/R Report’.   

 

Fields: 
Primary Sort:  The primary fields to sort by.  You can choose from the 
following categories: 

• Account Number 

• Account Name 

• Balance 

• Credit Class 

• Status Code 

• Branch 

• Balance (High to Low) 

Account Number:  The range of accounts to include in the report. 

Customer Type:  The range of customer types to include in the report.   

Credit Class:  The range of classes to include - Credit Classes are set up in 
the List pad and applied to each customer account. 

Acct Status:  Select the range of codes to include in this report.  Account 
status codes are defined in the Customer Status field in Customer Setup 
Codes, under Lists. 

All:   Check these boxes to include all accounts in the report, regardless of the 
specified criteria. 

Age Sub Accounts Individually:  Select this option to include detailed aged 
balance information for each Sub Account separate from their associated 
Master Account. 

Balance:  The range of balances to include, from low to high. 
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Major Account Code:  The range of major account codes to include on the 
report.   

Credit Controller:  The range of Credit Controller Types to include in the 
report.   

All:  Check these boxes to include all available Credit Controllers in the 
report, regardless of the specified criteria. 

Periods:  Select the appropriate period from the dropdown menu. 

Include:  Choose the columns to include on your report.  The program 
automatically lists all delinquent accounts.  However, you can narrow the list 
by selecting:  Current, 30, 60, 90, or 120 or more days overdue. 

Summary Only:  Only the aged A/R totals will print on the report. 

Hold Service Only (Credit Class):  Select this option to only include 
customers, by Credit Class, that are on Hold Service status in the report. 

Hold Service Only (Forced):  Select this option to only include customers 
that have been manually placed on Hold Service. 

Exclude Zero Balance Customers:  This will exclude all accounts on the 
report with a zero balance.   

Export Route for First Stop:  Select this option to include the Route ID with 
the first customer when exporting the report (by selecting the export button). 

Collections Accounts 
Use this report to view customers that are assigned to a ‘Collections’ type 
Credit Class Code within Customer Information.  

 
Fields: 
Primary Sort:  The primary fields to sort by.  You can choose from the 
following categories: 

• Account Number 

• Account Name 

• Balance 

Acct Number:  The range of accounts to include in the report. 

Customer Type:  The range of customer types to include in the report. 

Credit Class:  Designate a specific credit class from the drop-down list.  If 
you use a credit class code other than "W" to indicate collection accounts, 
select that code. 

Customer Ending Date:  The range of customer ending dates. 
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Balance:  The range of balances to include in the report, from low to high. 
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Returned Checks Report 
This report includes information regarding unpaid, and paid, returned checks 
processed through RMA.  

 
Fields: 
Primary and Secondary Sort:  The primary and secondary fields to sort by.  
You can choose from the following categories: 

• Entry Date 

• Account Number 

• Check Amount 

Acct Number:  The range of accounts to include in the report. 

Entry Date:  The range of entry dates to include in the report. 

Check Amount:  The range of check amounts to include in the report, up to 
999,999.99 for each check. 

Unpaid:  Select this box to only show returned checks that have not been 
paid. 

Paid:  Select this box to only show returned checks that have been paid. 

NOTE:   You may select both ‘Paid’ and ‘Unpaid’ if desired. 
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Inactive Accounts with Balances  
Use this report to view accounts that are inactive, but have a remaining 
balance.  

 

Fields:  

Primary and Secondary Sort:  The primary and secondary fields to sort by.  
You can choose from the following categories: 

• Customer 

• End Date 

Ending Date:  Enter the date range you would like to include in the report.  
The Ending Date is the date the customer was placed on inactive status. 

Acct Number:  The range of accounts to include in the report.   

Account Status:  The account status range to include in the report.   
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Customer Credit Limit Report 
This report identifies customers that have exceeded their assigned credit limit.   

 

Fields: 
Sort Options 1&2:  You can choose from the following categories: 

• Account Number 

• Name 

• Credit Limit 

Account Number:  The range of accounts to include in the report. 

Start Date:  The range of customer start dates to include in the report. 

Customer Type:  The range of customer types to include in the report.   

Sales Rep:  The range of sales reps to include in the report. 

Credit Class:  The range of credit classes to include in the report. 

Account Status:  The range of account status to include in the report. 

Major Acct. Code:  The range of major account codes to include in the report. 

Exclude Accounts Not Over Credit Limit:  Select this option to view only 
customers that have exceeded their allotted credit limit. 

Include Near Limit (80%):  Select this option to include customers that have 
used at least 80% of their allotted credit limit. 

Exclude 0 Credit Limit Accounts:  Select this option to exclude customers 
that do not have an assigned credit limit (e.g., 0.00). 
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Customer Refunds List 
This report includes information regarding customers that have a credit 
balance and are no longer active. 

NOTE:   Leave the From Date blank to include active customers with a credit 
balance. 

 

Fields: 
Primary and Secondary Sort:  The primary and secondary fields to sort by.  
You can choose from the following categories: 

• Account Name 

• Account Number 

• Date 

• Refund Amount 

Account Number:  The account range to include in the report. 

Amount:  The range of account balances to use in the report.  The amount can 
range from $-0.01 to $-999, 99.99. 

Term Date:  The range of dates to include in the report.  This report selects 
dates based on the customer’s termination date. 
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Consolidated Billing Summary  
This report includes a balance summary of each account assigned to the 
Consolidated Statement option within Customer Information.   

 

Fields: 
Sort Option 1 & 2:  Choose from the following categories: 

• Date 

• Account Number 

• Account Name 

• Customer Type 

• Major Account Code 

• Zip  Code 

• Tax Code 

Statement Types:  The statement range to include in the report. 

Acct No:  The account number range to include in the report. 

Close Date:  Enter the Period Close Date that will be listed on the report. 
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Account Deposit Report 
This report includes deposit totals entered in the Deposit field within 
Customer Information, on the Finance tab.   

NOTE:   The Deposit field is updated each time a product is sold with the 
‘Update Account Deposit’ flag checked within Product Charge Codes.  This 
option is typically used for miscellaneous deposits (e.g., equipment deposit).   

 

Fields: 
Primary and Secondary Sort:  The primary and secondary fields to sort by.  
You can choose from the following categories: 

• Date 

• Account Number 

• Account Name 

• Customer Type 

• Major Account Code 

• Zip Code 

• Tax Code 

Account Number:  The range of accounts to include on the report. 

Start Date:  Select the range of customer start dates to appear on the report. 

Customer Type:  The range of customer types to include on this report.   

Only Non-Terminated Customers:  Check this box to filter out all inactive 
accounts. 
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Default Products by Customer Report  
This report includes information related to default products assigned to each 
customer. 

 

Fields: 
Primary and Secondary Sort:  The primary and secondary fields to sort by.  
You can choose from the following categories: 

• Product Class 

• Charge Code 

• Customer 

Account Number:  The range of accounts to include on the report. 

Product Class:  Select the range of Product Classes to appear on the report.   

Charge Code:  Select the range of Charge Codes to include on this report. 

Customer Type:  The range of customer types to include on this report.   

Customer Level Detail:  Select this option to include account numbers on the 
report. 
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Point Status Report 
Use this report to view earned points per customer, as part of the Customer 
Retention Program.  

NOTE:   The Customer Retention Program allows you to provide incentives 
to your customers for purchases.  Refer to Chapter 4.04 of the Supplemental 
Guide for further information. 

 

Fields: 
Primary and Secondary Sort:  The primary and secondary fields to sort by.  
You can choose from the following categories: 

• Customer 

• Type 

• Points 

• Date 

Acct Number:  Select the range of account numbers to include on the report. 

Current Points:  Select the range of current points to include in the report. 

Date:  Input the range of dates you want to include on the report. 

Summary totals only:  Check this box to only print the summary page of the 
report, not the details.  



 

52 •••• Reports – Chapter 2B Route Manager Advanced User Guide B 

 

Top Customer Report 
This report allows you to view customers that are purchasing a high volume 
of items from the company.   

 

Fields: 
Primary and Secondary Sort:  The primary and secondary fields to sort by.  
You can choose from the following categories: 

• Route 

• Account number 

• Units 

• Amount 

Routes:  The range of routes to include in the report. 

Date:  Input the range of dates you want to include on the report. 

Top By:  Choose to sort by the highest number of units sold or by dollar 
amount. 

Purchased More than:  Insert a minimum number in the box to select only 
top customers. 

Available Products and Selected Products:  Select which charge codes are to 
be included in this report and move them to the selected products box. 

Remember Items in List:  Check this box to maintain this same list. 

Combine Products:  Click this box to display one entry per product on the 
report. 
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Top Customer by Geographic Area  
Use this report to display the top customers in each geographic area serviced 
by your company.   

NOTE:   Group Area Codes need to be assigned to each customer. 

 

Fields: 
Period Date:  Enter the date range to include in the report. 

Geographic Area:  Enter the range of geographic areas to include in the 
report. 
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Other (Accounting Reports) 
The Other report sub-menu contains miscellaneous product and customer 
related reports. 

 

Credit/Write-Off Invoices 
Use this report to display ‘credit’ and ‘write-off’ invoices posted to each 
customer’s account.    

NOTE:   Credit Note and Write-Off Reasons are found under Lists > 
Accounting Setup.  These codes can be assigned to invoices from within the 
Customer Finance Assistant. 

 

Fields: 
Primary and Secondary Sort:  The primary and secondary fields to sort by.  
You can choose from the following categories: 

• Invoice Number 

• Invoice Date 

Acct Number:  Enter the range of customers to include in this report. 

Invoice Date:  Enter the range of invoice dates to include in this report. 

Credit Class:  Enter the range of credit classes to include in this report. 

Customer Type:  Enter the range of customer types to include in this report.   

Amount:  Enter the invoice amounts to include in this report. 

Reason:  Enter the range of ‘write-off reasons’ to include in the report.  

Write-Offs:  Include only write-offs on the report. 

Credits:  Include only credits on the report.   

Credits & Write-Offs:  Include both credits and write-offs on the report.   
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Product Deposits on Hand 
This report shows the total number of bottles (containers) at each customer’s 
location.   

 

Fields: 
Primary and Secondary Sort:  The primary and secondary fields to sort by.  
You can choose from the following categories: 

• Account Number 

• Account Name 

• Quantity 

Product Code:  The range of product ID’s to include in the report. 

Acct Number:  Select the range of customers to generate in this report. 

Bottles on Hand:  The range of the number of bottles on hand. 

Print Details:  Select this option to include account level detail on the report. 

Include Customers with Zero Quantities:  Check this box to include 
customers without any bottles-on-hand quantities.   

Show Customer Activity:  Select this option to display the report based on a 
range of customer activity dates. 
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Product Comparison Sales Report 
Use this report to compare two products and their selling trends. 

 

Fields: 
Product:  In these two fields, enter two products to be compared. 

Last Period/This Period:  Establish two periods for making the comparisons 
for the two selected product charge codes. 

Cust ID:  The range of account numbers to include on this report. 

Major Acct ID:  The range of Major Account codes to include on the report.   
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Refund Check List 
This report displays processed refund check information. 

 

Fields: 
Primary and Secondary Sort:  The primary and secondary fields to sort by.  
You can choose from the following categories: 

• Check Number 

• Check Date 

• Acct Number 

• Acct Name 

Check Date:  Enter the refund check date range to include in the report. 

Acct Number:  Select the range of customers to generate in this report. 

Check Number:  Enter the refund check number range to include in the report 
(date range available when selected). 
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Management Reports 
This section includes several reports that will help your management team 
obtain important high level information. 

 
Each report is explained within the section below. 
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Starts and Stops 
This report allows you to monitor the reasons why customers are starting and 
stopping service with the company.  

 

Fields: 
Primary and Secondary Sort:  The primary and secondary fields to sort by.  
You can choose from the following categories: 

• Account Number 

• Date 

• Reason 

• ZIP Code 

• Employee ID 

Account Number:  The range of accounts to include in the report. 

Start Date:  The range of start dates to include in the report. 

Reason:  The range of Start/Stop Reasons to include in the report.   

ZIP Code:  The range of ZIP Codes to include on the report. 

Sales Reps From: and To:  The range of sales reps (one to three) to include 
on the report. 

Customer Status:  The range of customer status designations to include in the 
report (leave the From field blank when not in use). 

Which Report?  Select the type of report you wish to print. 

• Additions (Starts) 

• Terminations (Stops) 

Only include accounts with credit balances:  Check this box to include only 
accounts with a credit balance. 

Only include accounts with no payment:  Check this box to include only 
people refusing to pay.   

Include start/stop reason summary:  Check this box to include a start/stop 
reason summary at the end of the report. 
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Extended Information:  This option will enable more detailed information to 
be printed on the report. 

NOTE:   Extended Information is only included when the Termination report 
option is selected. 

Business Pulse Report 
This one page report includes information such as A/R balances, cash 
collected, and rent totals for the month.   

 
 

Business Flash Report 
The Business Flash Report is a powerful tool to measure the performance of 
your operations.  It consists of two parts: setting goals, and accumulating 
performance statistics.  Before you can run this report, it is necessary to enter 
your company goals for several key indicators.  This is done in Flash Report 
Setup, under Tools.   

NOTE:   For further information on setting up this report, please contact 
Advantage Route Systems. 

 

Fields: 
Period:  Input the period that you want reflected in the report.  

Branch To and From:  Select the range of Branches to be included in the 
report. 
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Route Commission Report 
This report includes product and commission totals for your drivers and route 
salesmen. 

NOTE:   Refer to Chapter 2.05 of the Supplemental Guide for further 
information on setting up commissions.   

 

Fields: 
Primary Sort:  This option is defaulted for you.  This report can only be 
printed by employee ID. 

Employee:  The range of employees to include in the report. 

Select the type of employee to run this report for from the list: 

• Drivers 

• Sales Person 1 

• Sales Person 2 

• Sales Person 3 

Commission:  The range of commission codes to include in the report. 

Route:  The range of routes to include in the report. 

Chrg. Code (Only if Show Detail is selected):  The range of product charge 
codes to include in the report. 

Unposted Invoices:  Use this option to only include invoices that have not 
been posted on the report. 

Include Inactive Employees:  Select this option to include employees with a 
release date on the report. 

Show Detail:  Selecting this box will bring up the Product Charge Code filter.  
This way you may select details for certain products. 

Suppress Empty Commission Classes:  Choose this option to remove 
commission classes without any activity. 

Summary:  Check this box to obtain a summary report only.   

Invoice Date:  The range of invoice dates to include in the report.  The 
primary invoice is typically the current month. 
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Include Beginning Balance:  Select this box to include beginning balance on 
the report, these totals are established within the employee setup screen. 

Sales Commission Report   
If your company pays commission to sales reps assigned to each account, this 
report can be used to calculate commissions based on the percentage entered 
manually for a given date range. 

 

Fields: 
Sort Option 1:  The sort option is defaulted for you.  This report can only be 
sorted by Employee ID. 

Salesman:  Enter the range of sales reps to include in the report. 

Customer Start Date:  Enter the customer start date range to include in the 
report. 

Commission Rate:  Enter the commission rate (percentage) that should be 
used in calculating the sales rep(s) rates. 

Invoice Date:  Enter the invoice date range to include in the report. 
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Driver Summary Report   
This report includes product sales totals and payment information based on 
the Commission Class Codes assigned to each product.  

NOTE:   Use the Route Commission Report to view a more traditional 
commission report that includes totals that should be paid to each employee. 

 

Fields: 
Primary and Secondary Sort:  The primary and secondary sort options are: 

• Driver 

• Invoice Date 

Employee Initials:  The range of drivers to include in the report. 

Invoice Date:  The range of invoice dates to include in the report. 

Unposted:  This report is generated from unposted transactions. 

All Employees:  Check this box to include all employees and drivers in the 
Driver Summary report. 

Include Inactive Employees:  Select this option to include employees with a 
Release Date on the report. 

Commission Codes:  Select the commission codes that you wish to include 
from the list that appears.  If you do not select specific commission codes, the 
program will include all commission codes in the report.   

De-select All:  Check this box to restart the selection process.   
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Production Planning Forecast 
To help you plan how much product you will need for your route demands, 
use the following report.  It not only looks back to a base period, but will also 
let you add or subtract a percentage from your base period to accommodate 
fluctuations in seasonal demand, temperature, or other factors.  By entering 
ending inventory levels, you can also prepare for high demands.   

 

Fields: 
Primary Sort:  This option is defaulted for you.  This report can only be 
printed by charge code order, and you can only print the report for one 
product at a time. 

Baseline Date:  Input a range of dates that you would like to use for the 
baseline.  Typically, this is one month or one week.  Too large a period is 
difficult to use and too short a period can be a poor indicator for the future. 

Forecast Date:  Input the date for the beginning of the forecast.  The ending 
date will match the same period length that you chose for the baseline date. 

Product Charge Code:  Input the charge code you wish to forecast.  Only one 
code is allowed. 

Growth over base line period:  Input the change from the baseline values that 
you would like to add or subtract for the growth in sales of the product in the 
forecasted period.  This percentage can be either positive or negative to meet 
your needs. 

Ending Inventory requirement:  Input the required quantity of this product to 
be in your inventory at the end of the sales forecast. 
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Production Batch Report 
This report is used for reference to products checked in with an assigned 
Production Batch Code.   

 

Fields: 
Primary and Secondary Sort:  The primary and secondary fields to sort by.  
You can choose from the following categories: 

• By Prod. Batch Code 

• By Account No. 

• By Quantity 

Prod. Batch Code:  Enter the range of batch numbers to include in the report. 

Date:  Enter the date range to include in the report. 

Acct No.:  Enter the account number range to include in the report. 

Include Unposted Invoices:  Choose this option to include unposted 
transactions in the report. 

Summary Only:  Choose this option to suppress the detailed information on 
the report. 
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Request Cancel Date Report 
This report will display the customers that have requested to cancel their 
service.  

NOTE:   This information is available when a date is entered in the ‘Request 
Cancel Acct.’ field within Customer Information, on the Credit tab.  

 

Fields: 
Primary and Secondary Sort:  The primary and secondary fields to sort by.  
You can choose from the following categories: 

• Account Number 

• Request Cancel Date 

• Employee ID 

Branches:  You may choose to run the report for a single branch or a range of 
branches.  Select the first and last branch to include on this report. 

Request Dates:  Enter the date range to be included on the report. 
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Expiring Contracts Report 
This report will provide you with information related to the contract 
management system in RMA. 

NOTE:   RMA includes contract options that will allow you to create, edit, 
and manage contract information on your customer’s accounts.  This feature 
can be used in a variety of different ways.  Refer to Chapter 4.08 of the 
Supplemental Guide for further information. 

 

Fields: 
Primary and Secondary Sort:  The primary and secondary fields to sort by.  
You can choose from the following categories: 

• Contract Number 

• Account Number 

• Expiration Date 

• Contract Type 

Account Number:  The range of accounts to include in the report. 

Contact Type:  The range of contract types to include in the report. 

Contract No:  Enter the range of contract numbers to include in the report. 

Start Date:  The range of contract start dates to include in the report. 

Expiration Date:  The range of contract expiration dates to include in the 
report. 

Include Equipment Detail:  Select this option to include contract assigned 
equipment per customer in the report. 
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Projected Delivery Report 
This report calculates customer delivery needs based on their projected usage.  

NOTE:   This report is generally only used in the propane industry. 

 

Fields: 
Primary and Secondary Sort:  The primary and secondary fields to sort by.  
You can choose from the following categories: 

• City 

• Percent Full 

• Zip Code 

Available Products:  The product list available. 

Selected Products:  Add the product range that should be included in the 
report. 

Cylinders/Bulk:  Choose one of the radio options to control the displayed 
column headings on the report: 

• Cylinders = Bottles per Day / Capacity of Racks (for 20lb 
Cylinders). 

• Bulk = Gallons per Day / Tank Capacity. 

Cut Off Date:  The projected end date the report should include, based on the 
customer’s delivery calendars (generally entered a week or more in advance). 

% Full From/To:  The projected amount full that the system should include 
in the report (e.g., 1 to 60%). 

Include Degree Days:  Select this option to include Daily Temperature 
Recording report figures. 

NOTE:   For further information on Daily Temperature Recordings used 
primarily in the propane industry, refer to Chapter 3.22 of the Supplemental 
Guide. 

City From/To:  Enter the range of cities to include in the report.  

Look back last __ deliveries:  Enter up to five previous deliveries to include 
in the report — increasing the number of deliveries will result in a more even 
approximation. 
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Customer Consumption Summary 
The Customer Consumption Report includes various information on rate of 
product consumption. 

NOTE:   This report can only be viewed within Microsoft Excel. 

 

Fields: 
Primary and Secondary Sort:  The primary and secondary fields to sort by.  
You can choose from the following categories: 

• Account Number 

• Sales Rep: 

• Start Date 

• Current Price 

• Customer Type 

• Route 

• Major Account Code 

Account Number:  The range of accounts to include in the report. 

Customer Type:  The range of Customer Types to include in the report. 

Sales Rep:  Enter the range of Sales Representatives to include in the report. 

Dates:  The range of activity dates to include in the report. 

Charge Code:  The range of Charge Codes to include in the report. 

Product Class:  Select the range of Product Classes to include in the report.   

Route:  The range of routes to include in the report. 

Major Acct Code:  The range of Major Account Codes to include in the 
report. 
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Expired Purchase Orders 
This report includes expired purchase order information entered within the 
Route tab of Customer Information.   

 

Fields: 
Primary and Secondary Sort:  The primary and secondary fields to sort by.  
Sort by the following categories: 

• Account Number 

• PO number 

Expiration Date:  The range of expiration dates to include on this report. 

All:  Default to include all expiration dates. 

Customer Type:  The range of customer types to include on this report. 

Percent Amount:  The percentage to include on the report based on the 
amount available on the P.O. number. 

All:  Default to include all percent amounts. 

Percent Qty:  The percentage to include on the report based on the quantity of 
products available on the P.O. number.  

All:  Default to include all percent quantities. 
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Key Point Index by Route 
This report allows you to view delivery statistics per route based on posted 
invoices and payments. 

 

Fields: 
Sort Option 1 & 2:  The primary and secondary fields to sort by, you can 
choose from the following categories: 

• By Route 

• By Date 

Date:  Enter a range of delivery day(s) dates to include in the report. 

Operator (Route):  Enter a range of routes to include in the report.   

Include Invoice Details:  Check this box to retrieve all details.   
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Pre-Route Total Net/Serviced Customers 
Report:   
This report will track the number of customer’s that have been “serviced” 
each delivery day — based on the items added to the Products Indicating 
Serviced field located within Lists > Routes > Handheld Class, on the Upload 
Reports 2 tab.   

 

Fields: 
Sort Option 1 & 2:  The primary and secondary fields to sort by, you can 
choose from the following categories: 

• By Route 

• By Date 

Date:  Enter a range of delivery day(s) dates to include in the report. 

Operator (Route):  Enter a range of routes to include in the report.   

Include Invoice Details:  Check this box to receive the full detailed report.   
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Free Product Report 
The Free Product Report has been created for companies that generate credits 
for free products on the desktop when using Period Discount Pricing — this 
report does not apply to the percentage discount option.   

NOTE:   For further information on Period Discount Pricing, refer to Chapter 
2.15 of the Supplemental Guide. 

 

Fields: 
Sort Option 1:  The primary fields to sort by.  You can choose from the 
following categories: 

• By Account Number 

• By Period Discount Code 

Date:  Enter a range of invoice dates to include in the report. 

Account Number:  Enter a range of account numbers to include in the report.   

Major Account Codes:  Enter a range of Master Account Codes to include in 
the report.   
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Customer Promotions Report 
The Customer Promotions Report includes information related to Customer 
Promotions found under Lists > Customer Setup Codes. 

NOTE:   This report can only be viewed within Microsoft Excel. 

 

Fields: 
Sort Option 1 & 2:  The primary and secondary fields to sort by, you can 
choose from the following categories: 

• By Route 

• By Date 

• By Account No. 

Account Number:  Enter a range of account numbers to include in the report.   

Customer Type:   

Date:  Enter a range of delivery day(s) dates to include in the report. 

Promotion:  Select the range of Customer Promotions to include in the 
report. 

Route:  Enter a range of routes to include in the report.   
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Communication Reports 
This section contains several reports that will help you track customer 
communications with your service staff. 

These reports include the following: 

 
These reports are explained in detail within the section below. 

Delivery Orders Report 
This report includes all of the Delivery Orders entered and scheduled by your 
employees.   

 

Fields: 
Primary and Secondary Sort:  The primary and secondary fields to sort by.  
You can choose from the following categories: 

• Account Number 

• Primary Date 

• Secondary Date 

• Employee 

• Route 

Acct Number:  Enter the range of account numbers to include in the report. 

Time:  When selecting entered orders you can specify the hour range the 
order was taken.  This can be helpful, for example, if you only want the new 
orders for the next two hours. 

Primary & Secondary Date:  Select the criteria for the primary and 
secondary date.  Then, enter the range of primary and secondary dates to 
include in the report. 
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Employee:  Select the criteria for the employees.  Then, select the range of 
employees that entered the request to include on the report. 

Open Tickets:  Select this option to view all delivery orders that have not yet 
been filled. 

Completed Tickets:  Select this option to view all delivery orders that have 
been completed. 

Both:  Select this option to view both open and completed delivery orders. 

Print Qty:  Products available in this drop-down are assigned to any pending 
orders on the delivery tickets.  Only one product can be selected to print on 
the report. 

Exclusive:  Choose this option when assigning a product to the ‘Print Qty’ 
drop-down to filter out all orders that do not include the product in a Pending 
Order.   

Group by Employees Dropdown Filter:  Check this box to print the report by 
the established Employee Groups. 

Reasons:  A list of delivery orders that have been entered into the system 
under Lists, Delivery Orders. 

  Click this button to move the selected delivery order from the list of 
Reasons to Selected Reasons. 

  Click this button to move all of the delivery orders in Reasons to 
Selected Reasons. 

  Click this button to move the selected delivery order from Selected 
Reasons to Reasons. 

  Click this button to move all of the delivery orders in Selected 
Reasons to Reasons. 

Selected Reasons:  This list shows which delivery orders you are including 
on the report. 

Include Blank Reasons:  Select this option to include pending orders that 
were not assigned a Delivery Order Reason. 

Include Message:  Select this option to include messages in the report. 

Include Reason Code:  Select this option to include reason codes in the 
report. 

Include Address:  Select this option to include customer’s address in the 
report. 

Include Phone Number:  Select this option to include customer’s phone 
number in the report. 

Verbose Reason Codes:  Select this option to include Verbose Reason Codes 
in the report. 
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Pre-Sale Delivery Orders 
This report includes all of the Delivery Orders created using the Route Pre-
Sale function on the Route menu. 

 

Fields: 
Sort Option 1 & 2:  Sort by the following fields: 

• Account number 

• Primary Date 

• Secondary Date 

• Employee 

• Route 

Acct No:  The account number range to include in the report. 

Time:  Time that the Pre-Sale was completed to include on the report. 

Primary & Secondary Date:  Enter the range of primary and secondary dates 
to include in the report. 

Open Tickets:  Choose this option to display the open orders. 

Completed Tickets:  Choose this option to display only the completed orders. 

Both:  Choose this option to include both the Open and Completed orders on 
the report. 

Employee:  Select the criteria for the employees.  Then, select the range of 
employees that entered the request to include on the report.   

Contact Via Codes:  Choose the contact codes to include on the report: 

• E-mail 

• Fax 

• Telephone 

• Other 
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Contact History Messages  
This report allows you to print a summary of contact messages entered by 
your staff for the selected search criteria.  The flexible format allows you to 
see a report by a variety of parameters including dates, operators, and reasons.  
This will allow you to maintain a high degree of control over customer 
service personnel so that quality service can be given to your customers.   

NOTE:   Contact history messages are originally entered on the Contacts tab 
in the Customer Information screen. 

 

Fields: 
Primary and Secondary Sort:  The primary and secondary fields to sort by.  
You can choose from the following categories: 

• Account Number 

• Date 

• Employee 

Acct Number:  Enter the range of account numbers to include in the report. 

Entered Date:  Input a range of dates that the message was entered to include 
on the report. 

Follow Up Date:  Enter a range of follow up dates to include on the report.  
This allows you to use the report for future items that may be coming due. 

Employee:  Select the range of employee initials that originally entered the 
request for this report. 

Follow Up:  Select the range of employee initials that followed up on the 
request. 

Open Tickets:  Will only include the Open Tickets on the report. 

Completed Tickets:  Will only include the Completed Tickets on the report. 

Both:  Will include both Open and Completed Tickets on the generated 
report. 

Reasons:  You may choose the contact message reasons that you would like 
to include on the report. 

  Click this button to move the selected contact message reason from 
available Reasons to Selected Reasons. 

  Click this button to move all of the available contact messages from 
Reasons to Selected Reasons. 
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  Click this button to move the selected contact message reason from 
Selected Reasons to Reasons. 

  Click this button to move all contact message reasons from the 
Selected Reasons to Reasons. 

Selected Reasons:  This list shows which contact message reasons you are 
including on the report. 

NOTE:   You may also double-click on a selected item to move it from one 
area to the other. 

Include Blank Reasons:  Select this box to include blank reasons on the 
report.   
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Log Report 
For quality control certain changes made by users in RMA will be recorded in 
the Log Report.  The amount of information logged can be adjusted under 
Branch Setup, on the Logging tab.   

 

Fields: 
Primary and Secondary Sort:  The primary and secondary fields to sort by.  
You can choose from the following categories: 

• Modified Date 

• Employee ID 

Modified Date:  Input the range of dates the record(s) shown on this report 
were modified. 

Employee ID:  Select the range of employee ID numbers you want included 
on the report. 

Acct:  Select the range of Account numbers you want included on the report. 

Log Type:  The user can select either the customer log or the administrative 
log to obtain the desired information. 

Fields:  The list of available fields to include on the report. 

Selected Fields:  This list shows the fields you have chosen to include on the 
report. 

  Click this button to move the selected field from Fields to Selected 
Fields. 

  Click this button to move all of the fields in Fields to Selected Fields. 

  Click this button to move the selected field from Selected Fields to 
Fields. 

  Click this button to move all of the fields in Selected Fields to Fields. 
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Route Reports 
This section has a diverse selection of reports to help your route managers 
when they need information. 

These reports consist of the following categories: 

 

Daily 
The following nine reports are normally printed each day as a summary of 
route activities. 

 



 

82 •••• Reports – Chapter 2B Route Manager Advanced User Guide B 

 

Past Due Average by Route  
The Past Due Average by Route report will help determine the scale of 
delinquency and which routes have the most problems with delinquent 
accounts.  Priorities for collection and collection techniques can be 
established in terms of routes or areas to target.  It should also be helpful in 
deciding on the necessary actions to take to correct the problems or prevent 
future problems.   

 

Fields: 
Primary Sort:  Select this option to sort by a customer’s account number or 
account name.   

Route:  The range of routes to include in the report. 

Balance:  The range of balances to include in the report.  You must have the 
“Include Detail” box checked before you can input figures into this field. 

Include Detail:  Select this box to include the transaction details in the report.  
Check this box to allow sorting by Account Name or Account No.   

Show Column Totals **:  The totals will not match the aging report. 

Include Special Stops:  Click this box to include special stops in the report. 
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Past Due by Route Day 
Print this report by day and distribute to the appropriate driver or sales person 
to place urgency on collecting payments from customers.  

 

Fields: 
Sort Option 1 & 2:  You can choose from the following categories: 

• Account Number 

• Account Name 

• By Sequence 

• Credit class 

• Status Code 

• Customer Type 

Route:  Specify a range of routes to include in the report from the drop-down 
list. 

Promised Date:  The range of route dates to include in the report. 

Include:  Choose the data ranges to include in this report.   

Blank Lines:  Select how many blank lines you want between each account 
on the report. 

Credit Class:  The range of credit classes to include in the report. 

Account Status:  The range of account status codes to include in the report. 

Acct Type:  The range of customer account types to include in the report. 

Include Authorization Codes:  Select this box to have the requested 
Authorization Codes listed on the report. 

Include All Dates for this Route:  Checking this box to include ALL Dates 
on the route(s) specified. 

Summary Totals Only:  Choose this option to suppress the detailed customer 
information on the report. 

Include all Customers on Route:  Choose this option to include all customers 
on the report, regardless of balance or past due status.  

Don’t Include Will Call Customers:  Choose this option to exclude accounts 
marked as ‘Will Call’ from the report. 
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Authorization Codes 
The Authorization Codes report includes release codes that can be entered on 
the handheld on the date and route selected.  The codes may apply to one or 
more of the following account standings:  Hold Service, Past Due, 
Suspended, Over Credit Limit, and COD.  

NOTE:   Release Code requirements are optional and can be established 
under Lists > Routes > Handheld Class, on the Finance tab. 

 

Fields: 
Primary and Secondary Sort:  The primary and secondary fields to sort by.  
You can choose from the following options: 

• Account Number 

• Route 

Route Date:  The range of delivery dates to include on the report. 

Route:  The range of routes to include on the report. 
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Payment Summary  
This report provides a summary of payments received per route.  New screen 
shot needed to add Summary List Only checkbox.  It is included in writeup. 

NOTE:   This can be helpful if you pay commissions to each route driver 
based on money collected. 

 

Fields: 
Primary Sort:  This option is defaulted for you.  This report can only be 
sorted by route. 

Date:  The date that you want the report to be run for. 

Route:  The range of routes to include in the report.   

Summary List Only:  Check this box for a summary report only. 
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Tickets Not Printed 
This report will give you a list of Delivery Order tickets that have not been 
printed. 

  
Fields: 
Sort Option 1 & 2:  The primary and secondary fields to sort by.  You can 
choose from the following categories: 

• Route 

• Date 

Route:  Enter a range of routes to include in the report. 

Promised Date:  Enter a range of delivery day(s) dates to include in the 
report. 

Include all Customers on Route:  Choose this option to include all customers 
with Delivery Orders that fit the criteria entered. 
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Printed Tickets Not Entered 
This report will give you a list of tickets that have been printed but have not 
been entered into the system. 

  
Fields: 
Sort Option 1 & 2:  The primary and secondary fields to sort by.  You can 
choose from the following categories: 

• Route 

• Date 

Route:  Enter a range of routes to include in the report. 

Promised Date:  Enter a range of delivery day(s) dates to include in the 
report. 

Include all Customers on Route:  Choose this option to print all customers 
with Delivery Orders that fit the criteria entered. 
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Delivery Order Status 
This report will give you a list of Delivery Orders entered in the system based 
on a wide range of criteria options. 

 

Fields: 
Sort Option 1 & 2:  The primary and secondary fields to sort by.  You can 
choose from the following categories: 

• Route 

• Scheduled Route 

• Entry Date 

• Promised Date 

• Acct. No. 

Route:  Choose between Scheduled Route and Customer Route.  Then, enter a 
range of routes to include in the report.   

Promised Date:  Choose either Promised Date or Created Date and enter the 
desired date range. 

Unconfirmed Delivery:  Choose this option to include Unconfirmed 
Deliveries on the report. 

Confirmed Delivery:  Choose this option to include Confirmed Deliveries on 
the report. 

Printed:  Choose this option to include printed Delivery Orders on the report. 

Closed:  Choose this option to include closed Delivery Orders on the report. 

Posted:  Choose this option to include posted Delivery Orders invoices on the 
report. 

Invoiced:  Choose this option to include invoices created for Delivery Orders 
on the report. 

Include all Customers on Route:  Choose this option to include all customers 
with Delivery Orders based on the criteria entered. 
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Special Orders Report 
This report displays special order information collected on route for the dates 
entered. 

 

Fields: 
Sort Options 1&2:  These options are defaulted for you by employee ID and 
account number. 

Account Number:  Enter the range of account numbers to include in the 
report. 

Route Date:  Enter the route dates to include in the report. 

Route:  Enter the range of route ID’s to include in the report. 
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Sales 
This section contains several reports that are related to product sales. 

These reports include the following:  New screen shot needed to add 
Customer Activity Report below Gratis Sales. 

 
These reports are explained in detail within the section below. 

Sales Summary by Route  
A tool to help in managing your routes is the Sales Summary by Route report.  
This report shows sales for individual routes and service days.  This printed 
report only displays a summary unless Include Detail is checked. 

 

Fields: 
Primary Sort:  This option is defaulted for you.  This report can only be 
printed by route. 

Route Date:  The range of dates to include in the report. 

Route:  The range of routes to include in the report. 

Include Detail:  This option will include more details in the printed report. 

Include Off Route:  Check this box to include off-route customers and 
regular customers on the report. 
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Product Sales Summary 
This report provides a summary of products sold by route.  

 

Fields: 
Sort Option 1 & 2:  The sort options for this report are: 

• Route 

• Charge Code 

Service Date:  The range of route dates to include in the report.   

Route:  The range of route ID’s to include in the report. 

Charge Code:  The range of product codes to include in the report. 

Include Off-Route:  Choose this option to include off route deliveries in the 
report. 

Include Inactive Employees:  Select this option to include inactive accounts 
in the report.   

Default Equipment Service Ticket:  These 2 buttons are used to select a 
default Service Ticket.  Select the default ticket from the dropdown menu---
the standard service ticket or a custom ticket (if applicable). 
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Gratis Sales by Route 
This report indentifies products that were given away for free based on a 
defined set of ‘Gratis Reasons’.   

 

Fields: 
Primary and Secondary Sort:  The primary and secondary fields to sort by.  
You can choose from the following categories: 

• Account Number 

• Charge Code 

• Date 

Routes:  The range of routes to include in the report. 

Account Number:  The range of account numbers in include in this report. 

Product Code:  The range of product charge codes to include in the report. 

Dates:  The range of dates to include in this report. 

Available Products and Selected Products:  Select which reason are to be 
included in this report and move them to the selected products box. 

Remember Items in List:  Check this box to maintain this same list each time 
the report is accessed.   
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Customer Activity Report 
This report includes a summary of each customer’s latest activity, balances, 
and transaction dates. 

 

Fields: 
Primary and Secondary Sort:  The primary and secondary fields to sort by.  
You can choose from the following categories: 

•      Route 

•      Last Delivery Date 

• Account Number 

• Balance 

• Last Transaction Amount 

Route:  The range of routes to include in the report. 

Last Delivery Date:  The range of dates for the last deliveries. 

Account Number:  The range of account numbers in include in this report. 

Customer Type:  The range of Customer Types to include in the report. 
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Last 5 Deliveries 
This report allows you to view a product listing of each customer’s last five 
deliveries on route.   

NOTE:   This can be useful in plant production planning, route truck 
balancing, and other management needs.   

 

Fields: 
Primary and Secondary Sort:  The primary and secondary fields to sort by.  
You can choose from the following categories: 

• Account Number 

• Stop 

• Date 

• City 

• Sequence 

Account Number:  The range of account numbers to include in the report. 

Route:  The range of routes to include in the report. 

Products:  Range of products delivered. 

Route Date:  Date range to be included.   

Show Last 5 Par Values:  Select this option to include the recorded Par 
Levels per product for each delivery day.   

NOTE:   This option is only used with the Par Module.  Contact ARS for 
further information. 
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Customer Purchases Report 
This report shows all of the products purchased by customers according to the 
criteria entered.  It can be helpful in evaluating customer product 
requirements in planning for route deliveries.   

 

Fields: 
Primary and Secondary Sort:  The primary and secondary fields to sort by.  
You can choose from the following categories: 

• Route 

• Charge Code 

• Account Number 

Acct Number:  Enter the range of account numbers to include in the report. 

Next Delivery Day(s): Enter the range of delivery dates to include in the 
report.  The date range entered will determine the customers that show up on 
the report based on next delivery dates.  

History Dates:  Enter the range of history dates to include in the report. 

Route:  Enter the routes to be included in the report. 

Route Totals Only:  Select this option to view only the route totals for the 
criteria selected.  Otherwise the report will list each customer and the 
individual products purchased. 

Customer Summary Only:  Check this box to have only the Customer 
Summary displayed and not entire Customer Detail. 

Products Not Sold/Since:  Check this box to display the list of customers 
who have not received any of the products you have under the ‘included’ 
section.  Along with this, you will need to enter a date in the ‘Since’ field.  
This date will must be within the range of the History Date above.  Using this 
option will show you which customers have not received products since a 
certain date. 

Products:  A list of products that have been entered under List, Product 
Codes, Product Charge Codes.   

Available Products:  This list shows all products that can be included on the 
report. 

  Click this button to move the selected product from the list of 
Available Products to Selected Products. 

  Click this button to move all of the products in Available Products to 
Selected Products. 
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  Click this button to move the selected product from Selected Products 
to Available Products. 

  Click this button to move all of the products in Selected Products to 
Available Products. 

Selected Products:  This list shows which products you are including on the 
report. 

Remember Items In List:  Select this option to keep the products placed in 
Selected Products section next time you return to this report. 

Management 
The Management report sub-menu includes several reports that will help your 
route management team obtain important high level information.   
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Stops by ZIP Code 
This report will generate a list of all of the routed customers based on their 
ZIP codes.  This can be helpful when re-engineering routes.  The report is 
also helpful for displaying how many customers are routed in each area.  

 

Fields: 
Primary and Secondary Sort:  The primary and secondary fields to sort by.  
You can choose from the following categories: 

• by Account Number 

• by Zip Code 

• City 

ZIP Code:  The range of ZIP Codes to include in the report. 

Account Status:  The range of customers by Status code to include in the 
report. 

Only Non-Terminated Customers:  This option will only include customers 
who do not have an end date on their record. 
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Route Stop Mapping 
This report allows the user to export route data for processing in a third party 
application such as Microsoft Streets and Trips.   

 

Fields: 
Primary Sort: You can choose to sort by the following categories: 

• Sequence 

• Account Number 

• Account Name 

Date:  Enter a date range for the routes you would like to export. 

Route:  The range of routes to include in this export process.   

Combine all into one file:  Check here to combine all routes selected into one 
export file. 

Include Warehouse as first stop:  Select this option to include the Warehouse 
location as the first stop.  This is useful for route optimization.   

Don’t Load MapPoint:  Select this option to preview or print the report 
without plotting the route in the Mappoint program. 

 Directory:  Enter the path (or directory) where the file should be saved.  
The path should include the drive letter, as in the following example: 
C:\MAPPING. 

Ignore Characters in [ ]:  Choose this option to ignore characters in brackets 
[]. 
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Customer Route Listing Report 
This report generates a listing of each billing and delivery address per routed 
account number.   

 

Fields: 
Sort Options 1&2:  Choose from the following options: 

• Account Number 

• Stop 

• Date 

• City 

• Sequence 

Account Number:  The range of customer accounts to include in the report. 

Start Date:  The range of start dates to include in the report. 

Only Non-Terminated Customers:  Select this option to only include 
accounts that do not have an end date.   
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Price List Report by Customers 
Use the Price List Report by Customers to print a list of customers grouped 
by the price list they are assigned to.   

 

Fields: 
Primary and Secondary Sort:  The primary and secondary fields to sort by.  
You can choose from the following categories: 

• Price List 

• Account Number 

• Branch 

Price List:  Select the range of price lists you wish included in the report.  If 
you only want to include one price list, enter the same value in the From: and 
To: fields. 

Acct Number:  Enter the range of account numbers you want included on the 
report. 

Customer Type:  Enter the range of customer types to include in the report. 

Show only customers without a price list:  Choose this option to filter out 
customers assigned to a price list. 
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Customer Equipment List 
This report prints a list of all customers with installed equipment.   

 

Fields: 
Primary and Secondary Sort:  The primary and secondary fields to sort by.  
You can choose to sort by: 

• Equipment ID 

• Equipment Type 

• Account Number 

• Install Date 

Equip. ID:  The range of serial numbers to include in the report. 

Acct Number:  The range of accounts to include in the report. 

Install Date:  The date range of equipment installation. 

Routes:  The route range to include in the report. 

Include Picked Up Equipment:  Indicate whether to include your customer’s 
equipment that has been picked up.   
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Route Times 
Use this report to manage your routes more effectively.  It allows you to look 
at a single route or several routes to see the times that each customer was 
serviced.  The report also shows the sequence number so you can evaluate the 
route efficiency.  Large gaps of time between stops may need to be 
investigated.   

 

Fields: 
Sort Option 1:  This option is defaulted for you.  This report can only be 
printed by route. 

Route Date:  The range of dates to include in the report. 

Route:  The range of routes to include in the report. 

Output to map file:  You may choose to print this report to paper or output it 
to a file that can be imported into a mapping program such as Microsoft 
Streets & Trips.  If you choose this option, it will prompt you for the next two 
fields.  These are only required if you are using an output file.  See Appendix 
D for more assistance. 

Combine all into one file:  If you are requesting more than one route, you can 
choose this option.  This will combine stops for more than one route/day 
combination into a single file.  If you do not check the box, the system will 
create a unique file for each route/day item.   

Include Warehouse as first stop:  Choose this option to include the 
warehouse location established in File > Company Setup as the starting point 
of the route. 

Pushpin:  Used with Microsoft Mappoint. 

Directory:  Enter the path (or directory) where the file should be saved.  
The path should include the drive letter, as in the following example: 
C:\MAPPING. 

Summary Only:  This will do the report in Summary format and leave out 
details. 

Include Signature:  not currently being used. 

Allow unposted transactions:  Click this box to display unposted transaction 
information. 
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Customers without Deliveries 
This report prints a listing of customers that are without delivery or scheduled 
customers that have not received their deliveries for the period of time 
entered.   

 

Fields: 
Primary and Secondary Sort:  The primary and secondary fields to sort by.  
You can choose from the following options: 

• Account Number 

• Stop 

• Sequence 

Acct Number:  The range of accounts to include in the report. 

Route:  The range of routes to include in the report. 

Include Off-Route Customers:  To include off-route customers in this report, 
check this box. 

Ignore Special Deliveries:  Do not include special deliveries on this report.   

Unscheduled Customers:  Click this box to search for unscheduled 
customers. 

Scheduled Customers W / O Deliveries:  Check this box to search for 
scheduled accounts that have not received a delivery.   

Route Date:  The date range (by route) to include in the report. 
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Will Call Report 
The Will Call Report is used to generate a report of all customers that are 
marked as ‘Will Call’ within Customer Information, per route.  

 

Fields: 
Primary and Secondary Sort:  The primary and secondary fields to sort by.  
You can choose from the following options: 

• Account Number 

• Route 

• Date 

Route:  Select the range of routes that you wish to include on this report. 
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Skip Reasons by Route 
The Skip Reasons by Route report generates a list of customers who have had 
a skipped delivery, according to the specified criteria. 

 

Fields: 
Primary and Secondary Sort:  The primary and secondary fields to sort by.  
You can choose from the following options: 

• Route 

• Date 

Routes:  Select the range of routes that you wish to include on this report. 

Dates:  Input the range of dates to include on the report. 

Skip Reasons:  A list of available skip reasons to view on the report. 

NOTE:   The product charge code for the skip reason will not appear in the 
Skip Reasons field until it has been used during the current billing period. 

Selected Reasons:  A list of reasons that have been selected to appear on the 
report. 

  Click this button to move the selected reason from Skip Reasons to 
Selected Skip Reasons. 

  Click this button to move all reasons in Skip Reasons to Selected Skip 
Reasons. 

  Click this button to move the selected field from Selected Skip 
Reasons to Skip Reasons. 

  Click this button to move all reasons in Selected Skip Reasons to Skip 
Reasons. 
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Missing Invoice Numbers by Route 
In some countries it is important to maintain a finite list of all invoice 
numbers and the customers that have used them.  To facilitate this process, a 
report can be generated of all route tickets issued to a route salesperson that 
were not returned at the end of the day. 

 

Fields: 
Sort Option 1:  This option is defaulted for you.  This report can only be 
printed by route. 

Route: Enter a range of routes to include in the report. 

Promise Date: Enter a range of delivery day(s) dates to include in the report. 

Include all Customers on Route:  Choose this option to include all customers 
on route. 
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Missing Delivery Tickets 
This report is helpful to facilitate the process of tracking delivery ticket 
numbers.  The report will display the Delivery Order ticket numbers that were 
processed but not entered into the system. 

 

Fields: 
Sort Option 1 & 2:  The sort options for the report. 

• Route 

• Date 

Route:  enter a range of routes to include in the report.  

Promised Date:  Enter the range of dates to include on the report. 

Include all Customers on Route:  Choose this option to include all customers 
on each route selected.  



 

108 •••• Reports – Chapter 2B Route Manager Advanced User Guide B 

 

Route Summary 
This report summarizes average products sold and equipment information 
based on Routes, Day Labels, and Products Sold. 

 

Fields: 
Primary and Secondary Sort:  The primary and secondary fields to sort by.  
You can choose from the following categories: 

• Day Label 

• Customer Account + Stop 

• Sequence  

• City 

• Zip Code 

• Via Code  

• Frequency Code 

• No. of Equipment 

Day Label Mask:  The number of characters to mask. 

Day Label:  Select the range of day labels to include in the report. 

Route:  Select the range of routes to be included on the report. 

Product Class / Charge Code:  Choose the product charge code(s) or class(s) 
to include in the report. 

Equip. Type:  Select the types of equipment to include in the report. 
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Minimum Purchase Offenders   
Use this report to identify customers with meager purchases.  This will let 
you evaluate the cost effectiveness of the offending customers.   

 

Fields: 
Sort Option 1 & 2:  The primary and secondary fields to sort by.  You can 
choose from the following categories: 

• Account No. 

• Charge Code 

Account No.:  Enter a range of customers to include in the report. 

Start Date:  Enter a range of customer start dates to include in the report. 

Route:  Enter a range of routes to include in the report. 

Charge Code:  Enter a range of product codes to include in the report. 

Quantity:  Enter the range based on the option selected below: 

• Units:  Select this radio button to view the report based on the 
quantity of items purchased. 

• Dollar Amount:  Select this radio button to view the report 
based on the dollar amount of items purchased. 

Customer Type:  Enter the range of customer types to include on the report. 

Product Class:  Enter the range of product classes to include on the report. 

Only Non-terminated customers:  Choose this option to display only non-
terminated accounts. 
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Route Sequence Report 
This report will allow the user to view accounts by route, sequence number, 
and day label.  The report can be reviewed periodically to ensure that 
customers are routed on the proper day labels. 

  

Fields: 
Sort Option 1 & 2:  The primary and secondary fields to sort by; you can 
choose from the following categories: 

• By Sequence 

• By Day Label 

• By Acct. No 

Route:  Enter a range of routes to include in the report. 

Available Day Labels:  A listing of all of the day labels in the program.  

Selected Day Labels:  A listing of the day labels added to the report. 

Use the arrows or double-click on individual day labels to include them on 
the report. 

Exclude Will Call Customers:  Select this option to exclude Will Call 
accounts from being included on the report. 
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Cust/Equip by Day Label 
This report will list customer container and equipment quantities per stop.  
The report is sorted by route and day label automatically. 

 

Fields: 
Route:  Enter a range of routes to include in the report. 

Day Label:  The range of Day Labels to be included on the report. 

Route Planning Report 
This report will list customer container and equipment quantities per stop.  
The report is sorted by route and day label automatically.   

 

Fields: 
Sort Option 1:  Sorting is only by Route. 

Account Number:  Enter the range of account numbers to include on the 
report.   

Route:  Enter a range of routes to include in the report. 

Date:  Enter the date for the start planning report. 

Period:  Enter the number of days to include in the planning report. 
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Suspended/Hold Service Accounts 
Report 
The Suspended/Hold Service Accounts Report includes all customers that are 
either suspended or placed on Hold Service status, depending on the option 
selected within the report. 

 

Fields: 
Sort Option 1, 2, 3:  You can choose from the following categories: 

• Date 

• Account Number 

• Account Name 

• Customer Type 

• Major Acct. Code 

• Zip Code 

• Tax Code 

Account Number:  The range of account numbers to include in the report. 

Start Date:  Enter the range of customer Start Dates to include in the report. 

Customer Type:  The range of customer types to include in the report. 

Sales Rep:  The range of Sales Reps to include in the report. 

Credit Class:  Enter the range of customer Credit Classes to include in the 
report. 

Account Status:  Enter the range of Account Status Codes to include in the 
report. 

Major Account Code:  The major account number range to include in the 
report.   

Suspended Date:  Enter the date range to include in the report for Suspended 
customers. 

Only non-terminated customers:  Select this option to suppress terminated 
customers from the report. 
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Suspended Accounts:  Select this option to run the report for suspended 
customers. 

Hold Service Accounts:  Select this option to run the report for Hold Service 
customers. 

 

 

Reprint (Route Reports) 
The reprint submenu includes options for reprinting handheld and Afternoon 
Reports. 

 

Reprint Product Sold Report 
This Reprint is used to reproduce the driver’s Product Sold report obtained 
during the upload and check-in process.   

 

Fields: 
Primary Sort:  This option is defaulted for you.  This report can only be 
printed by charge codes. 

Route:  The range of routes to include in the report. 

Invoice Date:  The invoice date for this report.   

Include Summary Totals:  Check this box to have the report include a 
summary report with recap of the total sales. 
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Reprint Perpetual Inventory Report  
This report will print perpetual inventory totals that are reported from the 
uploaded route day.  The original report can be printed automatically as an 
Afternoon report.   

 

Fields: 
Primary Sort:  The primary is defaulted for you; it can only be sorted by 
charge code. 

Route:  Enter the route to be included in the report. 

Route Date:  Enter the date of the route. 

Reprint Vehicle Inspection 
This report will reprint Vehicle Inspection reports completed on the handheld. 

 

Fields: 
Sort Option 1:  The primary sort is by Route only.   

Rte Date:  Enter a range of delivery day(s) dates to include in the report. 

Route:  Enter a range of routes to include in the report. 

Truck ID:  Enter a range of truck Ids to include in the report. 
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Uploaded Load Requests 
This report will reprint load requests for each route and date selected. 

 

Fields: 
Sort Option 1:  The primary sort is by Route only.   

Route:  Enter a range of routes to include in the report. 

Date:  Enter a range of route dates to include in the report. 

Reprint Archived Upload Reports 
This option allows you to reprint archived Afternoon Report data for each 
route uploaded.  Simply click on each Route/Date that you would like to 
reprint and choose ‘OK’.  

NOTE:   Before the Afternoon Reports can be reprinted, the option must be 
enabled by going to Lists > Routes > Handheld Class > Upload Reports, and 
selecting the ‘Create PDF Archive of Upload Reports’ option. 

 

Fields: 
Route and Date:  Displays each Route/Date that can be reprinted.  

Print:  Displays an ‘*’ next to each Route/Date that will be printed. 
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Other (Route Reports) 
The Other submenu includes miscellaneous route related reports.   

 

Customer Delivery Calendar 
Print out delivery schedule calendars for your customers.  These reminders 
can prevent wasted trips on forgotten delivery days.   

 

Fields: 
Primary and Secondary Sort:  The primary and secondary fields to sort by.  
You can choose from the following categories: 

• Route 

• Account Number 

• ZIP Code 

• Sequence 

Account Number:  Enter the range of accounts to include. 

Type:  Enter the range of account types to be included on the report.   

Route:  Enter the range of routes to be included on the report. 

Route Date:  Enter the route dates you wish to include in the report. 

Year:  Select the current year to print the Customer Delivery calendar.  All 
calendars are printed for one calendar year. 
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Print Style:  Choose one calendar format.  You can choose between: 

• Mailable Postcard 

• Standard Postcard 

• Full Page 

NOTE:  Mailable Postcards use Avery 5389 or 8389 laser postcards.   

NOTE:   Email addresses listed on the Info tab (Lists > Customer 
Information) are used when emailing delivery schedules. 

Non Completed Delivery Orders without 
Delivery 
This report will display all OPEN Delivery Orders that have not been 
scheduled on route.  This report automatically displays when accessed. 
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Product Serial Detail Report 
This report displays sold products and their assigned serial numbers.  This is 
helpful for companies that use handheld scanners for inventory movement.   

 

Fields: 
Sort Option 1, & 2:  The fields to sort by can choose from the following 
categories: 

• Account Number 

• Route  

• Zip Code 

• Serial 

• Date 

Account No.:  Enter a range of customers to include in the report. 

All:  Check this box if a full range of data is requested. 

Include Signee Name:  Select this option to include the signee name entered 
during the transaction listed. 

Zip Code:  The range of ZIP Codes to include in the report. 

Serial:  The range of serial numbers to include in the report.  All pieces of 
equipment are included if no range is specified. 

Dates: Enter a range of delivery day(s) dates to include in the report. 

Route:  Enter a range of routes to include in the report. 

Extra:  Enter the ‘Extra’ field range to include in the report (assigned to the 
item on the Handheld tab within the Product Charge Codes screen). 

View Serial Numbers Loaded on Truck:  Select this option to generate a 
report that will only list items that are currently assigned to a delivery vehicle. 
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Route Miles Summary  
The Route Miles Summary report provides you with detailed mileage 
information entered by each driver on the handheld.   

NOTE:   Mileage requirements can be configured for the handheld under Lists 
> Routes > Handheld Class, on the Load/Unload tab. 

 

Fields: 
Sort Option 1 & 2:  The primary and secondary fields to sort by.  You can 
choose from the following categories: 

• Route 

• Group 

Trip Date:  Enter the delivery date range to include in the report. 

Route:  Enter a range of routes to include in the report. 

Truck Number:  Enter a range of truck ID’s to include in the report. 

Driver Name:  Enter a range of drivers to include in the report. 

Not Pre-Posted (Pending):  Select this option to view pending route 
information. 

NOTE:   The following options only apply to multiple branch companies that 
use the Pre-Post Transactions option in RMA. 

Pre-Posted:  Select this option to view pre-posted route information. 

Both:  Select this option to view both pending and pre-posted route 
information. 
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Multiple Route Skips Report 
The Multiple Route Skips Report includes customers that have been skipped 
multiple times, consecutively.  This is helpful to determine if a customer 
needs to be contacted, requires a route change, etc.  

 

Fields: 
Sort Option 1 & 2:  The primary and secondary fields to sort by.  You can 
choose from the following categories: 

• Account Number 

• Date 

Skips (From and To):  Enter the minimum and maximum number of skipped 
deliveries to include in the report. 

Account Number:  Enter the account number range to include in the report. 

Route:  Enter the route range to include in the report. 

Inactive Since:  Enter the date range to include for customers that have been 
marked inactive. 

Last Delivery Since: Specify a date to list recent deliveries.   

 



 

Route Manager Advanced User Guide B Chapter 2B – Reports 121 

 

Equipment Reports 
This section focuses on reports related to equipment.   

 
These reports are described in more detail within the following section. 
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Equipment Master List 
Select this report to generate a list of all equipment in the system.   

 

Fields: 
Primary and Secondary Sort:  The primary and secondary fields to sort by.  
You can choose to sort by: 

• Equipment ID 

• Equipment Type 

• Acct Number 

• Install Date 

Equip. ID:  The range of equipment serial numbers to include in the report, 
from the first to last equipment ID (up to 16 characters each). 

Install Date:  The date range of equipment installation. 

Equip. Type:  The range of equipment types to include in the report.   

Equipment Manufacturer:  The range of Equipment Manufacturers to be 
included on the report. 

Account Number:  The range of accounts to include in the report. 

First Installed Date:  With multiple installations and transfers, this date can 
be helpful in getting a full and useful report. 

Equipment Style:  The range of equipment styles to include in the report. 

Destroyed Equipment:  Select one of the radio buttons to obtain a report with 
the proper listing of destroyed equipment.   

• Exclude Destroyed Equipment 

• Include Destroyed Equipment 

• Destroyed Equipment Only   

Short Listing:  Select this box to print the report in a single line per unit 
format. 

Include Uninstalled:  Select this box to include all uninstalled equipment on 
the report. 
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Equipment Type List 
A list of all entered equipment types can be printed using this report option.  
Choose your output destination to print the list. 

 

Equipment Style List 
A list of all entered equipment styles can be printed using this report option.  
Choose your output destination to print the list. 

 

Service Codes List 
A list of all entered service codes can be printed using this report option.  
Choose your output destination to print the list. 

 

Equipment Faults List 
A list of all entered equipment faults can be printed using this report option.  
Choose your output destination to print the list. 
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Equipment Manufactures List 
A list of all entered equipment manufacturers can be printed using this report 
option.  Choose your output destination to print the list. 

 

Equipment Service Ticket 
You can print service tickets for drivers that will be servicing equipment.  
Each ticket includes the type of equipment, location, billing information, past 
service history, and the employee taking the call.  These tickets are taken with 
the driver or service person to perform the required service on the customer’s 
equipment.   

 

Fields: 
Primary and Secondary Sort:  The primary and secondary fields to sort by.  
You can choose from the following categories: 

• Date 

• Equipment ID 

• Employee ID 

• ZIP Code 

Request Date:  This is the range of dates to include in the report.  It is usually 
from a past date benchmark to the present date. 

Equipment ID:  The range of equipment ID to include on the report. 

Employee ID:  The range of employees to include in the report, from the first 
to the last employee ID number. 

Equipment Types:  The range of equipment types to include on the report. 

Customer Types:  The range of customer types to include on the report. 

Zip Code:  The range of Zip Codes to include on the report. 
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Archived Tickets:  Check this option to reprint archived equipment service 
tickets.   

NOTE:   Equipment Service Tickets are archived when the ‘Service Call 
Complete’ option has been selected on the Service Follow-up tab within 
Transactions > Equipment Processing > Equipment Service Call and at least 
one transaction posting has occurred since. 

Include Inactive Employees:  This option will include customer service 
orders created by employees who are now marked as Inactive. 

Default Equipment Service Ticket:  Choose between the standard service 
ticket or a custom ticket (if applicable). 

Equipment Service Orders 
The Equipment Service Orders Report is used to track equipment and when it 
will require serving by your organization.   

 

Fields: 
Sort Option 1 & 2:  The primary and secondary fields to sort by.  You can 
choose to sort by: 

• Account Number 

• Date 

• Equipment ID 

• Zip Code 

• Customer Type 

Request Date:  Specify the range of dates to be listed on this report. 

Equipment ID:  Select the range of equipment ID numbers that you want to 
include on this report. 

Equipment Types:  The range of equipment types to include in the report. 

Customer Types:  The range of customer types to include in the report. 

Zip Code:  The range of zip codes to include in the report. 
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Format: 
• Preview Report Format 

• Generate Unscheduled Service Orders 

• Assign to Route 

• Assign to Default Route 

• Auto Schedule For 

Service Schedules:  There are several options that you can choose to select a 
similar report with different options: 

• Equipment with Service Schedule 

• Equipment in place without Service Schedule  

• Both 

Totals Only:  Select this option to include only the totals in the report. 

Missing Service Tickets  
This report will find any Service Tickets that have been printed but not 
entered into the system.   

 

Fields: 
Sort Option 1 & 2:  The primary and secondary fields to sort by.  You can 
choose from the following categories: 

• Ticket number 

• Account number 

• Date 

Promised Date:  Select the range of dates to include in this report. 

Include All Customers on Route:   Choose this option to include all 
customers scheduled on the promised day entered. 
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Equipment by Location  
This report allows the user to view equipment by the location it currently 
resides.  This is useful in locating misplaced equipment as well as knowing 
what equipment you have available to rent.  You may choose any or all of the 
default locations.   

 

Fields: 
Primary and Secondary Sort:  The primary and secondary fields to sort by.  
You can choose from the following categories: 

• Account Number 

• Equipment ID 

• Equipment Type 

• Group Area Code 

• Purchase Date 

• Installed Date 

Equipment ID:  The range of equipment ID numbers to include in the report.  
You may select a single unit or a range. 

Group Area:  The range of group area codes to be included on the report. 

Installed Date:  The ‘Installed’ date range to include on the report. 

ZIP Code:  The range of ZIP Codes to include on the report.  This will allow 
you to choose a smaller area than the entire database. 

Equipment Style:  The range of Equipment Styles to include in the report. 

Type:  The range of equipment types to include in the report. 

Period Code:  The range of Period Codes to include in the report.  This will 
let you only include equipment that is rented on a quarterly basis, for 
example. 

Location(s):  This option allows you to select a range of locations.  For 
example, to know what equipment is stored at the warehouse, check the 
Warehouse box and the report will print out the equipment at that location.  
Choose any or all of the boxes shown. 

Destroyed Equipment:  Choose one of the following options. 

• Exclude Destroyed Equipment 

• Include Destroyed Equipment 

• Destroyed Equipment Only 
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Include New Equipment:  Choose this option to include equipment Sold as 
New. 

Include Used Equipment:  Choose this option to include equipment Sold as 
Used. 

Identify Sold Equipment:  Choose this option to identify all equipment 
marked as Sold in general. 

Summary Only:  Check this box if you wish to only have a summary of the 
report printed. 

Equipment Movement Report 
The Equipment Movement Report displays where equipment locations and the 
employee that placed it there.  

 

Fields: 
Primary Sort:  The primary sort option defaults to location. 

Secondary Sort:  You can choose from the following categories: 

• Type 

• Equipment ID 

• Account Number 

• Branch 

Equipment ID:  Input the range of equipment ID numbers to include on the 
report. 

Installed Date:  Enter the range of dates to include on the report. 

Type:  The range of equipment types to include in the report. 

Location(s):  These checkboxes allow you to select the location(s) where the 
equipment is located and have it listed on the report.   

Exclude Sold Equipment:  Check this box to complete the exclusion.   
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Equipment Sold 
This report provides a list of units sold.  It is useful for property tax 
assessments, sales tax reporting, and asset tracking.   

 

Fields: 
Primary and Secondary Sort:  The primary and secondary fields to sort by.  
You can choose from the following categories: 

• Serial Number 

• Customer 

• Date 

Equip. Serial Number:  The range of serial numbers to include in the report.  
All pieces of equipment are included if no range is specified. 

Date Sold:  The range of dates to include in the report.  This can be compared 
with the date sold in the equipment master file. 

Account Number:  The range of accounts to include in the report. 
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Equipment Warranty Report 
As you service your equipment, you may optionally select that it was repaired 
under warranty.  This report can be printed by manufacturer for all warranty 
repairs.   

 
 

Primary and Secondary Sort:  The primary and secondary fields to sort by.  
You can choose from the following categories: 

• Equipment ID 

• Type 

• Repair Date 

Equipment ID:  The range of serial numbers to include in the report.   

Install Date:  Select the range of installation dates to include on the report. 

Equipment Type:  Select the range of equipment types to include on the 
report.   

Account Number:  Enter the range of account numbers to include on the 
report.   

Short Listing:  Select this option to generate a summarized report.   

Include uninstalled:  Check here to include uninstalled equipment on the 
report.   
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Equipment Warranty Expiration Report 
This report provides equipment warranty expiration and repair information. 

 
Primary and Secondary Sort:  The primary and secondary fields to sort by.  
You can choose from the following categories: 

• Equipment ID 

• Type 

• Repair Date 

Equipment ID:  The range of serial numbers to include in the report.   

Repair Date:  Select the range of repair dates of equipment to include on the 
report. 

Equipment Type:  Select the range of equipment types to include on the 
report.   

Manufacturer:  Select the range of equipment manufacturers to include on 
the report.   

Warranty Expiration Date:  Select the range of warranty expiration dates to 
include on the report.   

Ignore Repairs:  Check here to omit repairs on the equipment on this report. 
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Customers without Equipment 
This report will print a listing of all customers who do not have equipment 
listed on their account.  You may print it by a range of starting dates 

 

Fields: 
Primary and Secondary Sort:  The primary and secondary fields to sort by.  
You can choose from the following categories: 

• Account Number 

• Date 

• Account Name 

Acct Number:  The range of account numbers to include in the report. 

Start Date:  The range of customer start dates to include in the report.  

Only Non-Terminated Customers:  This option will only include customers 
who do not have an end date on their customer record.   
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Equipment Status Reports 
The Equipment Status Report includes information related to Equipment 
Status Codes assigned to each piece of equipment. 

 

Fields: 
Sort Option 1:  This report is automatically sorted by Equipment Status Code. 

Report Type:  Select the type of report output from the following choices: 

•    Consumption 

•    By Customer 

•    By Status 

•    Status Summary 

Acct Number:  Enter the range of account numbers to include in the report, 
along with one of the following account choices:   

•   Active 

•    Inactive 

•    Both 

Show Stop Details:  Select this option to include multiple account stop detail 
on the report. 

Last Status Change:  The date range for the equipment status changes to be 
included on the report.    

Customer Type:  Enter the range of Customer Types to include in the report. 

Area:  Enter the route areas to be included in the report. 

Zip Code:   Enter the range of ZIP Codes to include in the report.   

Invoice Date:  Enter the range of invoice dates to include in this report. 

Charge Code:  Enter the range of charge codes to be included on this report.   

Minimum Quantity:  Enter the minimum quantity per charge code that must 
be met to include the item on the report. 

Available Status Codes:  This list displays all Equipment Status Codes that 
can be included on the report. 
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  Click this button to move the selected status codes from the list of 
Available Status Codes to Selected Status Codes. 

  Click this button to move all of the status codes in Available Status 
Codes to Selected Status Codes. 

  Click this button to move the selected Status Codes from Selected 
Status Codes to Available Status Codes. 

  Click this button to move all of the Status Codes in Selected Status 
Codes to Available Status Codes. 

Selected Status Codes:  This list shows which Equipment Status Codes will 
be included in the report. 

Inventory 
Listed below are several reports that relate to Inventory.   

 
These reports are described in more detail within the following section. 
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Inventory Status  
This report helps the user manage inventory more effectively.  At any time, a 
list of products can be printed in order to determine inventory on hand. 

 

Fields: 
Primary Sort:  This report can only be printed by charge code and product 
class. 

Available Warehouses / Selected Warehouse:  Choose the warehouse(s) to 
include in the report by using the arrow options on the screen. 

Available Products / Selected Products:  Choose the product(s) to include in 
the report by choosing the arrow options on the screen. 

Remember Items in List:  Select this option to keep the products placed in 
Selected Products section next time you return to this report. 
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Inventory Valuation Report  
This report will calculate profit margins based on price vs. cost for a given 
date range. 

 

Fields:   
Charge Code:  The product code range to include in the report. 

Receive Date:  The receive dates included in the report. 

Product Class:  Enter the product classes that should be included in the 
report. 

Show Detail:  Select this check box to show inventory value details. 

Available Warehouses / Selected Warehouses:  Choose the warehouse(s) to 
include in the report by using the arrow options. 
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Inventory Stock Take Report 
This report is designed for taking a physical stock count in the warehouse.   

 

Fields: 
Available Warehouses / Selected Warehouse:  Choose the warehouse(s) to 
include in the report by using the arrow options on the screen. 

Available Products / Selected Products:  Choose the product(s) to include in 
the report by choosing the arrow options on the screen. 

Remember Items in List:  Select this option to keep the products placed in 
Selected Products section next time you return to this report. 

As of:  Enter the desired date. 

Show Units Less Than:  Insert a minimum number of items in inventory to 
be displayed on the report.   
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Inventory Order Status Report 
The Inventory Order Status Report includes all unposted Inventory 
Adjustment orders being processed in RMA. 

 

Fields: 
Primary and Secondary Sort:  The primary and secondary fields to sort by.  
You can choose from the following categories: 

• By Expected Date 

• By Product Batch Code 

• By From Warehouse 

• By Via Warehouse 

• By To Warehouse 

• By Charge Code 

Product Batch Code:  Specify the range of Product Batch Codes to include in 
the report. 

Expected Date:  Specify the range of expected dates to include in the report.   

Available Warehouses / Selected Warehouses:  Choose the warehouse(s) to 
include in the report. 
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Inventory Stock Transfer Report 
This option allows the ability to make a paper transfer of stock from one 
warehouse to another and report the changes.  This can be a record of 
physical transfer or it can be used as an order to make the physical changes 
shown.  Local rules should prevail on this procedure. 

 

Fields: 
Sort Options 1-3:  The report can be sorted in the following ways: 

• Branch 

• Warehouse 

• Charge Code 

• None (no sort needed)  

Date:  Enter the date range to include in the report. 

Chrg. Code:  Enter the charge code range to include in the report. 

Reason Code:  Enter the inventory reason report to include in the report. 

Include Products With No Activity:  Choose this option to include products 
with no activity. 

Available Warehouses / Selected Warehouses:  Choose the warehouse(s) to 
include in the report. 
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Pallet Status Report  
The Pallet Status Report provides you with detailed product information per 
pallet entered in RMA. 

NOTE:   This option works with the Pallet Reference Code option located at 
the top of the Warehouse Setup screen.  Refer to User Guide A for further 
information on this option. 

 

Fields: 
Sort Options 1-3:  The report can be sorted in the following ways: 

• Branch 

• Warehouse 

• Charge Code 

• Employee  

Date:  Enter the date range to include in the report. 

Employee Initials:  Enter the employee initials range to include on the report. 

Pallet Status:  Select one of the following options: 

• Both:  Select this option to include Active and Broken-Down pallets 
in the report. 

• Active:  Select this option to only view pallets that have not been 
broken-down in the report. 

• Broken:  Select this option to only view pallets that have been 
broken-down within the Inventory Adjustments screen. 

NOTE:   Pallets can be automatically broken-down when transferring 
inventory to an alternate warehouse.  Refer to the Warehouse Setup 
option in User Guide A for further information. 

Available Warehouses / Selected Warehouses:  Choose the warehouse(s) to 
include in the report. 
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Warehouse Inventory Report 
The Warehouse Inventory Report allows you to view inventory totals by 
warehouse location in RMA. 

 

Fields: 
Sort Options 1-3:  The report can be sorted in the following ways: 

• Branch 

• Warehouse 

• Charge Code 

• None 

Charge Code:  Enter the charge code range to include on the report. 

Available Warehouses / Selected Warehouses:  Choose the warehouse(s) to 
include in the report. 
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Running Inventory Report 
The Running Inventory Report will provide you with on hand inventory totals 
that include adjustments for inventory assigned to pending invoices, Supply 
Chain Orders, and warehouse locations.  

 

Fields: 
Sort Options 1-3:  The report can be sorted in the following ways: 

• Branch 

• Warehouse 

• Charge Code 

• none 

Charge Code:  Enter the charge code range to include on the report. 

Available Warehouses / Selected Warehouses:  Choose the warehouse(s) to 
include in the report. 

 



 

Route Manager Advanced User Guide B Chapter 2B – Reports 143 

 

Par Valuation Report 
The Par Valuation Report includes par values and total cost per customer. 

 

Fields: 
Sort Options 1-2:  The report can be sorted in the following ways: 

• Account No. 

• Charge Code 

• Last Updated 

Account No.:  Enter the range of account numbers to enter on this report. 

Charge Code:  Enter the charge code range to include on the report. 

Last Updated:  Enter the range of par activity dates to include on this report. 
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EDI Reports 
This option is part of the EDI module and requires custom programming from 
ARS.  Two reports are available. 

 

Print EDI Daily Sales Report 
This report is used with EDI processing, contact Advantage Route Systems 
for further information. 

 

Fields: 
Acct Number:  The range of accounts to include in the report, up to six 
characters each.  If you choose the same account number for the first and last 
number in the range, it will allow you to choose any format for your 
statement style.  It will not look at the code on the customer record when 
doing so. 

Dates:  The range of dates to include in the report. 
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Average Daily Sales 
This report is used with the EDI function in RMA; contact Advantage Route 
Systems for further information. 

 

Fields: 
Acct Number:  The range of accounts to include in the report, up to six 
characters each.  If you choose the same account number for the first and last 
number in the range, it will allow you to choose any format for your 
statement style.  It will not look at the code on the customer record when 
doing so. 

EDI Code:  The range of EDI Codes to include in the report. 
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Statements 
The statements function allows you to print statements according to specific 
parameters. 

 

Standard Statements 
This option is used for printing statements based on preconfigured 
information under Lists > Customer Setup Codes > Statement Codes.   

 

Fields: 
Sort Options 1:  Sort options for this report are: 

• Zip Code 

• City 

• Acct No. 

Acct Number:  The range of accounts to include in the report, up to six 
characters each.  If you choose the same account number for the first and last 
number in the range, it will allow you to choose any format for your 
statement style.  It will not look at the code on the customer record when 
doing so. 

ZIP Code:  The range of ZIP Codes to include in the report. 

Major Acct:  Use this option to filter customers based on Major Account 
Codes. 

Statement Type:  The type of statement to include in the report.   

Close Date:  The date of the last transaction included on the statement.   

Use Credit Terms:  Select this option to calculate the statement due date 
based on the customer’s assigned Credit Terms code. 

Due Date:  The number of days the system should add to the Close Date as 
the Due Date for payment.  This will print on the statement. 
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Include:  Choose the columns to include on your report.  However, you can 
narrow the list by selecting: Current, 30, 60, 90, or 120 or more days overdue. 

NOTE:   Not all of the following options are available with every statement 
type.  They will only be visible if they correspond to the statement type 
selected. 

Include Payment Voucher:  Select this option to print a payment voucher at 
the bottom of a normal 8½" x 11" statement. 

Include Invoices:  Select this option to have invoices included with the 
statements. 

NOTE:   By selecting Include Invoices, you will not have the ability to export 
your statements. 

Rental Invoices Only:  Select this box to only print the rental invoices with 
the statement. 

Pre-Printed Form:  Select here to print only the data, and not the heading on 
a pre-printed form. 

Open Item Statement:  Selecting this option will only print statements that 
still have balances. 

Suppress Aging:  Selecting this option will prevent the customer’s aging 
from printing on the statement. 

Include Stop Information:  Select this option if you wish to have the 
customers stop information printed on the statement. 

Include Bottle Counts:  Check this option to include the customer’s bottle 
counts on the statement. 

Exclude Postal Bar Code:  Selecting this option will remove the bar code 
from the statement. 

Detail side first:  Use this option to print the detail side of a postcard before 
the address side.  This is used for two-sided postcards. 

8 ½ X 11 Invoice Format:  Select this option if you wish the invoices to be 
printed in 8 ½ X 11 format. 

Include No Charge Items:  Select this option if you wish to have No Charge 
items included in the statements. 

Don’t Include Invoice Details:  Select this option if you do not wish to have 
the invoice details printed on the statements. 

Show Mini Signatures on Statement:  Select this option to include invoice 
signatures within the statement detail section. 
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Numbered Statements  
In some countries, it is necessary to print a statement that has a number on it 
that can be tracked by local government authorities.  This program will allow 
you to generate statements with these numbers on them.   

NOTE:   To use this feature, select the option ‘Use Statement Numbers’ 
within File > Branch Setup, on the Statement tab.   

 

Fields: 
Sort Option 1:  Select whether to sort by City, ZIP Code or Account Number. 

Acct Number:  The range of account numbers to include in the report, up to 
six characters each. 

ZIP Code:  The range of ZIP Codes to include in the report. 

Major Acct:  Use this option to filter customers based on Major Account 
Codes. 

Statement Type:  The type of statement to include in the report.  Select the ID 
from the drop-down list and the corresponding description will automatically 
appear to the right of it.  (Statement codes are setup in Statement Codes, 
under Lists, Customer Setup Codes.)  For example, if your statement type is 
bulk statement, then the statements are printed to a file and only a summary 
sheet is printed on your printer. 

Billing Cycle:  Choose this option if billing cycles are being used with the 
current statement.  The cycles are setup under Lists> Customer Setup Codes> 
Statement Types and may not be displayed. 

Close Date:  The Close Date is the date of the last transaction included on the 
statement.  The Due Date is the day the payment is due at your office.  This 
will print on the statement. 

Starting Statement No:  This field is automatically populated with the 
starting Statement Number that will be used when printing numbered 
statements (can be overwritten, if necessary). 

NOTE:   The Statement Number pool can be configured under Lists > Branch 
Setup, on the Statement tab. 
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Include:  Choose the columns to include on your report.  However, you can 
narrow the list by selecting: Current, 30, 60, 90, or 120 or more days overdue. 

NOTE:   Not all of the following options are available with every statement 
type.  They will only be visible if they correspond to the statement type 
selected. 

Include Payment Voucher:  Select this option to print a payment voucher at 
the bottom of a normal 8½" x 11" statement. 

Include Invoices:  Select this option to have invoices included with the 
statements. 

NOTE:   By selecting Include Invoices, you will not have the ability to export 
your statements. 

Rental Invoices Only:  Select this box to only print the rental invoices with 
the statement. 

Pre-Printed Form:  Select here to print only the data, and not the heading on 
a pre-printed form. 

Open Item Statement:  Selecting this option will only print statements that 
still have balances. 

Day Aging:  Select the number of days you want included in the “Only Open 
Items” statement. 

Suppress Aging:  Selecting this option will prevent the customer’s aging 
from printing on the statement. 

Include Stop Information:  Select this option if you wish to have the 
customers stop information printed on the statement. 

Include Bottle Counts:  Check this option to include the customer’s bottle 
counts on the statement. 

Exclude Postal Bar Code:  Selecting this option will remove the bar code 
from the statement. 

Detail side first:  Use this option to print the detail side of a postcard before 
the address side.  This is used for two-sided postcards. 

8 ½ X 11 Invoice Format:  Select this option if you wish the invoices to be 
printed in 8 ½ X 11 format. 

Include No Charge Items:  Select this option if you wish to have No Charge 
items included in the statements. 

Don’t Include Invoice Details:  Select this option if you do not wish to have 
the invoice details printed on the statements.   

Show Mini Signatures on Statement:  Select this option to include invoice 
signatures within the statement detail section. 
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Statement Number List  
To support numbered statements, you may want to print out a list of the 
statements printed each month.   

NOTE:   To use this feature, select the option ‘Use Statement Numbers’ 
within File > Branch Setup, on the Statement tab.   

 

Fields: 
Primary and Secondary Sort:  The primary and secondary fields to sort by.  
You can choose from the following categories: 

• Account Number 

• Date 

• Statement Number 

Acct Number:  Enter the range of account numbers to include on the report. 

Date:  Input the date range that this report is to include. 

Statement Number:  Enter the range of statement numbers that you want to 
appear on the report. 

Include Invoice Detail:  This will include invoice detail on the report. 
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Dunning Notices 
There are always a few customers who either forget about or neglect their 
payments.  This feature will print out a reminder notice for these customers.   

NOTE:   There are some steps that need to be taken prior to printing here, 
refer to Dunning Letters and Credit Class within the Supplemental Guide. 

 
Fields: 
Sort option1 and 2:  Select this option to sort by ZIP Code, city, or account 
number. 

Account Number:  The range of accounts to include in the report. 

Due Date:  The due date that is printed on the dunning notices. 

Available and Selected Credit Classes:  Select the one-character credit class 
from the available credit classes.  Selected credit classes appear to the right. 

Export Data:  Allows files to be exported for third party processing.  Contact 
ARS for further information. 
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Pre-Sale E-Mail   
This option allows the ability to send e-mail to all customers assigned to an e-
mail contact code.  A template can be established with this option. 

 

Fields: 
Customer:  Enter the desired customer account range. 

Route:  Enter the desired route ID range. 

Via Code:  Enter the desired Contact Via Code range. 

Customer Type:  Enter the desired customer type range. 

Date:  Enter the next delivery date of the customers to be contacted. 

Template:  Select the template to use when sending e-mail to customers, the 
user should be familiar with Outlook File Templates (.OFT files). 
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List Reports 
List reports are generally simple lists that correspond to the screens shown on 
the lists tab.  Below is a listing of the reports in this submenu. 

 
These reports relate directly to the Lists menu and can also be printed from 
within their respective areas by clicking on the image of the printer on the 
toolbar. 

Customer List 
There are three reports that are currently available within the Customer List 
sub-menu.    
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Customer List 
The Customer List report can give a complete list of customer accounts in the 
system.  At times it may be helpful to view the information for a single 
customer or a range of customers at a glance.   

 

Fields: 
Primary and Secondary Sort:  The primary and secondary fields to sort by.  
Sort by the following categories: 

• Date (Customer Started Service)  

• Account Number 

• Account Name 

• Customer Type 

• Major Account Code 

• Zip  Code 

• Tax Code 

Account Number:  The range of account numbers to include in the report. 

Start Date:  The range of start service dates to include in the report. 

Customer Type:  The range of Customer Types to include on this report. 

Sales Rep:  The range of Sales Reps to include in the report. 

Credit Class:  Select the range of Credit Classes to include on the report. 

Acct Status:  Choose the range of Account Status Codes to use on the report. 

Major Acct:  The range of Major Account Codes to include on the report. 

Statement Code:  The range of Statement Codes to include on the report. 

Only Non-Terminated Customers:  This option will only include customers 
who do not have an end date on their record. 

Include Category Summary:  This will provide a count of customers by 
category, whether it is types, credit status or other “breaks” in the data. 

Short Listing:  Check this box if you would like the consolidated, one-
customer-per-line format.  It will leave out some of the detail but is handy if 
you simply want a customer list. 
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Print Only Summary:  Selecting this option will generate a short report that 
summarizes the data.   

Use Delivery Address:  Select this option to include the customer’s delivery 
address on the report (requires Short Listing option). 

Filter By: 
Select the desired Sales Rep field (1, 2, or 3) to use for report sorting. 

Bank Details 
The Bank Details report contains all of the information entered under the 
Bank Info option on the Credit tab within Customer Information.  

 

Fields: 
Sort Option 1:  Defaulted by Account Number.   

Account Number:  Range of account numbers included on the report. 

Start Date:  The range of start service dates to include in the report. 

Credit Class:  Select the range of credit classes to include on the report. 

Customer Type:  The range of customer types to include on this report. 
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Credit Card Details 
The Credit Card Details report contains all of the information entered under 
the Credit Card option on the Credit tab within Customer Information.  

 

Fields: 
Sort Option 1:  Sorting is only by Account Number.   

Account Number:  Range of account numbers included on the report. 

Start Date:  The range of start service dates to include in the report. 

Credit Class:  Select the range of credit classes to include on the report. 

Customer Type:  The range of customer types to include on this report. 
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Customer Setup Lists 
The following reports contain the data that deals with customer setup. 

 

Customer Status Code List 
Print out a list of all of the Customer Status Codes. 

 

Fields: 
Primary and Secondary Sort:  The primary and secondary fields to sort by.  
You can sort by the following categories: 

• Status Code 

• Status Description 

Customer Status:  Select the range of customer status codes to include on this 
report. 
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Start/Stop Reason Groups 
This report will list all of the Start/Stop groups entered into RMA. 

 

Start/Stop Reason List 
The Start/Stop Reason List report will list the settings for the selected range 
of Start/Stop Reasons filtered by the Start/Stop Group assigned. 

 

Fields: 
Primary and Secondary Sort:  The primary and secondary fields to sort by.  
Sort by the following categories: 

• Group 

• Reason Type 

• Reason Code 

Group:  The range of groups to include on this report. 

Reason Type:  The range of reason types to include on this report. 

Reason Code:  The range of reason codes to include on this report. 

Late Charge Codes List   
A list of all late charge codes can be printed using this report. 
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Customer Type Codes List 
Choose this report to print a listing of all of the customer types in the 
program. 

 

Fields: 
Sort Option 1:  The primary fields to sort by.  You can sort by the following 
categories: 

• ID 

• Description 

Customer Type Codes:  Select the range of customer type codes to include on 
this report. 

Credit Class List 
A report of all credit class codes can be printed using this report option.   

 

Statement Codes List 
A list of all statement codes can be printed using this report option.   
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Contact Reasons List 
The Contact Reasons List report will generate a list of contact reasons 
selected.   

 

Fields: 
Primary and Secondary Sort: The primary and secondary fields to sort by.  
You can sort by the following categories: 

• ID 

• Description 

Contact Reasons:  Select the range of contact reasons to include on this 
report. 

Suspend Service Codes List 
The Suspend Service Codes List generates a list of the selected suspend 
service codes.  

 

Fields: 
Primary Sort:  The primary fields to sort by.  You can sort by the following 
categories: 

• ID 

• Description 

Suspend Service Codes:  Select the range of suspend service codes to include 
on this report. 
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Service Priority Report 
A list of all Service Priority codes can be printed using this report option.   

 

Contact Via Codes 
A list of all Contact Via Codes can be printed using this report option.   

 

Contact Frequency Codes 
A list of all Frequency Codes can be printed using this report option.   

 

Major Account Code 
A list of all Major Codes can be printed using this report option.   

 

Promotion Codes 
A list of all Promotion Codes can be printed using this report option.   
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ZIP Codes List 
A list of all ZIP Codes in your system can be printed using this report option.   

 

Fields: 
Primary and Secondary Sort:  The primary and secondary fields to sort by.  
You can choose from the following categories: 

• ZIP Code 

• City 

• Date 

Last Updated:  The range of dates when the ZIP Codes were last updated. 

ZIP Code:  The range of ZIP Codes to include in the report. 

Short Listing:  Checking this box will print the Zip Codes in a three-column 
format. 

Group Area Codes List 
The Group Area Codes List report allows you to print out a list of all the 
group area codes that have been entered into the system. 

 



 

Route Manager Advanced User Guide B Chapter 2B – Reports 163 

 

Delivery Order Reasons List 
The Delivery Orders Reasons List report will generate a list of the selected 
range of delivery order reasons.   

 

Fields: 
Primary Sort: The primary fields to sort by.  You can sort by the following 
categories: 

• ID 

• Description 

Delivery Order Reasons:  Select the range of telephone reasons to include on 
this report. 

Branch Codes List 
The Branch Codes List report generates a list of the selected range of branch 
codes.   

 

Fields: 
Primary Sort:  The primary fields to sort by.  You can sort by the following 
categories: 

• ID 

• Description 

Branches:  Select the range of branches to include on this report. 
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Product Codes List 
The following reports contain information related to your product setup.   

 

Product Charge Codes List 
The Product Charge Codes report gives you a listing of the product codes 
that you have entered into the system.  You may limit the report to a charge 
code range or a general ledger account number range. 

 

Fields: 
Primary and Secondary Sort:  The primary and secondary fields to sort by.  
You can choose from the following categories: 

• Charge Code 

• Date 

• Description 

• Truck Order 

• Product Class 

Charge Code:  The range of charge codes to include in the report. 

G/L number:  The range of G/L number codes, for products sold, to include 
in the report.  Specify from first to last (lowest to highest). 

Show G/L Account Numbers:  This will cause all general ledger account 
numbers on the report. 

List all Price Levels:  Check this box to include all price levels in the report.  
This will take more space to print. 

Exclude Inactive Products:  Check this box to exclude products not actively 
marketed at the present time. 
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Product Class List 
The Product Class report will allow you to print a listing of all the product 
classes that you have entered into the system. 

 

Product Price List 
The Product Price List report prints out a list of product price levels that have 
been entered into the system.   

 

Fields: 
Primary Sort:  This option is defaulted for you.  This report can only be 
printed by price list. 

Price List:  Select the range of price lists that you wish to include on the 
report. 
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Product Price List by Customer 
The Product Price List by Customer report prints out a list of product price 
levels and the customers assigned to them.   

 

Fields: 
Primary Sort:  This option is defaulted for you.  This report can only be 
printed by price list. 

Price List:  Select the range of price lists that you wish to include on the 
report. 

Inventory Adjustment Codes 
The Inventory Adjustment Codes report will generate a list of inventory codes 
for the selected range. 

 

Fields: 
Primary and Secondary Sort:  The primary and secondary fields to sort by.  
You can sort by the following categories: 

• Inventory Code 

• Inventory Reasons 

Inventory Reasons:  Select the range of inventory adjustment codes to 
include on this report. 
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Gratis Reasons List 
The Gratis Reason List report will generate a list of gratis reasons codes. 

 

Fields: 
Primary Sort:  The primary fields to sort by.  You can sort by the following 
categories: 

• ID 

• Description 

Gratis Reasons:  Select the range of gratis reasons to include on this report. 

 

Rent Credit Codes List 
The Rent Credit Codes List report will generate a complete list of credit 
codes. 
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Quarantine Status Codes List 
This report will list all of the Quarantine Status codes available within the 
program. 

 

Fields: 
Sort Options 1 & 2:  Choose from the following sort options: 

• Quarantine Codes 

• Quarantine Description 

Quarantine Codes:  Enter the range of quarantine codes to include on the 
report. 
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Account Setup List 
These reports create lists of items dealing with the accounting functions in 
RMA. 

 

Sales Tax Rates List 
The Sales Tax Rates List report will print a list of all the sales tax rates that 
you have entered into the program. 

 

General Ledger Listing 
The General Ledger Listing report will print a list of all the General Ledger 
accounts that have been entered into the program. 
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General Ledger Account Usage 
This report allows you to print a listing of all general ledger numbers entered 
in the RMA system. 

 

Fields: 
Primary Sort:  This option is defaulted for you.  This report can only be 
printed by general ledger number order. 

General Ledger Account Number:  The range of G/L numbers to include in 
the report. 

Write Off Reasons 
A list of all Write-off Reasons can be printed using this report option.   

 

Credit Note Reasons 
A list of all Credit Note Reasons can be printed using this report option.   
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Truck List Report 
A list of all entered trucks can be printed using this report option.   

 

Truck Class List 
The Truck Class List report creates a list of the Truck Classes created in the 
system.  

 

Handheld Class List 
This report will display all of the settings within the Handheld Class setup 
screens. 

 

Fields: 
Sort option 1 & 2:  Choose to sort by Class or Handheld Description 

Handheld Class:  The range of handheld classes to display on the report. 
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Route List 
This report allows you to print a listing of all routes in the RMA system.  This 
report is useful to see all customers assigned in each of the branches. 

 

Fields: 
Primary and Secondary Sort:  You can select from the following fields for 
the primary and secondary sort: 

• Branch 

• Route 

• Employee ID 

Employee:  Select a range of employees to restrict the output, if desired. 

Route:  Select a range of routes to restrict the output, if desired. 
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Employee Setup List 
The following reports display the settings used to set up employees. 

 

Employee List 
This report will provide a list of employees and their settings entered into the 
program. 

 

Fields: 
Primary and Secondary Sort:  The primary and secondary fields to sort by.  
You can sort from the following categories: 

• Employee ID 

• Hire Date 

• Social Security Number 

• Name 

• Sequence:   

• Security Level:   

Date Hired:  The range of hire dates to include in the report.  You may 
choose only new employees if you wish. 

ID Number:  The range of employee ID numbers to include. 

S.S.N.:  The range of Social Security numbers to include in the report. 

Type:  A range of employee types to include on the report. 

Security Level:  Include a range of security levels to include on the report. 

Include Inactive Employees:  Select this option to include those employees 
with Release Dates. 
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Security Level Codes List 
The Security Level Codes List report prints a list of the security levels within 
the system. 

NOTE:   Only employees designated as “Master User” can access this report. 

 

Fields: 
Security Level:  The security level range to include on the report. 

Summary List Only:  Check this box to obtain an abbreviated list of security 
levels. 

Commission Class List 
The Commission Class List report allows you to print a list of all the 
commission class codes that you have entered into the system. 

 

Branch Report 
The Branch Report allows you to print a list of all branches entered into the 
program. 
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Graphs 
Use this utility to view graphs of two different data items: 

• Aging Analysis 

• Sales History YTD 

Simply choose the desired graph and style and click on the OK key. 

 

Fields: 
Graph Data:  Select the data that is to be viewed as graph. 

Graph Type:  Select the type of graph to create.  Choose from these options: 

• Line 

• Vertical Bar 

• 3D Vertical Bar 

• Horizontal Bar 

• 3D Horizontal Bar 

• Pie 

• 3D Pie 

Select OK to preview the graph. 
 

Custom Reports Menu 
RMA supports a variety of custom reporting tools (e.g., Crystal Reports) to 
allow more flexibility for reporting purposes.  Once these reports are created, 
the Custom Reports option gives you the ability to integrate these types of 
reports into the RMA Reports menu.  This may be helpful for users that 
would benefit from having certain external reports accessible from within the 
RMA program (links to programs can be added as well). 

Refer to Chapter 4.05 of the Supplemental Guide for further information. 
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Chapter 3B  – Route 

Overview 
The Route pad is primarily used for items related to handheld processing.   
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 Daily Handheld Processing 
There are many options available when transferring data to and from the 
handheld units each day.  These options are discussed within the section 
below. 

Advanced Communications 
This optional module allows you to transfer route data wirelessly through 
the handheld units.  Contact Advantage Route Systems for further 
information.    

 

RMLive 
This optional module allows you to transmit and receive real-time route 
data, throughout each delivery day.  Contact Advantage Route Systems 
for further information.   
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Pick Processing 
The Pick Processing feature allows you to create Load Orders that can 
be printed and distributed to your warehouse employees for order 
‘picking’.  This option is helpful for companies that have a high volume 
of orders daily.  

NOTE:   Refer to Chapter 4.13 of the Supplemental Guide for further 
information on Pick Processing.  

 
The six menu items are described in the pages below.   

Ad-hoc Stock Levels 
The Ad-hoc Stock Levels option is used to establish products that should 
be pulled automatically each delivery day. 

 

Fields: 
Route:  Select a route from the drop-down menu.   

 Add:  Choose this button and select an item to establish as a standing 
order.  Enter the required quantity for each day of the week.  
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Generate Pick Tickets 
The Generate Pick Tickets option is the central hub for all items that need 
to be pulled from inventory for a given route and date.   

 

Fields: 
Pick Route:  Specify the route for the pick ticket. 

Pick Date:  Specify the date for the pick ticket.  

Generate Standing Order Telesales:  Select this option to generate and 
add any Weekly Standing Orders to the pick ticket. 

NOTE:   Refer to Chapter 4.12 of the Supplemental Guide for further 
information on Weekly Standing Orders. 

Generate Standing Orders:  Select this option to include any Standing 
Orders on the pick ticket.   

NOTE:   Standing Orders are items assigned to each customer within 
Customer Information, on the Products tab. 

Print Pick Tickets:  Select this option to review and print the pick ticket. 

 Calculated Pick Quantities:  Select this option to review product 
totals with a higher level of detail within the Generate Pick Tickets 
screen. 

NOTE:   This option can be enabled under File > Branch Setup > 
Defaults.   
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Column Headings: 

NOTE:   The headings displayed on the screen will vary based on ticket 
type. 

Product:  The product code assigned to the listed product. 

Description:  The description of the product listed. 

Ad-Hoc Stock:  The total product quantity required from the Ad-hoc 
Stock Levels screen. 

Telesales Orders:  The total quantities entered on Delivery Orders 
generated for the current route and date. 

Standing Orders:  The total quantity generated from the customer’s 
Default Products. 

Standing Orders Telesales:  The total quantity generated from the 
customer’s Weekly Standing Orders. 

NOTE:   Refer to Chapter 4.12 of the Supplemental Guide for further 
information on the Weekly Standing Orders feature. 

Driver Requests:  The total quantity generated from the Load Request 
feature on the handheld. 

Adjust:  The total quantity entered manually on the ticket. 

Total Pick Quantity:  The total quantity for the item on the ticket. 

Confirmed Pick:  The total quantity that was picked on the ticket. 

Issued Pick Quantity:  The total quantity that should be picked on the 
ticket.  
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Confirm Pick 
The Confirm Pick option allows you to enter product totals entered on 
each pick ticket.    

 

Fields: 
Pick Route:  Specify the route to edit. 

 

Pick Date:  Specify the date to edit.   

Confirm Selected Cycles:  Select this option to complete the order.  

Column Headings: 

NOTE:   The headings displayed on the screen will vary based on ticket 
type. 

Product:  The product code assigned to the listed product. 

Description:  The description of the product listed. 

Cycle 1:  The quantity assigned to the current cycle (multi-cycles are 
available in Calculated Mode).   

Other: 
Add:  Select a product to add to the Pick Confirmation.   
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Generate Load Orders 
The Generate Load Orders option allows you to create Load Orders that 
will be received by drivers on the handhelds.   

 

Fields: 
Pick Route:  Specify the route to generate the Load Order for.  

Pick Date:  Specify the date to generate the Load Order for.   

Generate Load:  Select this option to generate the Load Order.   

Column Headings:  
Cycle:  Displays the cycle number. 

Pick ID:  Displays the assigned pick ticket code. 

Issued:  Displays the number of items assigned to the ticket. 

Confirmed:  Displays the number of items verified on the ticket. 

Process Closed:  Displays the status of the ticket if it has been closed (T 
or F). 

Pick Confirmed:  Displays the status of the pick confirmation for 
processing (T or F). 

Load Complete:  Displays the status of the load if it has been processed 
(T or F). 
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Print Delivery Manifest 
Use this report to print a Delivery Manifest that can be attached to the 
processed order. 

 

Fields: 
Sort Option:  The report will automatically be sorted by route. 

Route:  Enter the range of routes to include in the report.   

Date:  Specify the date to include in the report.   

Maintain Calculator 
This option is currently in development. 
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Load Order  
The Load Order Entry option allows you to create a “Pick List” that can 
be printed or sent to the driver’s handheld for processing.   

NOTE:   Refer to Chapter 3.10 of the Supplemental Guide for further 
information on processing Load Orders. 

 

Fields:   
Truck:  Select the truck from the drop-down list. 

Route:  Select the appropriate route from the drop-down list. 

Date:  Select the date for this load entry. 

Order Number:  Displays the assigned load order code. 

Driver Name:  Displays the driver assigned to the current route. 

Employee:  Displays the initials of the employee making the entry. 

Origin Warehouse:  Select the origin of the items to be processed. 

Destination Warehouse:  Select the warehouse that will receive the 
items (generally this is the driver’s delivery vehicle). 
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Morning Cards 
This option will transfer route data to a card by using either a Storage 
Card Reader or the USB Cradle (third party software needed) that came 
with the handheld unit.   

NOTE:   For further information on Handheld Processing, refer to the 
Handheld Manual available for download at www.ARS247.com.  

 

Fields:   
Standard tab:  The standard transfer method used. 

• Route:  All of your company’s routes. 

• Initials:  The initials of the drivers responsible for deliveries on 
the specified routes. 

• Employee Name:  The name corresponding to the driver initials. 

• Status:  Designates the status of the route.  It will indicate 
whether they are “out” on route or “in” from route. 

• Process:  Indicates if the route will be processed. 

Process Route For:  The date to process the route. 

Card Drive:  The drive letter assigned to the card slot in use on the card 
reader. 

Send Update:  Choose this option when a new version of the handheld 
program should be sent to the handheld. 

All Routes:  When selected, this option will create the data for all the 
routes on a selected day and sort them so they can later be loaded onto 
handheld data cards.  This option works directly with the Load Data 
Card process.   

Don’t Copy Route to Card:  Select this option to have RMA copy the 
route information to the PC to be used for batch morning card 
processing.   

Multi tab:   The multi tab displays 4 field headings: 

• Route:  Your company’s routes. 

• Description:  Route description.   

• Driver 
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• Date 

Send Update:  Choose this option when a new version of the handheld 
program should be sent to the handheld. 

Order Manually:  Select this option to enable the ability to double-click 
on the Route and Date field headings (for sorting purposes on the 
handheld). 

Don’t Copy Route to Card:  Select this option to have RMA copy the 
route information to the PC to be used for batch morning card 
processing. 

Afternoon 
When the driver returns at the end of the day, transfer the invoice data 
(along with other changes, such as equipment status) from the storage 
card back to the desktop system.   

To do this using a storage card reader, simply insert the card into the 
reader on the desktop computer and select Afternoon.   

 
The system will automatically identify your card.  Make sure this is the 
correct card.  Simply follow the instructions on the screen to upload the 
data.   

RMA will automatically proceed to generate reports as determined on the 
Upload Reports tab, under Lists, Routes, Handheld Class. 

When everything is complete, the program will prompt with an upload 
successful message.  The card is now ready for fresh data for the next 
day’s route. 
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Load Data Card 
The data created by checking the All Routes option on the Morning Card 
screen is displayed here and waiting to be processed to the cards. 

 

Fields: 
• Route:  The route for which data is available. 

• Initials:  The initials of the driver who is assigned to this route. 

• Employee Name:  The name of the driver assigned to this route. 

• Date:  The date of the prepared data for this route. 

Card Drive:  The drive letter assigned to the card slot in use on the card 
reader. 

To copy the data to a card: choose the correct Card Drive, select one 
employee name, and then click ‘OK’.   
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Pre-Route Reports 
Before your route drivers begin their routes each day, it is a good idea to 
print a copy of the stops to be visited.  This is helpful for several reasons: 

• It will let you call any past due account to ensure that the 
customer has a payment ready upon delivery. 

• If the handheld should break or get lost, the route information is 
still available. 

• It shows the entire route at a glance for possible improvements 
in the way the route is run. 

The following screen shows your Pre-Route Report options.  

 

Fields: 
Primary Sort:  The primary field to sort by.  Choose from the following 
categories: 

• Sequence 

• Account Number 

• Account Name 

Date:  The date you would like to print the Pre-Route report.  This will 
pick up all stops for the date selected as well as the rent for the date 
shown and other date-specific items. 

Route:  The range of routes to include in this report.  A separate report 
will be printed for each route. 

All Day Labels:  Choose this option if you would like to see all of the 
customers assigned to the specified route, regardless of date of delivery. 

Include Blanks (available with “All Day Labels” option):  Choose this 
option to include customers assigned to the currently selected route(s) but 
are not assigned to a day label. 

Only Active Day Labels (available with “All Day Labels” option):  
Select this option to filter out older day label entries — based on the 
From Date entered.   

Blank Lines:  The number of blank lines to print out between each 
customer.  Add extra lines to leave the route driver room to write in 
notes. 
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Include Messages (Alert, One Time, Driver Instructions, Site 
Instructions, Delivery Order Message, Open Hours, Contact Message):  
Select the message you would like to appear on the report.  In the Last 
field, specify the number of Contact Messages to make available for 
review. 

Bill of Lading/Delivery Manifest:  Select this option to include Pick 
Processing information with the Pre-Route Report. 

NOTE:   Refer to Chapter 4.13 of the Supplemental Guide for further 
information on Pick Processing. 

Short Listing:  Check this box if you would like the consolidated, one-
stop-per-line format.  It will leave out some of the detail but is handy if 
you simply want a route list. 

Include Load Sheet:  Check this box to include a load sheet with your 
pre-route report.  If you choose to include the load sheet, the Number of 
Copies field will become enabled.  This will allow you to directly input 
how many copies of the load sheets you want to print with each pre-route 
report. 

Show Grouped Product Breakdown:  Check this box to show product by 
group as previously set up. 

Include Equipment Serial No. and Type:  Check this box if you want to 
include an equipments serial number and an equipment type in the report. 

Sequence Special Stops:  Selecting this option will cause special stops to 
be placed by their sequence number, not at the top of the route list for the 
day. 

Sequence Drags:  Selecting this option will place drag stops based on the 
customer’s default sequence number. 

Show Phone Number:  Select this option for phone numbers to appear 
on the report.   

Show 2nd Address Line:  Selecting this option will cause a second 
address to be printed on the report for the day. 

Include Route Sheet:  This check box will include a route sheet before 
the actual report comes up.   

Show All Products:  Choose this option to include all products assigned 
in the default product section.  Check the Detailed box if details are 
needed.   

Daily Delivery Schedule – Wide A4:  Choose this option to print a 
delivery schedule with the report. 

Include Equipment Orders With Each Stop:  Choose this option to 
include pending equipment orders on the report.   

Use Product Details with Tank Size:  This is part of a custom 
enhancement.  Contact ARS for further information. 

Delivery Time Filter:  Select the preferred delivery time filter to apply to 
the report.  

NOTE:   Customers can be assigned and sorted by delivery time within 
their account under Lists > Customer Information > Route > Handheld 
Options, in the Deliv. Time field.  Additionally, each account can be 
sorted by time on the handheld by selecting the ‘Allow Route List 
Filtering by Delivery Time’ option under Lists > Customer Information > 
Routes > Handheld Class, on the Screen tab.    
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Driver’s Manifest 
The Driver’s Manifest includes a shipper’s certificate that can be used 
and signed during the delivery day by the driver. 

 

Fields: 
Primary Sort:  The primary field to sort by.  Choose from the following 
categories: 

• Sequence 

• Account Number 

• Account Name 

Date:  Enter the range of stop dates to include on the manifest.  

Route:  Enter the range of routes to include on the report. 
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Route Planning Calendar   
The Route Planning Calendar provides you with a monthly calendar that 
includes each route stop per day for the route selected. 

 

Fields: 
Period:  Select the monthly period to be used on the route planning 
calendar.   

Route:  Select the route to include on the calendar.   

Output Format:  The following are the options available when printing 
the calendar:  7 Day format of Sunday through Saturday or 5 Day Format 
of Monday through Friday. 
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Print Route Tickets 
This program allows you to create blank or pre-printed tickets on plain 
paper.  If you have a custom form for tickets, other types of printers may 
be used.  

 

Fields: 
Process Tickets For/To:  Enter the range of route dates for tickets to be 
printed. 

Route:  The range of routes for tickets to be printed.   

Copies:  Select the number of copies of each ticket to print. 

Blanks: 
The following are the options available when printing blank route tickets: 

• None:  Select this option to prevent printing any blanks along 
with your route tickets. 

• Default:  The default number of blanks to be printed with your 
route tickets. 

• Custom:  Selecting Custom enables you to input the number 
of blank forms to print for each route. 

• Blanks Only:  To print only blank forms. 

Customer:  To print only one route ticket for a specific customer, enter 
the account number here. 

Ticket Number:  Enter a ticket number to reprint a specific ticket.  

Date to use on Tickets:  Enter the date that you want to appear on the 
tickets.   

Tickets Per Page:  Specify the number of tickets to print per page (up to 
4). 

Include Quantity on Tickets:  Check the box to have a customer’s 
default quantity for each product to print on the route tickets.  Otherwise 
it will leave a blank space on the ticket so you can hand write in the 
quantity. 

Only Print Required Tickets:  When this box is checked, the system will 
only generate an invoice for customers who have the “invoice copies to 
print” with a value greater than zero.  If you do not check this box, a 
ticket will be generated for every customer who matches the date and 
route criteria previously entered.  
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Default Route Ticket:  Select this option to print route tickets using a 
standard note format that will be returned to the office by the driver. 

Ticket with Company Info:  Select this option to print tickets using a 
standard receipt format that may be left with the customer. 

Custom Ticket:  Select this option to use a custom route ticket designed 
for your company.  

Print Load Sheet 
Load Sheets contain the minimum product requirements your driver 
should have on a specific route based on the average quantities of 
products sold for the previous 5-deliveries, per customer.   

NOTE:   For further information on processing Load Orders, refer to 
Chapter 3.10 of the Supplemental Guide. 

 

Fields: 
Primary and Secondary Sort:  Choose to sort by Charge Code or 
Product Class. 

Route:  The range of routes to include in your printed load sheets. 

Date:  The date to be used for printing the load sheets. 

Number of copies:  Select the number of copies of each load order to 
print out. 

Generate Report Without Route Page Breaks:  Choose this option to 
combine totals of each route on summary page. 

Include Equipment Detail:  Choose this option to include equipment 
detail from Delivery Orders on the report. 

Only Totals from Delivery Orders:  Choose this option to only show 
totals based on Delivery Orders scheduled for the day. 

Show grouped Product breakdown:  Choose this option to group 
products based on product class.   
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Route Pre-Sale 
This option allows you to pre-call customers prior to their delivery day.   

NOTE:   The route and date parameters screen appears first.  It allows 
you to select the route, delivery date, and product information.   

 

Fields: 
Route:  The Route field allows you to select the range of routes that you 
would like to load on your Pre-Sale screen. 

Customer Type:  The Customer Type field allows you to select the range 
of account types you would like to load on your Pre-Sale screen. 

NOTE:   Select the ‘All’ field to load all of the Routes and Customer 
Types, if desired. 

Date:  Enter the range of pre-calling dates you would like to load on your 
Pre-Sale screen.   

Ignore:  Choosing this option will ignore all delivery dates and load all 
of the customers assigned to the selected Route and Customer Type 
fields. 
Contact Via Code:  Choose from the options below.  

• E-Mail 

• Fax 

• None 

• Telephone 

NOTE:   If you do not select any Contact Via options, all of the 
customers will be displayed. 

Scheduled Only:  Click this option to only load customers assigned to 
the selected Contact Via Code that are scheduled for delivery.  

Use Calling Schedule:  Select this option to load customers set up for 
Advanced Pre-Calling. 
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Caller Type (Optional):  Select the employee type that you would like to 
use for filtering data in the pre-sale list.  Your options are: 

• Route Caller:  This employee field is available within the PreCalling section of 
the Route tab. 

• Sales Rep 1-3:  The Sales Rep fields are located on the Info tab of Customer 
Information. 

Employee (Optional):  Select the employee you would like to load pre-
calling data for.  Customers assigned to other employees will not be 
loaded unless you select the ‘All Employees’ option. 

Do you want to clear product quantities?  Select this box to change all 
quantities to ‘0’ when loading Default Products on the Pre-Sale screen. 

Product Classes / Product Codes:  Select one of these options to 
determine the product filter criteria that will be used on the screen.   

Products / Classes:  Depending on the option above, add the Product 
Classes or Product Codes that you would like to include on the pre-sale 
screen by using the arrows on the screen (or choose ‘All’ box). 

Route Pre-Sale 
After entering the desired criteria and clicking the ‘OK’ button, the Pre-
Sale screen will appear.  The Pre-Sale list includes all of the route stops 
that should be contacted. 

 

Fields: 
Seq. No:  The customer’s route sequence number. 

Customer Name:  The customer’s delivery name.  
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Status:  This field provides you with the following codes regarding the 
customer’s pre-call status: 

*  Completed Pre-Call 

!  Skipped Delivery 

?  Left Message 

= In progress   

 

NOTE:   Contact Via Codes are displayed in this field as well, such as 
‘E’ in the Status column above.   

To take an order or edit any information, simply click on a customer’s 
name.  As the customer is selected, their account information will appear 
in the appropriate fields on the right side of the screen.  Each item is 
defined below. 

 

Fields: 
Customer Name:  The name of the selected customer. 

Account Number:  The account number of the selected customer. 

Delivery Date:  The delivery date of the selected customer. 

Route:  The route assigned to the current customer. 

Address:  The current address of the selected customer. 

Account Bal.:  The customer’s current account balance. 

Past Due Amt.:  The customer’s past due amount owed. 

Day:  The day label assigned to the customer. 

Phone:  The primary contact phone number on the account. 

Alternate Phone:  The alternate phone number on the account. 

Contact:  The primary contact on the account. 
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Language:  The primary language assigned to the customer. 

P.O.:  Enter the P.O. number associated with the delivery, if any.  

Last Pre-Sale:  The last pre-sale completed on the account. 

Contact Via:  The primary contact method this customer prefers.  

Contact Freq.:  The frequency this customer prefers to be contacted.   

Skip Delivery:  Select this option to manually skip the customer’s 
delivery and remove the customer from the route for the delivery day. 

Left Message:  Select this option if you were not able to reach the 
customer and left a message. 

Billing Notes / Alert Message:  Enter any optional notes regarding the 
pre-call for the office (Billing) or the driver (Alert Message).   

Example Billing Note: 

 

Example Alert Message: 

 

NOTE:   You can toggle between Billing Notes / Alert Message by 
selecting either the Billing or Delivery radio button on the right side of 
the screen. 

 Route Calendar:  Select this option to view or edit the 
customer’s current delivery schedule. 

Billing / Delivery:  Select either button to toggle between Billing Notes 
or Alert Message to the left of this option.  

 Customer Information:  Select this button to view or edit the 
customer’s account. 

 Deliver Order:  Select this option to create a Delivery Order on 
the account. 

 OK:  Select this option to save any changes made.  You can then 
select another customer from the list. 

 Cancel:  Cancels your current transactions so you can select 
another customer from the list. 

 Exit:   Exits the Pre-Sale screen.  
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Card Override 
Before certain actions can be taken on a driver card, the computer checks 
to be sure previous steps were done correctly. 

For example, before a card can have a new day’s route put onto it, the 
program checks to see if the afternoon function was completed for the 
previous day.  The morning card function may give a message, 
“yesterday’s transactions have not been uploaded.”   

If you have indeed uploaded the transactions, then you will use this 
function to override the data on the card.  Do this by following the 
instructions on the screen. 

 
Insert the card and click ‘OK’.  The override is available so you can 
proceed to other functions such as uploading and downloading. 

If the override doesn’t work, you may need to remake the card.  This 
requires use of the Prepare Data Card function.  Be extremely careful 
when performing this option as it will completely erase the data on the 
card. 

WARNING!   DO NOT PERFORM THIS FUNCTION IF THERE IS 
STILL VALID DATA ON THE CARD! 

Prepare Data Card 
When you purchase a new card, it must be prepared for your data before 
you can use it on a route.   

 
CE Device Type:  Select the handheld device type from the list.   

Select Card Drive:  The drive letter assigned to the card slot in use on the 
card reader. 
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Schedule 
The Schedule menu provides tools for updating route information and 
correcting data before being it is processed to the handheld.   

 

Modify Order Due Dates 
The Modify Due Dates feature allows route supervisors to access and 
modify all open Delivery Orders.  The orders can be re-routed using this 
screen.     

NOTE:  You can sort by the different fields of the Delivery Orders by 
clicking on the field name above the list of orders. 

 

Fields: 
Route:  Select from the drop-down list the driver’s route that is 
associated with the customer. 

Use Scheduled Route:  Selecting this option will use the route that the 
order was scheduled for and not the stops normal route. 

Promised Date:  Enter the original promised date.  

All days for this route:  Select this option to bring up all customers on 
the selected route for the listed promised date. 

Filter By: 
Entered Date:  Select this option to sort the tickets by the date when the 
tickets were entered. 

Promised Date:  Select this option to sort the tickets by promised dates 
on the tickets. 

Confirmed Delivery Orders:  This option will show stops with a pending 
order.  
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Unconfirmed Delivery Orders:  This option will show stops on the route 
without any pending orders (these are for view purposes only and cannot 
be modified)  

Equipment Service Orders:  This option with show stops that have 
equipment service orders.  

NOTE:   To the right of these options, in red are the total orders for each 
type.   

Run Criteria:  Press this button to bring up a list of tickets that match the 
selected criteria, as shown below.   

 
The different types of orders are now color coded. 

GREEN:  Unconfirmed. 

BLUE:  Confirmed. 

WHITE:  Equipment Service. 

NOTE:   To modify a ticket, double-click on the appropriate customer.   

Ticket Number:  This field displays the number that is used to track the 
ticket.  This number also allows the ticket to be closed.  

Account Number:  This field displays the account number of the 
customer associated with the displayed ticket.  

Name:  This field displays the customer name associated with this ticket.   

Rte/Stop/Seq:  This field displays the route, stop, and sequence 
associated with the ticket. 

Entered Date:  This field displays the date the ticket was entered. 

Promised Date:  This field displays the promised date on the ticket. 

Type:  This field displays the type of order (confirmed, unconfirmed, 
equipment service order). 

 
Close Ticket:  Check this box to close a selected ticket.  You may also 
enter a message into the field below this checkbox. 

Add to the Message:  Check this box to add to a selected ticket, and then 
enter a message into the field below this checkbox. 

New Route:  This option allows you to change the route that the order is 
assigned to.  

New Seq:  This option allows the ability to update the sequence number 
on the order. 

Change Promised Date:  To change the existing promised date, check 
this box.  Then change the promised date in the field below the checkbox. 

Route:  Select the route that you would like to view. 
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Use Scheduled Route:  Select this option to filter out any regularly 
scheduled stops for the customer (generally preferred when managing 
Delivery Orders only). 

Promised Date:  Enter the original promised date.  

All days for this route:  Select this option to bring up all customers on 
the selected route for the listed promised date. 

Filter By: 
Entered Date:  Select this option to sort the tickets by the date the tickets 
were entered. 

Promised Date:  Select this option to sort the tickets by promised date. 

Confirmed Delivery Orders:  This option will display stops with a 
scheduled Delivery Order. 

Unconfirmed Delivery Orders:  This option will display stops on the 
route without any Delivery Orders (these are for viewing purposes only 
and cannot be modified).  

Equipment Service Orders:  This option with display stops that have 
scheduled Equipment Service Orders.  

NOTE:   For more information on Equipment Service Orders, refer to 
Chapter 3.14 of the Supplemental Guide available for download at 
www.ARS247.com.    

Run Criteria:  Press this button to bring up a list of tickets that match the 
selected criteria, as shown below.   

 
The different types of orders are now color coded: 

• GREEN:  Unconfirmed. 

• BLUE:  Confirmed. 

• WHITE:  Equipment Service  

Ticket Number:  This field displays the number that is used to track the 
Delivery Order.  This number also allows the ticket to be closed.  

Account Number:  This field displays the account number of the 
customer associated with the displayed ticket.  

Name:  This field displays the customer name associated with this ticket.   

Rte/Stop/Seq:  This field displays the route, stop, and sequence 
associated with the ticket. 

Entered Date:  This field displays the date the ticket was entered. 

Promised Date:  This field displays the Promised Date on the ticket. 

Type:  This field displays the type of order (Confirmed, Unconfirmed, or 
Equipment Service Order). 
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Modifying a Confirmed Order – Single Order 
1. Uncheck the ‘Unconfirmed’ and ‘Equipment Service Orders’ 

options on the screen to view only ‘Confirmed Orders’ 
(scheduled Delivery Orders). 

 
2. Double-click on a ‘Confirmed Order’ to activate “edit” mode. 

 
3. If you would like to complete the ticket from within this screen, 

select the option ‘Close Ticket’ and enter a note for reference. 

 
OR, 

If you would like to add a message to the order for driver 
reference and process the order, select the ‘Add to the message’ 
option. 

 
4. Enter a ‘New Route’ or select the ‘Change Promised Date’ 

option to update the scheduled delivery day. 

 
5. Click Save to complete the process. 
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Modifying a Confirmed Order – Multiple 
Orders 

1. Uncheck the ‘Unconfirmed’ and ‘Equipment Service Orders’ 
options on the screen to view only ‘Confirmed Orders’ 
(scheduled Delivery Orders). 

 
2. Single-click on each ‘Confirmed Order’ you want to update so 

that the word ‘NO’ changes to ‘YES’ in the Edit column. 

 
3. Double-click on the last customer selected to activate “edit” 

mode.   

 
4. Enter a ‘New Route’ or select the ‘Change Promised Date’ 

option and update the scheduled delivery day. 

 
5. Click Save to complete the process.  The screen will be cleared. 



 

Route Manager Advanced User Guide B Chapter 2B – Reports 205 

 

Route Resequence 
The Route Resequence option allows you to sequence all of your 
customers for a given route or route date.   

NOTE:   Click and drag the grey box to the left of the customer’s name 
to update the sequence order. 

 

Fields: 
Acct. No.:  Manually enter an account number to include on the route. 

Next Seq#:  Select a sequence number to use on a manually typed 
account number. 

Account Number:  Displays the customer’s account number. 

Stop:  Displays the customer’s route stop number.   

Name:  Displays the customer’s name.   

New Sequence:  Displays the customer’s new sequence number. 

Old Sequence:  Displays the customer’s old sequence number. 

City:  Displays the customer’s city.   

Address 1 & 2:  Displays the customer’s delivery address.   

Start Date:  Enter the date of the route to resequence. 

Route:  Select the route to resequence. 

Resequence Entire Route:  Select this option to resequence all customers 
assigned to the route selected (ignores the route date). 

NOTE:   Using the ‘Resequence Entire Route’ option requires planning; 
it is recommended that you contact ARS prior to utilizing this option. 

Save:  All information for each customer on the screen will be recorded 
in Customer Information on the Route tab. 

Exit:   This will allow you to exit without saving your changes. 

Open:  This allows you to access and rearrange data from an existing 
route.  To do this, select the Update Schedule option, and then enter the 
date the route/day is delivered.  If you want an entire route, select a route 
in the Route field.  If you want a day label, enter a day in the Day field as 
well.  Click the FILE button and the specified data will appear.   
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Preview:  This option allows you to preview and print any changes made 
prior to saving. 
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Modify Schedule 
The Modify Schedule option allows you to change groups of customers 
from one route to another, update delivery dates, add customers to a 
route, and more. 

NOTE:   While Modify Schedule makes it easy to make global route 
changes in RMA, it is recommended that you create a backup of your 
data prior to using this option. 

 

Fields: 
Acct. No.:  Key in a customer’s account number to assign them to the 
current route. 

Detail Lines: 
Account Number:  Displays the customer’s account number. 

Name:  Displays the customer’s name.   

Sequence Number:  Displays the customer’s sequence number. 

Day Label:  Displays the Day Label assigned to the account on the 
delivery date entered. 

City:  Displays the customer’s city.   

Address 1 & 2:  Displays the customer’s delivery address.   

Fields: 
Update Schedule:  Select this option to update the customer’s delivery 
schedule based on changes made to the Start Date, Route, or Day fields 
located on the bottom of the Modify Route screen. 

NOTE:   Use this option after the initial customer list has been loaded.  
Make the desired changes to Start Date, Route, or Day and select the 
Update Schedule option.  Click the Save key to complete the process.   

No Resequence:  Select this option to maintain the customer’s original 
Sequence Number prior to clicking Save. 

Change Route:  Select this box to permanently swap all of the 
customer’s listed to another route selected. 
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Clear Schedule:  Check this box to clear all customers listed from the 
route schedule.   

• Current Date Only:  Select this option to clear all customers 
from the route schedule for the current date only. 

• All:   Select this option to clear all customers from the route 
schedule for the date entered and onward.  

Special:  Select this option to manually schedule a special delivery for 
the listed accounts for the route and date entered. 

• Repeat Every ( ) days:  Select this option to automatically 
repeat each special delivery for the number of days entered. 

Start Date:  The beginning date of the route changes. 

Route:  The new route to assign to the customers. 

Day:  The new day to assign to the customers.   

Drag Unserviced Routes 
This option allows you to manually “drag” all of your stops from one day 
to the next.  This can be helpful for globally moving stops temporarily. 

 

Fields: 
From:  Enter the date that you would like to drag the stops from. 

To:  Enter the date that you would like to drag the stops to.   

NOTE:    This option will only drag scheduled stops on routes that have 
not had ANY transactions posted for the date entered.  If a transaction is 
found, no changes will be made. 



 

Route Manager Advanced User Guide B Chapter 2B – Reports 209 

 

Global Route Changes  

This option allows you to change the route and delivery day for a 
complete or partial route.  This is useful when rearranging your routes, 
especially by sections.    

 

Fields:    
Old Route:  Enter the current route for the group of customers who are 
changing routes. 

New Route:  Enter the new route designation for this group of customers. 

Entire Route:  If you are moving the entire route from the old to the new 
route, then click on this item. 

Partial Route:  If you are taking selected stops from the Old Route and 
applying it to a New Route, then select this option.   

NOTE:   The following options only apply if you have selected Partial 
Route. 

Old Day:  When moving less than a complete route from one driver to 
another, you can choose which day label to change from and to.  Select 
the day label from the originating route. 

New Day:  Choose the new day label for the selected stops. 

Sequence Number: 
From:  Indicate the first sequence number to include in the route split if 
you are doing a partial day. 

To:  Enter the ending sequence number to include in this route shift.  It 
will default to the last stop for the day indicated. 

All:  This option takes all stops for the selected route and day sequence 
and transfers them to the new route. 

From ZIP: 
Select the ZIP codes that should be included in the criteria.   

NOTE:   If you insert stops into a route and there are already sequence 
numbers for a range of stops on the same route, there may be duplicate 
stop numbers in the new route.  While this technically is not a problem, it 
could create some confusion the first time a route is run.  

Advanced Mapping   
The Advanced Mapping Module is required to use these features.  
Contact ARS for further information. 
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Utilities 
The utilities menu provides you with a variety of tools to correct data as 
it comes from the handheld.   

 
Each of these topics is described in greater detail within this section. 

Process Orders 
This option is used for importing orders from an external system and 
requires strict formatting and procedures.  Contact ARS for further 
information. 

Import Host Orders 
This option is used for importing orders from an external system and 
requires strict formatting and procedures.  Contact ARS for further 
information. 

Change Route Date 
Occasionally, dates from uploaded cards may need to be changed prior to 
posting.  Instead of changing the dates one by one, you can use this 
utility to change all dates on a given route to a new one using the screen 
below:   

 

Fields: 
Route, Route Date, Transaction Date:  The routes that may be changed 
will be listed here.  Simply highlight the route that you wish to change 
the transaction date for and click OK 

New Transaction Date:  The correct Transaction date for the highlighted 
routes. 

NOTE:   Be cautious when using this function in order to avoid changing 
dates improperly. 
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Delete Route 
This utility allows you to completely delete an unposted route from the 
desktop system and start over.  The Delete Route screen is shown below: 

 

Fields: 
Route/Date:  Select the route/date that you want to delete. 

WARNING!   It is imperative that you choose the specific route you wish 
to delete.  Once the information has been deleted, it cannot be retrieved. 
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Re-Upload Route from Archive 
This utility allows the user to re-upload previously uploaded route cards 
into the system.   

 
Simply select the route / date combination that you would like to re-load 
into your system and click the ‘OK’ button. 

Extend Route Calendars 
Use this tool to extend the delivery calendars for all or some of your 
customers.  This function only works if you have extended route 
calendars first under Branch Setup, on the Calendars tab.  

 

Fields: 
Account Number:  Select the range of accounts that you would like to 
extend the route calendar. 

All Customers:  When you select this option, the system will extend all 
route calendars for non-terminated customers. 



 

Route Manager Advanced User Guide B Chapter 2B – Reports 213 

 

 

Adjust Truck Stock Levels 
Use this option to manually adjust stock levels on trucks (perpetual 
inventory only).   

  

Fields: 
Route:  Enter the Route ID. 

Truck Bay:  Enter the bay number to adjust. 

Product Code:  Enter the Product Code to adjust. 

Quantity:  Enter the adjustment quantity. 

Route Date:  Enter the date of the route. 

NOTE:   Use Add to make new entries on the table. 
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Daily Truck Stock Levels 
Use this option to manually establish stock levels on trucks.  Use the Add 
button to establish stock levels of each product for the route for the day.   

 

Fields: 
Route:  Enter the Route ID and check the appropriate days of the week to 
be used in determining the stock levels. 

Truck Bay:  Enter the bay number to adjust. 

Product Code:  Enter the Product Code to adjust. 

Quantity:  Enter the adjustment quantity. 

Route Date:  Enter the date of the route. 

NOTE:   Use Add to make new entries on the table. 
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Screen Config   
The Screen Config screen contains setup related items options for 
optional modules available in RMA. 

RMLive Setup 
The RMLive Module is a real time data transfer system that allows your 
drivers and route salesmen to immediately transfer data to and from the 
office.   

NOTE:   Contact Advantage Route Systems for further information on 
this module. 

Setup Tab  
The Setup tab allows you to configure the fields displayed on the RMLive 
Console screen.   

 

Fields: 
Override Standard Columns:  Select this option to change the standard 
column options.   

Column Name:  Enter a new description next to each heading desired.   

Width:  Enter a new width for the column displayed on the Dispatch 
screen, if desired (note original width for reference).  

Visible:  Select this option to enable the column on the Dispatch screen.  
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RMLive Setup Options Tab 
The Options tab contains miscellaneous options available within the 
RMLive Dispatch screen.  Not on my program. 

 

Fields: 
Full Top:  Choose this option to establish the default view of the RMLive 
Console screen to ‘Dispatch-Expanded’. 

Full Bottom:  Choose this option to establish the default view of the 
RMLive Console screen to ‘Transaction-Expanded’. 

NOTE:   The expansion  option within the RMLive Console screen can 
be toggled between views, regardless of the option selected here.   

Do not send empty orders via RMLive:  Select this option to prevent 
Delivery Orders from being sent to drivers that do not contain products. 

 

Chapter  4B  – Tools 

Overview 
In addition to essential accounting functions, ARS has included some 
additional features to make your work easier and more efficient.   



 

 

 
These topics are described in more detail within this chapter. 
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EC2000 Web Update   
The Electronic Commerce 2000 Module allows you to provide important 
information to your customers on the web.  They will be able to login to 
view their balance, delivery schedule, and much more.  Contact 
Advantage Route Systems for further information. 

EF2000 
The Electronic Filing 2000 Module allows you to scan and retrieve 
documents in the system at any time.  Contact Advantage Route Systems 
for further information. 

EM2000 
This option is currently under development. 

Flash Report Setup 
This report is a powerful tool for measuring business performance.  This 
analytical tool compares projections with actual results.  This portion of 
the program lets you enter the projected or planned values for new sales, 
equipment, etc.   

Product Class Setup 
This option defines which Product Class Codes will be included on your 
Flash Report.   

NOTE:   Product Class Codes are created and maintained under Lists > 
Product Codes.  

 

Fields: 
Navigation Arrows:  Use the navigation arrows to add or remove each 
Product Class Code to the ‘Selected’ column.  



 

 

Plan Setup 
Used to establish budgets for various departments and periods.  These are 
used as baseline numbers to compare against actual performance. 

 

Fields: 
Plan Type:  You many enter projections for any of the following plans.  

• Revenue:  Gross sales in currency. 

• Volume:  Gross number of units of product sales. 

• Customer Base:  New customer starts and forecasted terminated 
accounts. 

• Equipment Base:  Accounts for new coolers placed or picked 
up.   

• Hedge:  This option will allow you to enter a value that will be 
used for offsetting price changes. 

Plan Period:  You may establish forecasted amounts for any period you 
have created in your accounting calendar.  If no dates appear here, then 
you will need to set up your information in Branch Setup. 

Product Class:  All of the product classes you have in your software are 
displayed here. 

Category Heading:  Depending on the category there will be different 
headings in this column. 

Revenue:  The total sales for the corresponding product class. 

Amount:  Enter projected amounts for each heading.  This can be units 
and/or currency (financial data). 

Back:  Move back one month. 

Next:  Move forward one month. 

OK:  Saves information entered and exits. 

Cancel:  Exits without saving information entered. 
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Equipment Leasing 
This feature allows you to set up and keep track of customers who have 
purchased coolers from you and wish to finance the purchase cost.  It 
functions as its own sub-module to set up the purchase as well as keep 
track of payments made on the purchase.  The same customer may 
finance multiple coolers and separate leasing records are kept for each 
one. 

Finally, there are a series of reports – all within this module – that 
support the tracking of the loans, balances, etc. 

 

Equipment Lease Setup 
This screen allows you to input information for each cooler that is going 
to be financed by your organization.  Each purchase must be set up 
before payments can be made.  This data ties to both the customer and 
equipment files.   

 

Fields: 
Lease ID:  The identification number for this lease agreement. 

Acct Number:  The account number of the customer leasing this 
equipment.  The tab key may be pressed in this field to bring up a list of 
your customers, which can be searched through alphabetically. 

Equipment ID:  The identification number for the piece of equipment 
this customer is leasing.  The equipment that you are going to lease 
cannot have a rent charge also.  The equipment must have a period code 
of “Z” assigned to it in order for it to be leased.  This cooler must be 



 

 

assigned to your customer in order to save the data.  Only equipment 
with a period code of “Z” will be displayed.  Equipment that is already 
assigned to lease will not display. 

Contract Amount:  The amount of money agreed to lease this piece of 
equipment.  

Down Payment:  The initial payment amount of the cooler being 
financed. 

Interest Rate:  The annual interest rate for this piece of equipment.  Enter 
as a number, not a decimal equivalent.  15% is entered as 15.00, not 0.15.  
There is an error message reminder of this if an incorrect entry is made. 

Payment Fee:  The periodic debt service fee for this piece of equipment 
if there is one.  This is added to the regular payment amount for each 
period. 

Total Contract Amount:  The total contract amount to be paid for the 
lease.  This is the contract amount plus interest and payment fee, if any, 
minus the down payment.  Each lease is usually charged interest or a 
payment fee.  However, both can be used at the time. 

Pay Frequency:  How often the customer must make payments on the 
equipment.  You can choose from the drop down list. 

Number of Payments:  The total number of payments to be made by the 
customer until it is paid in full. 

Amount of Payment:  The amount of each periodic payment that the 
customer will make.  This will be the periodic payment to amortize the 
contract amount divided by the number of payments plus the payment 
fee, if any. 

Signed By:  The person who signed the lease agreement. 

Note:  Enter any other information needed. 

Name:  The name of the customer leasing the equipment.  This appears 
automatically when the customer’s account number is entered. 

Address:  The customer’s address.  This appears automatically when the 
customer’s account number is entered. 

Contract Start Date:  The date when the contract begins. 

First Payment Date:  The date when the first payment is due. 

Contract Due Date:  The date when the final payment will be made. 

Payment Due Date:  The date when the payment is due each period. 

Last Payment Date:  The date when the last payment was actually made. 

Last Payment Amount:  The actual amount of the last payment. 

Lease Balance:  The amount of money still owed on the lease contract, 
less all payments made. 

NOTE:   The values can be modified at any time prior to posting the first 
payment. 
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Cooler Lease Payments and 
Adjustments 
Use this screen to enter payments and make adjustments to any lease in 
the system. 

 

Fields: 
Acct Number:  The customer’s six-digit account number. 

Lease ID:  The identification number for the lease agreement being paid 

Payment Amount:  The amount of the customer’s payments, up to 
999,999.99.  If you make a negative payment, the transaction will 
automatically become an adjustment and a red box will appear at the top 
of the window notifying you that the payment has become an adjustment.   

Payment Date:  The date the payment was made. 

Check Date:  The date that is printed on the check. 

Lease Balance:  The amount of money still owed on the lease contract. 

Note:  Enter any other information needed.  

Batch Number:  A number assigned to a group of payments to be used 
for sorting on the Deposit Slip Report.   

Employee:  Select the initials of the employee who entered the payment.  
This field defaults to the user that is logged onto the system. 

Name:  The customer's name automatically appears when you select the 
account number. 

Address:  The customer’s address automatically appears when you select 
the account number. 

Payment Type:  Select from the drop-down list the customer’s payment 
method: cash, check, credit card, or adjustment.  Credit card payments 
must be processed manually and are not processed in RMA. 

Check Number:  If the payment type is check or credit card, then enter 
the check number or reference number, up to ten digits. 

NOTE:   Enter any notes about this payment here.   



 

 

Post Payments 
Use this screen to post payments and adjustments entered using the 
previous screen.  This posting is independent of the normal posting 
program where you do your daily processing on the Transactions tab.  
Lease payments must be posted here in order for them to be applied to 
any account and its balance. 

 
The screen provides a listing of the date the lease payment was entered 
and the number of payments to be posted for that date.  Select the date(s) 
for Posting lease payments and click ‘OK’ to complete the posting 
operation. 



 

224 •••• Chapter 5B – Help Route Manager Advanced User Guide B 

 

Payments and Adjustments Ledger 
Use this screen to print a report of cooler leases. 

 

Fields: 
Primary and Secondary Sort:  The primary and secondary fields to sort 
by.  Choose from the following categories: 

• Account Number 

• Lease ID 

• Payment Type 

• Payment Date 

• Check Number 

Acct Number:  The customer’s account number, up to six characters. 

Lease ID:  The identification number for this lease agreement. 

Payment Date:  The date the payment was made. 

Posted Only:  Ledger printout will only display posted records. 

Unposted Only:  Ledger printout will only display unposted records. 

Both:  Ledger printout will display both posted and unposted records. 

 



 

 

Cooler Payment Schedule   
Use this screen to view payment schedules from cooler leases; as set up 
in the Cooler Lease Setup.  A copy of the payment schedule is usually 
provided to the customer at the time of signing the lease contract. 

 

Fields: 
Primary and Secondary Sort:  The primary and secondary fields to sort 
by.  Choose from the following categories: 

• Account Number 

• Lease ID 

• Equipment ID 

Acct Number:  The range of customer’s account numbers to be 
displayed. 

Lease ID:  The range of identification numbers for lease agreements to 
be displayed. 

Show Criteria:  This will show selection criteria on the header of the 
report. 
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List of Loans and Balances 
To manage the complete portfolio of outstanding loans, you can print out 
the entire list of loans.  This will show names, account numbers, 
balances, etc.   

 

Fields:  

Primary and Secondary Sort:  The primary and secondary fields to sort 
by.  Choose from the following categories: 

• Account Number 

• Lease ID 

• Equipment ID 

Acct Number:  The range of customer’s account number, up to six 
characters to include on this report. 

Lease ID:  The range of identification numbers for the lease agreements 
to include on this report. 



 

 

Equipment Lease Module Setup 
To support the functions of this module, there is a set up program to set 
up default lease information.  This is default information for all leases 
and addresses that are used strictly within this module.   

 

Send to Name/Address: 
Name:  The name of the group where the payments should be mailed. 

Address:  The address where the payment should be sent. 

Allow Payments from:  The date range in which postings can be entered 
for payments and adjustments.  The payment date must be within the date 
range specified on the screen. 

Use Period for Posting:  Checking this box will use RMA period 
calendar for payment and adjustment entry rather than the dates 
specified.   If this box is checked, the date range will not be used. 

Defaults: 
Coolers are often purchased in large quantities of the same models for the 
same price.  Leasing can be simplified by having a standard lease for all 
coolers.  The default section of the agreement contains the following 
elements for easy contract completion.  These are defaults only.   

• Contract amount 

• Down Payment 

• Interest rate 

• Payment Fee 

• Pay Frequency 

• Number of Payments 

All values can be modified when entering data in Cooler Lease Setup and 
any time prior to posting the first payment. 
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Conversation 
This option will allow the ability to send messages to other users logged 
in to RMA.  Turn this module on under Branch Setup, Desktop, Use 
Conversation (you may be required to adjust security settings and/or 
logout before the option is available). 

 
Users logged in to RMA will be displayed in the box shown, choose a 
user or select multiple names by holding down CTRL+CLICK and select 
‘OK’.  The message typed and sent will be displayed immediately on 

their screen if the option ‘Toggle Pop-up Messages’  is enabled on 
the users Module Bar. 

 

Check for New Messages 
You can prompt the system to play all new messages received since the 
last time you listened to the recorded messages.  To check for new 
messages, go to Tools and select Check for New Messages. 

 
 

Playback Customer Messages  
This option is only used with an integrated voicemail system. 

 



 

 

Global Changes 
Periodically, you may want to update information globally for large 
groups of customers in your database at once.  The Global Changes 
option allows you to do just that.  You can quickly change information in 
the following areas:     

 

Change Customer Account Numbers 
This option allows you to change a customer’s account number.   

WARNING:   This option should be used carefully as it changes all 
references to this account in the history, payments, master file, etc. 

 

Fields: 
Old Account Number:  The customer’s old account number. 

New Account Number:  The customer’s new account number. 

NOTE:   You may only change one customer account number at a time 
with this program. 
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Change Customer Names 
This option allows you to standardize the names of your customers so 
they are all uniform.  You can edit or copy both the bill to: and delivery 
name that are in a standard format.   

WARNING:   This option should be used carefully as it changes all 
names without the ability to undo any mistakes! 

 

Fields: 
Billing Name:  As you scroll through the records, the customer Billing 
name appears at the top of the screen.  

Left / Right arrows:  Flip the name so the last name comes first.   

Delivery Name:  As you scroll through the records, the customer 
Delivery name appears at the bottom of the screen. 

Up / Down Arrow:  To copy from one name to another, touch one of the 
arrows. 

Back:  Return to the previous record.   

Next:  Go to the next record.  This key is always highlighted when you 
are in the edit mode – thus allowing you to simply press [ENTER] and 
you will advance to the next record. 

Go to Account No:  If you would like to jump to an exact account 
number, enter it here. 

EXIT:  Exits this screen. 

 



 

 

Change Customer Sales Tax Codes 
This option allows you to make global changes to sales tax codes.  You 
can replace one existing code for another.   

 

Fields: 
Old Sales Tax Code:  Choose an old sales tax code that will be replaced 
with a new one.  

New Sales Tax Code:  Choose a new sales tax code that will replace the 
old one. 

Criteria:  Select the criteria in which to change the Sales Tax Codes.  
Select ranges of account numbers, customer types, and ZIP Codes. 
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Change Customer Promotion Group 
Codes  
This option allows you to change the promotion group code assigned to 
your customers (used with the Buy/Gets Module only).   

 

Fields: 
Old Promotion Group Codes:  Choose the old promotion group that will 
be replaced with a new one. 

New Promotion Group Code:  Choose the new promotion group that 
will replace the old one. 

Acct # Range:  Enter the account number range to include in the 
modification. 

Customer Type Range:  Enter the customer type range to include in the 
modification. 

ZIP Code Range: Enter the ZIP code range to include in the 
modification. 

Credit Class:  Enter the credit class range to include in the modification. 

Major Acct:  Enter the major account codes to include in the 
modification. 

Customer Status:  Enter the customer status codes to include in the 
modification. 



 

 

MangoGeo Batch Processing 
MangoGeo is a web-based address correction tool that can correct your 
delivery and mailing addresses, retrieve ZIP+4 information, and update 
tax codes.  Contact Advantage Route Systems for further information.   

 

Change Equipment ID’s 
This option allows you to change the ID (serial number) on a piece of 
equipment. 

WARNING!   This option changes all references to this serial number. 

 

Fields: 
Old Equipment No.:  The equipment’s former identification number. 

New Equipment No.:  The equipment’s new identification number. 

Status:  This field will inform you when the change is complete. 
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Modify Rent Prices 
This option allows you to modify rental rates on selected equipment 
assigned to customers.   

 

Fields: 
Serial # Range:  Enter the range of serial numbers to include in the 
modification. 

Equipment Type Range:  Enter the range of equipment types to include 
in the change. 

Charge Code Range:  Enter the rental codes to include in the 
modification. 

Rental Frequency Range:  Enter the period codes to include in the 
modification. 

Acct # Range:  Enter the account number range to include in the 
modification. 

Customer Type Range:  Enter the customer type(s) to include in the 
modification. 

Type $ or %:  Choose the $ (Dollar Amount) or % (Percentage) option. 

Modifier:   Enter the amount of the modification, i.e. 1.00 and $ will be a 
one dollar price increase or 1.00 and % will be a one percent price 
increase. 

Rent Price 1-3:  Choose the rental rates that should be updated (when 
using multiple rental rates).  Standard would be Rent Price 1 only. 

Modify for original prices between: 

• From:  Enter the lowest rental rate that should be modified. 

• To:  Enter the highest rental rate that should be modified. 

• Don’t Exceed:  Enter the highest value a rent could possibly 
become. 

• Round:  Enter a rounding number (should be left alone in most 
cases). 



 

 

Add/Remove Default Products 
This option allows you to globally add or remove default products within 
the Customer Information screen, on the Products tab.   

 

Fields: 
After clicking this  Add key, the following input screen will 
appear so you can enter any changes.   

 
Charge Code:  Select the charge code from the drop-down list. 

Description:  After selecting the charge code, the description 
automatically appears. 

Quantity:  Enter the default quantity for this product.   

Type:  Select the appropriate action: 

• Add:  To add a new default product. 

• Remove:  To remove a previous default product. 

Update Price List Also:  Select this option to add or remove the 
product(s) from Product Price Lists as well. 

Acct. No. Range:  The range of accounts to include in the modification.   

Customer Type:  The range of customer types to include in the 
modification. 

Customer Start Date:  The range of customer start dates to include in the 
modification. 

Major Acct. Code:  The range of major accounts to include in the 
modification. 

Credit Class:  The range of credit classes to include in the modification. 

Branch Range:  The range of branch ID’s to include in the modification.   
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Modify Prices on Default Products 
This option allows you to modify prices for selected default products for 
a given customer range.   

 

NOTE:   After clicking the ADD button, the following input screen will 
appear so you can enter any new changes. 

 

Fields:  
Charge Code:  Select the charge code from the drop-down list. 

Description:  After selecting the charge code, a corresponding 
description automatically appears. 

Modifier:  Enter the value to modify the product by. 

Type:  Select the way to modify prices from the options below: 

• $:  This option will add or reduce the product price by the dollar 
amount in the modifier. 

• %:  This will change the price by the percentage set in the modifier 
field. 

Modify Prices Between:  Enter the lowest and highest value to qualify 
for a price adjustment. 

Don’t Exceed:  The price cap for the increase. 

Round:  Rounds the new price to the value indicated.  

Acct. Range:  The range of accounts to modify. 

Customer Type:  Enter the range of customer types to modify. 

Customer Start Date:  The range of dates that customers started with 
your company. 

Major Acct. Code:  The range of major accounts to include in the 
modification. 

Credit Class:  The range of credit classes to include in the modification. 

Branch Range:  The range of branches for the price change to occur in. 



 

 

Change Default Products 
This option allows you to remove a default product and replace it with a 
new product. 

 

Choose the  Add button to enter the products you would like to 
change.  It will bring up the following input screen: 

 
Fields:  
Old Chrg Code:  Enter the charge code you would like to replace. 

New Chrg Code:  Enter the charge code you would like to add. 

Price:  Select one of the two pricing options below. 

•    Keep Price:  Select this option to keep the existing price and 
apply it to the new product. 

•      Change Price to Default:  Select this option to replace the 
existing price with the default price of the new product.  

Quantity: 

•    Keep Qty:  Select this option to keep the default quantity 
assigned to the current product. 

•    Change Qty to Zero:  Select this option to replace the current 
default quantity with 0. 

 Delete:  To cancel a change, highlight the items and choose the 
delete button. 

Fields:  
Account Range:  Select the range of accounts to modify. 

Customer Type:  Enter the range of customer types to modify. 

Customer Start Date:  The range of dates that customers started with 
your company. 

Major Acct. Code:  The range of major accounts to include in the 
modification. 

Credit Class:  The range of credit classes to include in the modification. 

Branch Range:  The range of branches for the price change to occur in.   
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Add/Remove Deposit Codes 
This option allows deposit codes to be globally added and/or removed 
from each customer. 

 

Fields: 
Deposit Code:  Select the deposit code from the drop-down list. 

Description:  After selecting the deposit code, the description 
automatically appears. 

Quantity:  Enter the default quantity for this product.   

Type:  Select the appropriate action: 

• Add:  To add a new deposit code. 

• Remove:  To remove a previous deposit code. 

Acct. No. Range:  The range of accounts to include in the modification.   

Customer Type:  The range of customer types to include in the 
modification. 

Customer Start Date:  The range of customer start dates to include in the 
modification. 

Major Acct. Code:  The range of major accounts to include in the 
modification. 

Credit Class:  The range of credit classes to include in the modification. 

Branch Range:  The range of branch ID’s to include in the modification.   



 

 

 

Add / Remove Recurring Charges 
This option allows recurring charges to be globally added and/or 
removed from each customer. 

 

To add or remove a recurring charge, click this  Add button.  It 
will bring up the following input screen: 

 
Fields:  
Charge Code:  The recurring product charge code. 

Description:  The description of the recurring fee. 

Amount:  The amount of the recurring fee. 

Fields: 
Type:  Select the appropriate action: 

• Add:  To add a new recurring charge. 

• Remove:  To remove a recurring charge. 

Account Range:  Select the range of accounts to modify. 

Customer Type:  Enter the range of customer types to modify. 

Customer Start Date:  The range of dates that customers started with 
your company. 

Major Acct. Code:  The range of major accounts to include in the 
modification. 

Credit Class:  The range of credit classes to include in the modification. 

Branch Range:  The range of branches for the price change to occur in.   
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Close Open Delivery Orders 
Choose this option to manually close Delivery Orders from the desktop.   

 

Fields: 
Employee Name:  The employee closing the delivery orders. 

Completion Date:  The date that will be used for completing the order. 

Completion Message:  A message that can be entered on the delivery 
order(s) being closed. 

Delivery Order Entered Date:  The date that the delivery order was 
entered into RMA. 

Promised Date:  Enter the promised date range within the Delivery 
Orders to be included.  

Entered By:  The employee that entered the Delivery Order originally. 

Customer #:  The customer account number range. 

After the desired criteria is entered, choose the ‘OK’ button, a pop-up 
similar to the following should appear:   

 



 

 

Click ‘Yes’ to close the order(s). 

 
Click ‘OK’ to complete the process and exit the screen. 

Clear Route Calendars 
Use this option to clear customer route schedules globally. 

 

Fields: 
Account Type:  The range of accounts types to include. 

Day Label:  The range of Day Labels to be removed. 

Clear Calendar From:  Specify the starting date for clearing the 
calendars. 

Archived Customers 
This subsystem allows you to manage old customers that need to be 
removed from the system.   
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Archive Customers 
The Archive/Delete Customers function will remove the customer’s 
information and selected sales data from the primary storage files and 
move it to a history file or permanently delete it to free up storage space.  
The screen shown below is used for the first step in archiving. 

 

Fields: 
Account Number:  The range of accounts to include. 

Customer Type:  The range of Customer Types to include. 

Credit Class:  Enter values for the range of Credit Classes to include.  
You may not want to archive customers who are Bankrupt for example. 

Last Transaction Date:  This will set a date for the archiving process.  It 
will include all customers whose last transaction occurred before this 
date.  This date is established under Branch Setup, on the Optimizations 
screen.  This date will appear on reports that follow and be used to make 
sure you do not delete recent customers. 

Enter the desired criteria and select ‘OK’.  A confirmation screen will 
pop-up, customers that appear on the list can be excluded by double-
clicking on each account. 

 



 

 

All customers marked as ‘Yes’ will be deleted from the system, click 
‘OK’ and the following prompt will appear: 

 
When you are sure you wish to continue, click ‘Yes’.  Once the process 
is complete, you will immediately see the report displayed and have the 
ability to print the Archived Customers Report. 

Archived Customers Report 
The Archived Customers Report provides a way to look at your 
customers who have been removed from the active system.   

 

Fields: 
Sort Option 1 & 2:  The primary and secondary fields to sort by.  You 
can choose from the following categories: 

• By Date 

• By Account No. 

• By Account Name 

• By Customer Type 

• By Major Account Code 

• By Zip Code 

• By Tax Code 

Account Number:  Enter the account number range desired. 

Start Date:  Enter the starting dates for the customers that were archived. 

Customer Type:  Enter the types of customers to be included in the 
report. 

Sales Rep:  Enter any Sales Rep ID’s. 

Credit Class:  Enter the Credit Class range. 
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Acct Status:  Enter the account status range. 

Only Non Terminated Customers:  Check this box if you do not wish to 
include any Terminated Accounts. 

Include Category Summary:  Check this option if you would like to 
group the customers together based on the primary sort option you have 
chosen.  

Short Listing:  Select this option if you do not wish to have any detail on 
the report. 

Print Only Summary:  A condensed summary will be printed using only 
category totals.   

A sample of the report is shown below according to the criteria that you 
have selected.   

 



 

 

Archived Customers Revenue Report 
The Archived Customers Revenue Report is a high level report that will 
help you see sales for archived customers.  This may be used when you 
do need to look at data several years into the past.  While it is not as 
complete as normal revenue reports, it is still helpful. 

The screen below will help you extract the data you need, based on the 
parameters shown.   

 

Fields: 
Sort Option 1:  Company Branch 

Sort Option 2:  Account Number 

Sort Option 3:  Charge Code 

Account Number:  Enter the account number range desired. 

Date:  Enter the date range of archived transactions you would like to 
include in the report. 

Charge Code:  Enter the range of products sold that you would like to 
include. 

Customer Type:  Enter the types of customers to be included in the 
report. 

ZIP Code:  Enter the ZIP code range of the customers to be included in 
the report.  

A sample of the report is shown below according to the criteria that you 
have selected. 
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Final Customer Removal 
The Delete Archived Customers option explained below is the final step 
in customer elimination.  It will delete all customer data from the 
Archived Customer tables.  Once you do this, the customer’s data is 
permanently removed from the system.  You should run a backup of 
your data prior to doing this step. 

Delete Archived Customers 
The Delete Archived Customers function will permanently delete the 
customer data from the archived customer files to free up storage space 
and will help speed up the system. 

To do this, you will see a screen like the following that will let you 
choose which customers are to be permanently removed.   

 

Fields: 
Account Number:  The range of accounts to include. 

Customer Type:  The range of Customer Types to include. 

Credit Class:  The range of Credit Classes to include.  You may not want 
to archive customers who are Bankrupt for example. 

Last Transaction Date:  This will set a date for the archiving process.  It 
will include all archived customers who have not had a transaction since 
this date. 



 

 

Once you have made your selection criteria and pressed OK, a 
confirmation screen will be displayed. 

 
After you have selected / deselected any accounts that you care to, the 
final screen will appear before the process will begin: 

 
Once the process is complete, the Delete Archived Customers Report will 
be displayed.  We recommend you print this out and file it away for 
future reference. 
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Administration 
The Administration tools have been designed to help you run your 
system more efficiently.  The following list shows the tools currently 
available:   

 
These options are described in detail within the following pages. 

Users Currently Logged In 
This option allows a system administrator to view personnel that are 
logged into the system.  The screen displays who has logged onto the 
system, and how long they have been on the system.  You may also 
remove active or inactive (stuck) users in the system. 

 

Fields: 
User Name:  This lists all employees who have logged on, or are logged 
on to the system. 

Login Date:  The date the employee logged on to or had logged on to the 
system. 

Time On:  The amount of time each employee has been logged into the 
system. 

Computer Name:  The name of the computer for the employee logged in. 

Network Name:  The network the computer is logged on to. 

Wastebasket:  Choose a user then click on the wastebasket to remove the 
user. 

Clear Locks:  If you receive a message stating ‘file in use’ when working 
in the system, log on to RMA as an administrator and go to Users 
Currently Logged In, click the ‘Clear Locks’ button to unlock the files. 

Refresh List:  Updates the list of users logged into the system. 



 

 

Data Integrity Check 
This option allows the system administrator to check the computer’s data 
set for errors and problems.  The system checks all areas for data-related 
errors: customer information, default products, the equipment file, branch 
setup, etc. 

 
If you want to choose a segment of the report to check, click “De-Select 
All” to start the selection process.  You can select a line by double 
clicking on that line.   

Double clicking on a heading such as Customer Information will also 
select all Customer Information sub-items.  Double clicking on the 
heading a second time will de-select that item and all sub-items.      

Omit inactive accounts:  Checking this box will exclude inactive 
accounts from showing up with bad information. 

After you have made a procedural choice, click ‘Next’.  Click ‘Abort’ to 
stop the data integrity check at any time. This report can be printed after 
it displays the results. 

 
Review the report and attempt to resolve any issues reported.
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Remove Statement Numbers  

This option allows you to remove statement numbers that have been 
generated and assigned to invoices within RMA. 

NOTE:   For example, this option is helpful if a mistake is discovered on 
a previous statement batch and you would like to use the numbers again 
after adjustments or corrections have been made.  

 

Fields: 
From/To:  Specify a range of statement numbers to be deleted.   

Non-Assigned Statement Numbers 
This option is used to track non-assigned statement numbers.  This screen 
displays both assigned and non-assigned statement numbers and allows 
you to enter additional non-assigned statement numbers (European 
market only). 

 

Fields: 
Statement Number:  If a number does not automatically appear, enter a 
statement number. 

Date:  The date the statement number was assigned or discarded 

Comments:  Why the statement number was discarded. 



 

 

Consolidate History Data  
This function will export the data in a single file.  This is beneficial for 
external reporting utilities such as Crystal Reports. 

 

Fields: 
From:  The beginning date range from which to collect data to 
consolidate. 

To:  The ending date range from which to collect data to consolidate. 

File Name:  The actual name used for the export. 

Clear Pre-Postings 
The Clear Pre-Postings option clears pre-posted data from RMA.  The 
following screen will appear: 

 
Select the file that contains the pre-postings to be cleared and click OK. 
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Purge History 
This will move all transaction history for the chosen accounting period to 
the specified location.  It will also delete all entries in the PERIOD 
CALENDAR through the chosen account period.  This data will no 
longer be seen within the RMA system but it can be backed up to another 
computer, tape, or CD for future use or reference. 

 

Fields: 
Archive Till:  Select the time period to archive.   

Archive Folder:  Select the location of the archive. 

Clean Open Invoice System 
This option will apply any unapplied credits found in the system to the 
customer’s oldest items.  Since this is a global change it will affect a 
wide range of accounts and we generally recommend creating a backup 
prior to running this option.  A report will follow, after clicking ‘Yes’ the 
accounts affected will be displayed.  

 

NOTE:   Before looking into the accounts, the final step to this process is 
to POST a set of transactions, even though they are not related to this 
procedure.   



 

 

Pre-pay Credit Adjustment 
This option allows you to transfer all Pre-pay credits from one account to 
another or adjust pre-pay credits on an individual account. 

 

Fields:  
Account From:  The account from which you would like to change or 
transfer credits.  

Account To:  The Account that will be receiving the pre-pay credits. 

Product Charge Code:  The Product Charge code of the associated 
credits that will be transferred or changed. 

Adjust Account Pre-pay Credit:  Option to toggle between transferring 
credits or making changes to an individual account. 

Change Qty. to:  The amount to be adjusted on an individual account. 

To transfer all Pre-Pay credits from one account to another, simply input 
the From (sending) account number and then the To (receiving) account 
number.   

Once you have entered in both account numbers, enter in the Pre-Pay 
Product Charge Code that is going to be used for the transfer.  When you 
are satisfied, click OK to make the change or exit to cancel. 

To make changes to an individual account simply input the account 
number into the ‘Account From’ field.  Next, enter the Pre-pay product 
charge code.  Once the Account From and Product Charge Code fields are 
populated check the ‘Adjust Account Pre-pay Credit’ box.  Input the 
quantity and click OK.   

NOTE:   Security on this item should be carefully selected to protect the 
system from unauthorized changes.  For further information on the Pre-
pay option, refer to ‘Chapter 2.09: Prepay Products’ available for 
download at www.ARS247.com.  
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Disconnected and Distributed 
Database Management 
This option allows companies that are not connected to their branches 
continuously to sync their data when a connection is available.  Contact 
ARS for further information. 

 

Customer Follow-Up 
These options are currently under development.   

 

Quotation 
The Quotation options are used to create product or equipment quotes 
from customers by a salesperson.  These orders can be monitored and 
converted to Delivery Orders once the customer agrees to purchase the 
items.   

NOTE:   Refer to Chapter 3.26 of the Supplemental Guide for further 
information on Quotations.    

 



 

 

Language Maintenance 
To support our multi-lingual customers, there is a language maintenance 
utility.  This allows you to change the words on screens and reports to 
another language.  English is considered the base language.  In this 
utility, you can show the English word as well as one other language.  
You are allowed to sort the words by English or the alternate language 
equivalent.   

The screen below indicates that changes made in this program are 
immediately made to the file.   

WARNING!  Only experienced users and individuals that need to make 
language changes should be allowed to access and change this screen. 

 
The following screen allows you to make changes: 

 

Fields: 
Base Language:  This is the source language.  Typically, this is English.  
You cannot make changes to the base language. 

Edit Language:  The edit language is the data that you are changing.  If 
you click on the EDIT LANGUAGE button, you can change the 
language to a new one. 

Add:  This button will allow you to add a new language to the tables.  
This should only be used if you need a completely new language. 

Find:   When on this screen, you can press CTRL-F at any time to enter 
the Find mode.  This will allow you to search for any portion of text in 
either the base or edit language. 

Exit:   This button will allow you to leave the Language Maintenance 
program. 
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Coupon Management 
Refer to the Supplemental Manual for further information on coupon 
tracking.   

Surveys 
This option allows the user to create dynamic surveys that can be used 
during customer deliveries.   

 

Survey Information 
The Info tab contains the name of the survey and the time frame that it 
will be used.  The surveys can be established per handheld class, route, 
and customer type as well.   

 

Fields:   
Survey ID:  A seven digit alphanumeric ID. 

Survey Name:  The name of the survey. 

Filters: 
Valid from:  The starting date for the survey. 

To:  The ending date of the survey. 

Handheld Class:  Enter the handheld class that will use this survey. 

Route:  Enter the route that will use this survey. 

Customer Type:  Enter a customer type that will use this survey. 

NOTE:   You can choose one or all of the three fields for Handheld 
Class, Route, and Customer Type. 



 

 

Options: 
Require Signature:  Choose this option to require a signature with the 
survey.   

Require Survey:  Select this option to require that the survey be 
completed for each customer on the handheld. 

Show After Quick Sale Screen:  Select this option to use display the 
survey after saving the invoice on the handheld.   

Detail Tab 
This tab controls the questions on the survey, choose the ‘Add’ button on 
the bottom of the screen to input a new question, or modify an existing 
question. 

 

Fields: 
ID.Item:  The ID assigned to the survey item. 

Description:  The description of the survey item. 

Type:  The type of survey item. 

Mandatory:  Required or not required. 

Print:  Required to print. 
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Choose the ‘Add’ option to create a new question (shown below). 

 

Fields: 
ID:  The ID controls the category of the question, i.e. 00, 01 would be 
separated on the survey. 

Item:  The item number controls the order in which the question appears, 
i.e. 000 would be the first question, 001 the second, etc.   

Description:  The description of the survey item. 

Type:  The type of survey item. 

• Yes / No:  A simple Yes/No answer. 

• Numeric Value:  A number will be entered. 

• Text:  Something will be typed in. 

• List:  A list of items to choose from can be added. 

• Matrix:  This will place items on a grid. 

• Category / Heading:  A defined heading will be used. 

Mandatory:  This will make the item a requirement. 

Print:  This item will print on the handheld printer. 



 

 

Notes/Disclaimer Tab 
This option allows the ability to add some notes to the survey that will 
print for the customer.   

 

Fields: 
Notes:  Enter any notes that should be displayed on the survey.   

Disclaimer:  Enter a disclaimer for the survey if required.   
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Survey Questions 
The Survey Questions option allows you to enter questions that will be 
assigned within the Detail tab of the Survey screen.  

 

Fields: 
ID:  The ID controls the category of the question, i.e. 00, 01 would be 
separated on the survey. 

Item:  The item number controls the order in which the question appears, 
i.e. 000 would be the first question, 001 the second, etc.   

Description:  The description of the survey item. 

Type:  The type of survey item. 

• Yes / No:  A simple Yes/No answer. 

• Numeric Value:  A number will be entered. 

• Text:  Something will be typed in. 

• List:  A list of items to choose from can be added. 

• Matrix:  This will place items on a grid. 

• Category / Heading:  A defined heading will be used. 

Mandatory:  This will make the item a requirement. 

Print:  This item will print on the handheld printer. 

MLP Reports    

Refer to the supplemental document MLP Reports available on 
www.ARS247.com . 

 



 

 

Helpful Windows Functions 

Edit Functions 
As you enter data, you can use standard Windows functions to help you, 
such as those shown below.  This will make certain functions easier.  
Generally, these only work on text input fields.  Here are the system’s 
features that function like standard Windows routines: 

• Undo • Paste 

• Redo • Find 

• Cut • Find Again 

• Copy  

Calculator 
This full-function calculator can be used within Route Manager 
Advanced to help with most calculations. 

 

Calendar/Diary 
This calendar program can be used in Route Manager Advanced to 
look up dates and create reminders for future events 

 
You can place messages into any day.  The notes appear on the right side 
of the screen.  Use the control keys at the bottom of the screen to move to 
different dates. 
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Module Bar 
The Module Bar contains the default date used in most areas of the 
software.   

 

Module Date   

Displays the current date that will be assigned to all invoices, payments, 
etc.  This date can be changed if necessary.    

Quote Request      
The Quotations option is used to create product or equipment quotes 
from customers by a salesperson.  These orders can be monitored and 
converted to Delivery Orders once the customer agrees to purchase the 
items.  Refer to Chapter 3.26 of the Supplemental Guide for further 
information on Quote Requests. 

Delivery Orders  
The Delivery Orders screen handles special requests from customers, and 
is used to schedule special deliveries.   

NOTE:   Refer to Chapter 3.09 of the Supplemental Guide for further 
information on using the Delivery Orders feature in RMA. 

 

Fields: 
Account Number:  The account number of the customer who made this 
delivery order. 

Name:  The name of the customer who made this request. 

Delivery Address:  This customer’s delivery address. 

Contact Reasons:  Reason for Delivery Order 

Credit Terms:  Displayed only when terms have been set within the 
Credit Class assigned to the account. 

Route/Day/Stop:  The route for this customer.  Also include the day the 
customer received service and the stop number. 



 

 

Driver:  The name of the route driver that delivers to this customer. 

Date/Time:  The date and time the customer made this request. 

Phones (Info/Route):  The phone number of the customer. 

Contact/Spoke With:  The customer to contact regarding this request. 

Ticket No.:  The unique reference number to identify the request.  The 
eight-digit number is created by using the last digit of the year, two-digit 
month, a two-digit day and a three-digit count number.  This is used in 
invoice entry to close a ticket.  

Balance:  The customer’s account balance. 

Last Payment:  The date and the amount of this customer’s last payment. 

Request:  The request made by this customer. 

NOTE:   Navigate to Lists > Delivery Order Reasons to establish request 
selections.  

Route/Day/Stop:  Displays the customer’s assigned route information. 

Driver:  Displays the customer’s assigned driver. 

Entered Date/Time:  Displays the date and time that the order was 
created. 

Phones (Info/Route):  Displays the customer’s contact phone numbers. 

Spoke With:  Allows you to select or enter the person that was contacted. 

Ticket No:  Displays the assigned ticket number on the Delivery Order.   

  Open Hours:  This button will allow you to change the open hours 
on each delivery order. 

Equipment: 
Click anywhere within the equipment entry box to open the equipment 
entry screen. 

NOTE:   This information will only display on the Delivery Order and/or 
Delivery Ticket and is not recorded in the form of a transaction.  It is for 
driver and data entry information only. 

 
You have the ability to create five different types of equipment requests.  

 

Install: 
Create a Delivery Order to install a new piece of equipment. 
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Qty:  The quantity of one specific type and style of equipment to install. 

Equipment Type:  Select the Equipment Type from the dropdown list. 

Style:  Select the Equipment Style from the dropdown list. 

Location:  Type in the physical location for the equipment to be placed at 
the customer’s location. 

Freq.:  Select the Equipment Billing Frequency from the dropdown list. 

Chrg Code:  Select the Equipment Charge Code from the dropdown list. 

Period Rate:  Enter the Equipment Period Rate (if different than the 
Product Charge Code default). 

New:  Check the ‘New’ box to note on the Delivery Order that the driver 
needs to select a new piece of equipment. 

Exchange: 
Pick up one piece of installed equipment and replace it with a new or 
reconditioned piece of equipment. 

Serial No.:  Select the equipment to replace from the dropdown list. 

Equipment Type:  Equipment Type of the selected equipment. (Read 
Only) 

Style:  Equipment Style of the selected equipment. (Read Only) 

Location:  Location of the selected equipment. (Read Only) 

Fault:   Select the Equipment Fault Reason from the drop-down list.  
This will help the driver understand the issue.  The problem may be 
resolved without exchanging equipment. 

NOTE:   Equipment Faults are established under Lists > Equipment > 
Equipment Faults. 

Qty:  Always 1 – 1 piece of equipment installed replacing 1 piece of 
equipment removed.  

Equipment Type:  Select the Equipment Type from the drop-down list.  
The field will display the ‘Type’ for the equipment being removed. 

Style:  Select the Equipment Style from the drop-down list.  The field will 
display the ‘Style’ for the equipment being removed. 

Location:  The physical location for the equipment to be placed at the 
customer.  The field will display the Location for the equipment being 
removed. 

Freq.:  Select the Equipment Billing Frequency from the drop-down list.  
The field will display the Billing Frequency for the equipment being 
removed. 

Chrg Code:  Select the Equipment Charge Code from the drop-down list.  
The field will display the Product Charge Code for the equipment being 
removed. 

Period Rate:  Enter the Equipment Period Rate (if different than the 
Product Charge Code default).  The field will display the Period Rate for 
the equipment being removed. 

New:  Check the ‘New’ box to note on the Delivery Order that the driver 
needs to select a new piece of equipment. 

Service: 
Perform a periodic equipment service such as cleaning, sanitization, or 
maintenance. 



 

 

Serial No.:  Select the equipment that needs to be removed from the 
customer’s location from the drop-down list. 

Equipment Type:  Equipment Type of the selected equipment. (Read 
Only) 

Style:  Equipment Style of the selected equipment. (Read Only) 

Location:  Location of the selected equipment. (Read Only) 

Service:  Select the Equipment Service Reason from the drop-down list. 

NOTE:   Equipment Service Codes are created under Lists > Equipment > 
Equipment Service Codes. 

NOTE:   Refer to Chapter 3.14 of the Supplemental Guide for further 
information on equipment servicing.   

Repair: 
Perform a repair on-site at the customer’s location: such as replacing 
spigots or drip trays. 

Serial No.:  Select the equipment needing to be repaired from the drop-
down list. 

Equipment Type:  Equipment Type of the selected equipment. (Read 
Only) 

Style:  Equipment Style of the selected equipment. (Read Only) 

Location:  Location of the selected equipment. (Read Only) 

Fault:   Select the Equipment Fault Reason from the drop-down list. 

NOTE:   Equipment Faults are established under Lists > Equipment > 
Equipment Faults. 

Pickup: 
Remove a piece of equipment from the customer location due to 
cancellation. 

Serial No.:  Select the equipment needing to be replaced from the drop-
down list. 

Type:  Equipment Type of the selected equipment. (Read Only) 

Style:  Equipment Style of the selected equipment. (Read Only) 

Location:  Location of the selected equipment. (Read Only) 

Fault:   Select a fault code from the drop-down list.  This will notify the 
driver if there is an issue with the equipment so it can be tagged and 
reconditioned and/or repaired in the warehouse. 

NOTE:   Equipment Faults are established under Lists > Equipment > 
Equipment Faults. 

Message:  Any additional requests or comments can be entered into this 
field. 

Promise Date:  The date your staff promised this customer that their 
request would be fulfilled. 

Complete:  Click the ‘Complete’ button when this customer’s request is 
completed. 

Processed By:  The employee who received and input the information 
regarding the request. 

Completion Date:  The date that this customer’s request was completed. 

Completion Message:  Comments pertaining to the request’s completion. 

Follow up Date:  The date for a future follow-up call. 
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Follow up by:  The employee who will do a future follow-up call. 

Messaging: 
Delivery Message:  Additional delivery information or comments can be 
entered into this field.  This information is exclusive to this Delivery 
Order and is used on the Pre-Route Report, Handheld, and on the 
Delivery Ticket. 

(Optional) Invoice Message:  If you are using custom statements, this 
field is used to display specific invoice information relating to this 
Delivery Order. 

Other Fields: 
Promise Date:  The date your staff promised this customer that their 
request would be fulfilled.  This date will also be the date the delivery is 
scheduled for. 

Complete:  Used to manually complete the Delivery Order.  When the 
Delivery Order in manually completed, the system saves the initials of 
the person that completed the order (Processed By), and the date 
(Completion Date) completed.  The user should also enter a Completion 
Message for others to use as reference. 

Follow up:   If the Delivery Order requires special attention, the Follow 
Up button is used to alert the user (Follow-Up By) on a specific date 
(Follow-Up Date).   

The user will be prompted with a ‘Follow-Up Message’ when logging in 
to RMA once the Follow-Up Date is reached.   

NOTE:   The ‘Follow-Up By’ and ‘Follow-Up Date ‘can be defaulted 
under File > Branch Setup > Defaults tab.   

Add to Contacts:  If you select this box, the Delivery Order will be 
added to the customer’s Contacts tab.  This option can be defaulted under 
File > Branch Setup > Defaults tab. 

Add to Contacts:  If you select this box, the delivery order will be added 
to the customer contact history so that you can track message activity for 
this account. 

Add Info to Alert Message (Handheld Message):  Information about the 
request to be sent to the handheld. 



 

 

Orders: 
The Orders section of the screen allows you to attach the customer’s 
requested delivery items to the Delivery Order.   

 
Simply click in the orders box to access the Pending Order screen: 

 
The customer’s assigned Default Products will automatically be 
displayed for quick access.  Double-click on any item displayed to update 
the price or quantity, or add alternate items to the order by selecting the 
Add key. 

NOTE:   Any items left on the screen at 0 quantity will automatically be 
removed from the order on Save. 

Additionally, you can select a ‘Gratis’ reason on applicable items or the 
‘Default’ checkbox to add the item to the customer’s Default Products 
list permanently.   

 

NOTE:   The Qty. Disc option requires additional configuration steps.  
Refer to Chapter 2.01 of the Supplemental Guide for further information 
on this pricing option. 

Previous Orders: 
Additionally, you can select the ‘Previous Orders’ key to view orders and 
invoices posted on the account previously.  This will help save time on 
accounts that typically order similar items and identify purchasing trends. 
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The Previous Orders screen allows you to view previous Delivery 
Orders, Invoices, or both based on the oldest transaction date entered.  
Use the options on the bottom of the Previous Orders screen to filter 
displayed criteria. 

 
If you would like to Add (A) or Replace (R) any of the items listed on the 
current order, select the applicable radio button displayed next to each 
item in the list: 

 
Click OK  to complete the Pending Order process and add the items to 
the Delivery Order. 



 

 

Other Fields: 
Copies:  The format and number of copies of the order to print.  Indicate 
whether you want the wide version “W,” standard “S,” or “N,” which is 
similar to “W’ but will suppress prices on the printed order.  
Additionally, select the number of copies to print -- up to 4, depending 
on the format (i.e., “1S” will print one small order).    

 Report:  Pressing the Report button takes you directly to the 
Delivery Order Follow-up screen where you can print out a report 
containing route tickets or delivery order information. 

 Browse:  Pressing the Delivery Summary button takes you 
directly to the Last 5 Deliveries screen.  

Customer Fast Find  
The Customer Fast Find screen is used as a tool to look up customer 
information.  Choose from the criteria option on the right side of the fast 
find screen.  The system will search all of the fields selected.  

 
Enter the desired information and hit ENTER on the keyboard (partial 
information is ok).  The system will update the screen with the results 
found.  

 
Click on the account and choose the ‘Open’ button or hit ENTER on 
your keyboard to open up the selected account. 
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Contact Message  
The Contact Message option allows you to quickly enter a new contact 
message on a customer’s account.   

NOTE:   Clicking this icon while viewing a customer’s account will 
automatically open a new contact message screen for the account. 

 

Fields: 
Acct Number:  The account number of the customer being contacted. 

Spoke with:  The name of the customer you are contacting. 

Date:  The current date. 

Time:  The current time. 

Created By:  The employee that contacted the customer. 

Follow Up:  The date the customer should be contacted again for follow-
up.   

NOTE:   Leave the date defaulted to the current date if no follow-up is 
necessary. 

Follow Up by:  The employee who will follow-up with the customer.   

Contact Reason:  Choose a ‘reason’ for the type of message.  This list 
can be established under Lists > Customer Setup Codes > Contact 
Message Reasons. 

Show message on payment entry:  Select this option if you would like 
the current message to pop-up when entering a payment on the account. 

Message:  Enter the message details here.   

Completed:  Check this box if no further follow-up is necessary. 

Completed Date:  The date the customer’s request is completed.   



 

 

Print Customer Label  
Use this function to print customer mailing labels at any time.  These can 
contain either a “bill to” or a “delivery” address.   

 

Fields: 
Copies:  The number of labels to print for this customer. 

Missing Labels:  If you are printing labels on a sheet that is missing 
labels, enter the number of labels to skip before printing. 

Label Type:  If the Laser box is checked on the Local Setting tab, this 
drop-down list will allow you to select one of the following standard 
label types: 

• Avery 5162 

• Avery 5163 

• Avery 6231 

• A4 – 2 x 7   

Address:  Pick the address to use on the label. 

• Bill To:  Designates the customer’s billing address to appear 
on the label. 

• Deliver To:  Designates the delivery address. 

Print Phone Number:  Check this box to include the customer’s phone 
number on the label. 

Print Contact Name:  Check this box to print the contact name from the 
Info tab under Lists, Customer Information. 

Eject After Printing:  For dot matrix printers, select this option to 
automatically form feed the sheet after printing. 

Print Account Number:  Check this box to print the account number. 

Account:  The account number of the customer to print this label. 

Last Entered:  The account number that was last entered. 
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Customer Finance Assistant  
The Customer Finance Assistant allows you to create a credit, debit, or 
write-off transaction directly from any of the Customer Information 
screens.  Additionally, you also have the ability to transfer payments 
from one account to another — creating an easy solution when payments 
are applied to the wrong account.   

The Customer Finance Assistant can be used at any time.  However, if 
you are viewing the customer in any of the Customer Information screens 
the Customer Finance Assistant will automatically be populated with the 
customer data.   

The following screen appears when a customer is being viewed in any 
Customer Information screen:   

 



 

 

Account Credit 
The Account Credit option is used to make positive account adjustments.  
In most cases, only ‘adjustment’ type product codes should be used on 
this screen.   

NOTE:   Enter positive quantities on this screen; the quantities will be 
converted during the posting process.  

 

Fields: 
Acct. No.:  The account number for the credit transaction. 

Adjustment No.:  A unique identifying number for every adjustment - 
usually pulls from Branch Set-up. 

PO:  Purchase Order number. 

Name:  Name of the customer. (This will automatically filled in when 
you enter the account number) 

Reason:  The reason for the account credit. (Credit note Reasons) 

Narrative:  This allows you to enter a brief reason description for the 
Credit. 

Major Account:  The major account code assigned to the account. 

Date/Time:  The time and date that the Credit was created. 

Employee ID/Name:  The employee’s ID and name that created the 
Credit. 

Related Invoice:  The invoice that is related to this credit, for reference. 

  Click the Add button to add products or equipment that will be 
credited to the account. 
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Account Debit 
The Account Debit option is used to make positive account adjustments.  
In most cases, only ‘adjustment’ type product codes should be used on 
this screen.   

Fields: 
Acct. No.:  The account number for the debit transaction. 

Adjustment No.:  A unique identifying number for every adjustment - 
usually pulls from Branch Set-up. 

PO:  Purchase Order number. 

Name:  Name of the customer. (This will automatically filled in when 
you enter the account number) 

Reason:  The reason for the account debit. 

Narrative:  This allows you to enter a brief reason description for the 
debit. 

Major Account:  The major account code assigned to the account. 

Date/Time:  The time and date that the debit was created. 

Employee ID/Name:  The employee’s ID and name that created the  

Related Invoice:  The invoice that is related to this debit. 
 
 



 

 

Write-Off 
The Write-Off option can be used on accounts that are uncollectable.  In 
most cases, only ‘write-off’ type product codes should be used on this 
screen.   

 

Fields: 
Acct. No.:  The account number for the write-off transaction. 

Adjustment No.:  A unique identifying number for every adjustment - 
usually pulls from Branch Set-up. 

PO:  Purchase Order number. 

Name:  Name of the customer. (This will automatically filled in when 
you enter the account number) 

Reason:  The reason for the write-off transaction. (Write-Off Reasons) 

Narrative:  This allows you to enter a brief reason description for the 
write-off transaction. 

Date/Time:  The time and date that the write-off transaction was created. 

Major Account:  The major account code assigned to the account. 

Employee ID/Name:  The employee’s ID and name that created the 
write-off transaction. 

Related Invoice:  The invoice that is related to this write-off transaction. 
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Payment Xfer 
The Payment Transfer option is used to transfer a payment from one 
account to another.  This is helpful when a payment has been entered and 
posted to the wrong account.  This process will create a negative payment 
on the original account and a new payment on the correct account.   

1. Enter the account you want to transfer a payment from.  

2. Press [TAB] or [ENTER] to view the payments on the account.   

3. Highlight the payment and click ‘OK’, or double-click on the 
desired payment to transfer.   

 
4. Enter an account number to transfer the payment to, and click 

‘ENTER’ to complete the transfer process.   Does Customer 
Type call for a new screen shot here? 

 



 

 

Other Module Bar information:   
  Current Period:  This button displays the month or 

period that RMA is currently working in. 

  Current Language:  This box shows what language RMA is 
currently set to as defined in Local Settings. 

  Messaging:  This button turns messaging on or off. 

 Conversation: Select this icon to instant message other users within 
RMA (requires ‘Use Conversation’ within Branch Setup). 

 Find Customer Address:  Select this option to access the Advanced 
Mapping Module for customer address information. 

 Web Message:  Select this option to view recent bulletins published 
by ARS. 

 Import Documents:  Select this icon to import documents using the 
Electronic Filing Module. 

 Automated Processing:  Select this icon to access the Automated 
Processing Module. 

  Sales Counter:  This button will show total sales for the 
day.  Toggle between ‘My’ and ‘Group’ sales.  ‘My’  will show your 
sales for the day and ‘Group’ will show the different group(s) sales as of 
that moment (right-click the Sales Counter button for more options). 

NOTE:   Employee Groups must be used in order to use this function 
properly. 
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Chapter 5B  – Help  

Overview 
The Help pad gives you access to system help as well as information 
about the program.  

 
In addition to online help in a number of formats, we maintain a full 
support staff to answer your questions and provide solutions for optimal 
system performance.  E-mail support is the recommended format for 
written communications and allows us to get back to you quickly. 

No matter which method is best for you, you will always get the help you 
need. 

 



 

 

Contents  
The Table-Of-Contents option will allow you to quickly search the RMA 
User Guides A&B. 

NOTE:   This option requires an active internet connection. 

 

Day-to-day Operations   
This option is currently in development. 
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Technical Support   
Select the Technical Support option to access the Autotask portal that 
allows you to view and submit inquiries to ARS.   

If you have not received login information for the Autotask portal, please 
contact us at Support@ARS247.com with the following information:  
First and Last Name, Company Name, Phone Number, and E-Mail 
Address. 

 
To access the Autotask portal outside of RMA, use: 

https://clientaccess.autotask.net/default.asp?ci=5432  

Each inquiry reviewed or submitted will be assigned a unique ticket 
number that allows you to easily view and track the item(s).   

Contact Us  

Whenever you need assistance, we are just a phone call away.  Listed 
below are our main contact numbers: 

• Toll free tech support:  888.294.7688 (in the US only) 

• Fax:  1.775.263.8426 

• E-mail:  support@ARS247.com 

You can also view our Frequently Asked Questions section on the Web 
site.  http://www.ARS247.com. 



 

 

Tech Support Remote Connection 
ARS utilizes the Go-To-Meeting program to allow our technical support 
staff to access your PC.   

 

Fields: 
Meeting ID:  This will be supplied to you by a support staff member 
during when remote support is required.  

Connect via SimpleHelp 
This option allows you to connect with an ARS technician during support 
calls. 

Print Manuals 
Select this option to print various documents that are available within 
your version of RMA.   
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www.ars247.com 
Choosing this option will link you to the www.ARS247.com Web site. 

 
 

Modules 
The Modules option has been created to offer helpful links to forms and 
documents needed for optional modules.  This list may be updated 
periodically. 

Authorize.net Application Forms 
The forms that are required to be completed when signing up for service 
with Authorize.net (Electronic Funds Module). 



 

 

About RM Advanced  
If you want to know the current version of the software or phone 
numbers for technical support, select this option.   

 
Contact information, as well as your serial number, is displayed on this 
screen.  In addition, you can select the following buttons: 

Modules: 

 Select the ‘Question Mark’ icon (next to the Serial# field) to view 
your available optional modules.  Any modules purchased by your 
company will be marked with an [X]. 
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Tables:   
 Click this button to view diagnostic information about the system 

data tables and your active directories.  You can scroll through this 
information or exit by clicking ‘OK’.   

 

NOTE:   In the right column, you may notice deleted records.  If you 
have many files that contain deleted records, you should rebuild your 
tables.  To do this, go to File, then Rebuild Data Files.  This will remove 
deleted items from your files.  We recommend that you rebuild your files 
at least once a month.  

Error Log:   

 Click this button to view a report of all errors that have occurred 
when RMA has been in operation.  You will see a report similar to the 
following: 

 
When you generate this report, a printer icon will appear on the module 
bar.  If you are experiencing errors, this report will enable our technical 
support staff to help you solve any problems you may be experiencing 
with your software. 

When you close the error log, you will see the following screen: 

 
Click YES to clear the errors in the error log, or click NO to save the 
errors.
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Appendix A: End -of-Month 
Procedures 

Overview 
We have provided a checklist you can follow for general procedures on 
the Month-End process.  Using a checklist will help you stay on task and 
avoid problems once you have established your routine. 

NOTE:   Refer to Chapter 3.12 of the Supplemental Guide for further 
information on the Month End process. 
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Checklist 
Below is a checklist of steps to follow during the Month-End process.  Depending on your 
company, some of the steps may be omitted.   

 
Date:       Time:      Who:      Month End Processing Checklist                                  

1.   Post last batch of regular 
transactions 

2.   Back-up Data Files  

3.   Generate Rent Charges/Rents 
Not Billed / Post Rentals 
4.   Generate Recurring Billing 
Charges/ Post Charges 
5.   Generate Over-Usage Charges 
(Package Plan Only) / Post 
Charges 
6.  Generate Monthly Package Plan 
Charges (Module) / Post Charges 
7.  Calculate Administrative 
Charges / Post Charges 
8.   Calculate Credit Card Payments 
/ Post Payments 
9.   Calculate Late Fees / Post 
Charges 
10.   Print Monthly Reports: 

• Business Pulse Report 
• Aging Analysis 
•  Sales Detail Report 
• Any other relevant reports 

11. General Ledger Posting Report 

12. Customer Statements 

13. Close Period 

Complete: Start next month’s 
processing 
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Appendix B: Operating in a 
Multi-user Environment 

Overview 
If you are running the RMA in a multi-user environment, there are 
additional issues that you will need to address.  These issues include 
setting up the system, using the proper hardware, managing daily 
operations, and providing additional support.   

Typically, a multi-user system requires additional support by the system 
administrator due to the number of users and a more complex 
environment. 

Hardware Set Up 
Generally, there are two ways to set up a multi-user system.   

First, if you have a dedicated network server such as Windows Server 
2003 (our recommended choice) the data resides on one computer - a file 
server - and all users access that information via a network connection.  
Up to 999 users may be connected to the network and may use the RMA 
package simultaneously depending on your network design and 
configuration.  This method establishes a secure environment, easy 
backups, and the best performance available.  

The second choice is to set up a workgroup and designate one 
workstation as a server from which other users can access RMA.  This is 
generally acceptable for up to ten users.  It is generally better that the 
data host not be your heaviest user.  This option can be used when cost is 
a factor.  You can later upgrade from workstations to an actual server. 

User Licenses 
The RMA package comes with a single user license.  You will need 
additional licenses for each user.  The maximum number of concurrent 
users determines the number of licenses you need. 

This means that no matter how many network workstations have the 
package, the number of concurrent users will be limited to the number of 
licenses obtained. 
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Logging In 
In a multi-user environment the login prompt shows the names of all 
users currently logged on to the system.  It also provides the maximum 
number of users allowed.  Once this number of users is reached, no one 
else can log on.  If the number of users needing to log consistently 
exceeds the number of licenses you have, you should acquire additional 
licenses to meet the company’s needs. 

Multi-User Functions 
Most functions in RMA are multi-user.  The following is a partial list of 
the activities that can be done while more than one person is on the 
system. 

• Customer lookup 

• Most List functions 

• Entering payments 

• Entering invoices 

• Uploading cards (afternoon card function) 

• Downloading cards (morning card function) 

• Posting transactions 

• Printing statements 

• Printing most reports 

If a user is editing a customer record, multi-user features may be delayed.  
A message on the screen will alert others to this delay.   

NOTE:   While accessing a data record, if the border of the screen turns 
to a "hot pink", this means that someone else is already editing the record 
you are requesting to modify.  Allow them to finish their editing and try 
again.  This prevents data corruption. 

Single-User Functions 
There are a few processes that must be completed in single user mode.  
Your screen will warn you if there are other users in the system at the 
time you attempt a single-user operation.   

To prevent any corruption of data you will not be allowed onto the 
system until the single-user function is completed. 

Some features that require sole access to files are: Period Close, General 
Ledger Postings, Rebuilding the Data Tables and updating your software 
via the web or by CD. 

Updating Programs 
For the reason stated above, all users must be out of the system when you 
are updating your program. 

This is true whether you update your system by CD, Internet, or if ARS 
or your support provider does it remotely.  The update process can take 
from 5 minutes to over 2 hours depending on the method used.  Please 
plan ahead to suspend your normal operations long enough to complete 
the update process. 
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Clearing Out Logged in Users 
Once in a while, a user can get “stuck” in the system.  This can happen 
with network problems, power outages, a failed server, a bug in the 
program, or many other reasons.  Should this occur, generally one person 
can get into the program and access the Administration screen option 
under Tools.  Select Users Currently Logged In.  This will show all users 
that are in the system.  If a person is not really logged in, select the user 
and then the trash-can icon.  This will clear out the user so they can login. 

Troubleshooting 
Due to the number of variables involved, i.e. computers, network cards, 
cabling, servers, printers, routers, users, etc., it can often be difficult to 
pinpoint the exact source of the problem.  Check our Web site or call us 
for assistance in troubleshooting your system when you are in a multi-
user operation and cannot sort out a problem.
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Appendix C: Customer Notes 

Overview 
The RMA package provides two general ways to record interactions with 
customers.  These are: 

• Office Messages 

• Handheld Messages 

Each of these message types is explained in more detail below and can be 
found under the Customer Information screen. 

NOTE:   In order to maintain an accurate record of important account 
information, it is important that each operator understands the purpose of 
the message box and uses it consistently.  

Office Messages 
Note 

 
This information box is used to record permanent notes about the 
personality of the customer, such as: “Never pays on time,” “Promises a 
check and always sends it late,” or “Always speak with Linda to confirm 
any special orders.”  These messages are only displayed on the screen, 
and the customer will never see them.  The Note option can be found 
under Lists > Customer information, on the Info tab. 
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Statement Message 

 
On the customer’s statement, you can print a customized message such 
as, “Give this statement to Linda in accounts payable,” or “The products 
delivered under this invoice qualify under the National Fair Atmospheric 
plan,” or any other message specific to this customer.  The Statement 
Message can be found under Lists > Customer Information, on the Info 
tab. 

NOTE:   If you want a message to appear on every customer’s statement, 
you can use the Statement Notes option under Lists > Customer Setup 
Codes > Statement Codes. 
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Contact Messages   

 
This area provides an ongoing history of events that have transpired 
between you and the customer.  These messages are logged within Lists 
> Customer Information, on the Contacts tab.   

Many different types of messages can be entered, including: 

Automatic Messages:  These are messages that are automatically added 
to the Contacts tab each time a certain event occurs.  This can include: 
credit card processing approval, equipment transfers, telephone 
messages, route driver messages, returned checks, and other events. 

Manual Messages:  Any system user can select this tab and enter a short 
message describing contact with the customer.  This can include phone 
conversations, promises by the customer to pay an invoice, requests to 
change an address, and more.  You can also enter a follow-up date and 
the system will remind you to take further action on the account. 

To Add a new Contact Message, choose modify and select the ‘Add’ 
button on the bottom of the Contacts tab.  A screen similar to the 
following will appear:   

 
Enter the necessary information and click ‘Ok’.  Choose the ‘Save’ 
option within Customer Information to complete the process.   
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Handheld Messages 
Many messages can appear on the handheld computer.  These messages 
can be entered under Lists > Customer Information > Route, and click 
the Messages button.  A list of the possible messages is included below. 

 

Alert Message 
This message appears on the handheld as the driver first selects the stop 
to make a delivery.  Like all handheld messages, there is no maximum 
length restriction.  If more text is entered than can fit on the screen, scroll 
bars provide easy access to the additional lines of text. 

One Time Message 
The one-time message is just like the alert message, except it will only 
appear on the handheld for a period of time during the “start and stop 
period”.  This is useful to remind a route driver when a customer may be 
on vacation and will not require a delivery.  

Driver Directions 
To help the route driver locate a customer, instructions can be entered in 
this message area.  Typically, this would include street names or 
landmarks such as “Last house before the creek”, or “Go one light east 
on Meridian before turning right on Maple Street”. 

Site Instructions 
This message provides on-site instructions for delivery.  For example, 
“Bottles are located in garage next to tool shop,” or “Place a full bottle on 
the cooler each time”.  While site instruction s could include, “Beware of 
the big dog”, it may be better to enter such a message in the Alert 
Messages that appear when the driver comes to the stop. 

Invoice Messages 
Use this space to put a special message on the handheld delivery receipt.  
This might include a Purchase Order number, special instructions such 
as, “Accounts Payable will require one copy as well as the signing 
party”, or “This invoice must be paid under agreement 45-8384 which 
requires payment in five days”.  No special formatting is required for this 
message. 
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